infor
Copyright
@2019 INFOR Inc

VISUAL PLANNER FOR
SYSTEM 1
User Guide

This document explains how to use features of Visual Planner for System i
as of Version 7.0.214

Last updated: June 10, 2019




2

TABLE OF CONTENTS

Copyright © 2018 Infor

All rights reserved. The word and design marks set forth herein are trademarks and/or registered
trademarks of Infor and/or related affiliates and subsidiaries. All rights reserved. All other trademarks
listed herein are the property of their respective owners.

Important Notices

The material contained in this publication (including any supplementary information) constitutes and
contains confidential and proprietary information of Infor.

By gaining access to the attached, you acknowledge and agree that the material (including any
modification, translation or adaptation of the material) and all copyright, trade secrets and all other
right, title and interest therein, are the sole property of Infor and that you shall not gain right, title or
interest in the material (including any modification, translation or adaptation of the material) by virtue
of your review thereof other than the non-exclusive right to use the material solely in connection with
and the furtherance of your license and use of software made available to your company from Infor
pursuant to a separate agreement (“Purpose”).

In addition, by accessing the enclosed material, you acknowledge and agree that you are required to
maintain such material in strict confidence and that your use of such material is limited to the Purpose
described above.

Although Infor has taken due care to ensure that the material included in this publication is accurate
and complete, Infor cannot warrant that the information contained in this publication is complete, does
not contain typographical or other errors, or will meet your specific requirements. As such, Infor does
not assume and hereby disclaims all liability, consequential or otherwise, for any loss or damage to any
person or entity which is caused by or relates to errors or omissions in this publication (including any
supplementary information), whether such errors or omissions result from negligence, accident or any
other cause.

Trademarks

Microsoft®, Windows®, Windows NT® and the Windows logo are registered trademarks, and Windows
Server™ is a trademark of Microsoft Corporation in the United States and/or other countries.

IBM® and AS/400° are registered trademarks and iSeries™ and System i™ trademarks of International
Business Machines Corporation in the United States and/or other countries.

Publication Information
Release: Infor Visual Planner for System i 7.0

Publication Date : June 10, 2019

Visual Planner User Guide Page 2



3

TABLE OF CONTENTS

TABLE OF CONTENTS

TABLE OF CONTENTS eutiitiiie ittt ettt et et e et e et e eaaseaaesanesansesansssansessnsesannes
Py o Yo 10 Al N o 11 10 o [T

Chapter 1 Installing and Configuring VPi ...,

Overview

System Requirements

PC or Scheduling Station requirements
System i connectivity

VPi engine database

Installing and implementing VPi
Installing VVPi on client PC or Server
Creating an ODBC Data Source
Linking VPi to the ERP environment on the System i
Maintaining your Installation

Planning multiple entities

Deploying VPi for multiple Users
Deploying VPi for multiple Planners

Removing the Schedule Lock when one planner trips over other planner’s plan

Chapter 2 VPi CONCEPLS coooeeeieieeeeeeeee e

Role sharing between VPi and ERP

Information flow

Before you plan

While you plan

After you plan

Demand management

Forecasts and Safety-stocks and Replenishment of items
Replenishment Forecasts

Safety Stock Forecasts

Visual Planner User Guide




4

Chapter 3 Preparing for Planning

TABLE OF CONTENTS

Consuming forecasts

Total and Unconsumed Forecast
Viewing forecast consumption summary
Viewing forecast consumption Detail
Planning with VPi

Planned order quantity
Manufacturing order lead times
Purchasing time fences

Order rescheduling

Control items

Item Processes

Forward scheduling

Lot sizing policies

Negative BOM functionality

Inputs:

Config Changes

Example

Multi-sourcing Capability

Inputs to Visual Planner

Output from VPI

Back flushing in Visual Planner

Back flushing when multiple work orders are in Progress

Checking Back flushing details

Download data

Setting the download mode
Downloading data

Setting up VPi

Setting parameters for VVPi planning

Visual Planner User Guide




TABLE OF CONTENTS

Establishing calendars
Specifying machine availability
Using the menus

File menu

Display menu

Chapter 4 Using the VPiEngine.........cccccoiiiii,

Loading the project

L:C Chart

Actions

Drill Downs

Items Load

Actions

Drill Downs

Orders Window

Actions

Drill Downs

Time Phased L:C

Actions

Maintaining stability of the time phased chart
Drill downs

Supply Demand for Item
Actions

Drill downs

Orderwise Waterfall
Display supply-demand summary
Time-phased load summaries
Customer order options

Item List Filter

Fields

Actions

Visual Planner User Guide



6

TABLE OF CONTENTS

Set Default ReSched Code
View Log
Undo

Using the toolbar

Chapter 5 Uploading Data to the System i .....ccceeeeiiivieiiiiiiiiieeeecceee e,

Upload settings

Write Schedule Pass

Save Plan - uploading data to the System i

Uploaded Data

Planned Order (PPPLNO)

Manufacturing Order Operations (PPRTGW.OUT File)
Requirements (PPREQM.OUT file)

Reschedule Activity Work (PPRACW.OUT file)
Source Of Demand reference (PPDMDR.OUT file)

Chapter 6 Planning Reports in VPi........ccccooiiiii

Load Profile Report

Purpose

Usage

Work Order Pegging Report
Purpose

Usage

Suggested New PO (Detailed) Report
Purpose

Usage

Part Supply Demand (Detailed) Report
Purpose

Usage

Shipping Buffer Expedite Report
Purpose

Usage

Visual Planner User Guide




7

Chapter 7 Running multiple warehouses in VPi

Appendix A Configuration Parameters

Appendix B Glossary

TABLE OF CONTENTS

Multiple Warehouse/Plants Setup

Step 1: Create required folder structures for each warehouse/location
Step 2: Create Plants for each warehouse/location using ResAdmin
LaunchPad Application

VPIi

DbuUtil

ResAdmin

Download

Putback

Create a Combo

Combining warehouse to create corporate planning

Steps Involved in Setting up Multi-Plant

Steps Involved in Setting up Participating Warehouses / Locations
Preparing for the download

Downloading and building corporate data with XA and APSI

Building corporate data in other scenarios (No XA or not using APSI )

Mandatory settings

Additional parameters

Specific customer parameters
RESPARA Table Definition for VPi

IseriesIntegration Setting for VPi

Visual Planner User Guide

Page 7
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About This Guide

The Visual Planner for System i User Guide provides instructions to install,
set up, and use Visual Planner for System i (VPi). Use this guide with the
integration guide for your ERP product to implement VPi.

Intended audience

This guide is intended for system administrators who install and configure
software and the manufacturing personnel who plan with MRP.

Prerequisite knowledge

You must be familiar with the System i and with the manufacturing and
planning modules for your ERP product.

Contacting Infor

If you have questions about Infor products, go to InforXtreme Online Support at
http://www.inforxtreme.com.

If you do not have an InforXtreme account, click Register now, and complete
the registration. You will receive a log-on ID and password within 24 hours.

When you access InforXtreme, you have these options:

To access Infor knowledge bases, incidents, documentation, software
downloads, and community discussion forums, click one of the links from
the top menu of the home page.

To add an incident, select one of these options from the Incidents menu:

Add Product Incident: To ensure that your report reaches the correct
support group, specify your product, version, and other details.

Infor Confidential- Please do not distribute Page 1
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Add General Information Request: Use this option for all other
requests.

To find the Customer Support telephone number for your region, click
Contact Infor in the top right corner of the home page, specify a product
name, and click Search.

If we update this document after the product release, we will post the new
version on InforXtreme. We recommend that you check this Web site
periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.

Visual Planner User Guide Page 2
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Chapter 1 Installing and Configuring VPi

1

This chapter introduces Visual Planner for System i (VPi) and provides the requirements and installation

instructions for VPi. See the integration guide for your ERP product for additional requirements.

The chapter consists of the following topics:

Topic Page
Overview 1-2
System Requirements 1-2
PC or Scheduling Station requirements 1-2
System i connectivity 1-3
VPi engine database 1-3
Installing and implementing VPi 1-4
Installing VVPi on client PC or Server 1-4
Creating an ODBC Data Source 1-5
Linking VPi to the ERP environment on the System i 1-5
Maintaining your Installation 1-6
Planning multiple entities 1-6
Deploying VPi for multiple Users 1-6
Deploying VPi for multiple Planners 1-7
Removing the Schedule Lock when one planner trips over other planner’s plan 1-7
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Installing and Configuring VPi

Overview

VPi is a standalone product which provides an ERP user the ability to perform MRP
generations, using data from the ERP system, on a PC.

VPi contains functions that extract data from the inventory and product database, run
requirements generations, and perform shop-scheduling routines. VPi matches supply against
demand and develops a supply plan for materials and production resources. Schedules can be
reviewed and maintained and uploaded to the MRP data file structure for further processing.

The data that is used in the planning functions comes from the same records that are used for
the current MRP generation. See the integration guide for your ERP product for information
about the data that is mapped into VPi.

VPi provides a user-friendly interface with graphic representations of planning data and drag-
and-drop operations to maintain the planning data.

You use multiple views, drill-downs, “what ifs,” and un-do steps to resolve material and capacity
issues to meet your customer requirements.

System Requirements

VPi has the requirements listed below. See the integration guide for your ERP product for
software requirements to use the ERP product with VPi.

PC or Scheduling Station requirements

Visual Planner Solution runs on Microsoft Windows Compatible Personal computer (PC). Visual
Planner downloads the warehouse data from your System | System (such as XA, LX or System
21) and stores locally on the PC. You can install the VPi engine and the Access database on the
planner's PC if the warehouse data is small (less than 2GB). If you have more than one planner

( or your warehouse data is huge), you can install the VPi engine on each planner's PC and install
the RDMS database such as Microsoft SQL Server on a separate server. Once the Visual
Planning Session is done, data is put back to your ERP System (such as XA, LX and System 21) to
update the MRP Screens. For connecting to the local database, VPi uses ODBC driver and for
connecting to | Series, VPi uses Client Access ODBC driver.

Visual Planner User Guide Page 1-2
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Here is the hardware and software requirement for running Visual Planner.

PC component Requirement

Processor

[ ]
Memory(RAM) o
Disk >
Operating °
System °

[ ]
Database

System i connectivity

Best In Class CPU ( 2-4 core processors) Intel or AMD X-86/ X- 64
Architecture

2-4 GB for Small and Medium sized warehouses
8-16 GB for Medium and Large sized warehouses

100 GB

Microsoft Windows 7/8/10. Any flavor of OS will be OK
Microsoft Windows 2008/2012/2016 Server Standard/Enterprise
Microsoft Access for small and medium sized warehouses ( MS
Access has 2GB file size limit)

Microsoft SQL Server 2008/2012/2014/2016 standard

The desktop that runs the VPi engine must be connected by an Open
Database Connection (ODBC) data source to the System i server on which the
ERP system is installed. Use Client Access Express, Version 5, Release 1 or
later for this connection.

VPi engine database

The VPi engine uses a Microsoft Access 2000 database (and above), shipped
in the DB folder in the INFORVPi installation folder, and an ODBC data source
pointed to it. Microsoft Access 2000 need not be installed on the PC to run
the VPi engine.

For those customers with larger databases, functionality has been added to

allow VPi to work with an SQL Server database. Contact your Infor

representative or Infor PSO for assistance.

Visual Planner User Guide
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Installing and implementing VPi

See the integration guide for your ERP product for setup instructions on the
System i.

Installing and implementing VPi includes these tasks:
Installing Infor VPi Software and entering license key, if required.
Creating and Defining an Open Database Connection (ODBC) data
source to the System i server running the Infor ERP application.

Modifying the iSeriesIntgration.ini File.

Defining and setting parameters for VPi planning within the VPi
application.
See the integration guide for your ERP product for more information.

Installing VPi on client PC or Server

VPi includes the VPi engine and requires the Material Requirements Planning
(MRP) module for your ERP product. If you do not have MRP on your System i,
install it using the normal installation process for your ERP product.

VPi is delivered on an ISO image on the Infor download center. Use your normal
procedure to download and copy the ISO image.

To install the VPi engine, double-click on the VPixxSetUp.exe/MAPSetup.exe file
for your ERP product. Follow the screen prompts to install the product.

When the software installation is complete, Visual Planner for System i appears
on your Start/Programs menu and two shortcut icons appear on your desktop.
Proceed to the next step to create an ODBC data source.

Visual
Planner

Visual
Planner...
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\

l Visual Planner For Syste... ~

% ConfigureMultiwarehouse

)
'ﬁ’ Unlinstall Visual Planner For...

a Visual Planner

E Visual Planner Download

Creating an ODBC Data Source

Your integration may require you to establish an ODBC connection between
your Windows desktop and the System i on which the ERP system is installed.
See the integration guide for your ERP product for instructions.

Caution: When creating a ODBC Connection, always remember to create a
system DSN instead of user DSN option tab on the ODBC driver selection.

Linking VPi to the ERP environment on the System i

Navigate to the INFORVPi folder on the drive on which you installed VPi. Edit
the iSeriesIntegration.ini file in that folder to identify the data source, the user
ID and password, the environment, and the warehouse.

See the integration guide for your ERP product for instructions to configure the
iSeriesIntegration.ini file, if required for your integration.

Visual Planner User Guide Page 1-5
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Maintaining your Installation

Periodically, VPi updates will be made available to you. To maintain your
installation:

1 Download the software.

2 Select Start>Programs>Visual Planner for System i>Uninstall Visual Planner for
System i.

3 Install the new version. See “Installing VPi” for more information.

4 If you renamed one or both VPi desktop icons, installing a new version may
create new icons with the original name. If so, delete these new icons.

Your original configuration information is maintained; therefore, you don’t need
perform any other steps.

Planning multiple entities

Visual Planner allows you to run multiple warehouses on the same PC. Visual
Planner needs to be configured to accommodate multiple warehouses. Luckily, a
Launch Pad Utility (Launchpad.exe) distributed with Visual Planner software helps
you create the multiple warehouses environment. There is an entire chapter
dedicated setting up multiple warehouses. Please refer to the Chapter titled
Running Multiple warehouses” later this Guide.

Deploying VPi for multiple Users

Visual Planner allows you to access VPi Session results from multiple client
desktops with one station treated as Master desktop with other desktops behaving like
read only client. Normally, Microsoft SQL Server as database is better in such
environment due to more secured deployment of data. If you use Microsoft Access
database, then the database file needs to be located on a shared drive so that user from
all VPi client work stations can have access to the database. VPi engine needs to be
installed on each of the client desktops and setting up each of the client with a master
and slave configurations. This is done thru changing the iSeriesIntegration.ini
configuration file. Please refer to Appendix A for further details. Please find below one
typical such configurations where only one person (Master) does the actual planning
but others do the enquiry on the supply demand and other planning status inquiry.
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Server
VPi Shared database

Inquiry
VPi Engine

VPi Engine
DownlLoadMode=0"

Down LoadMode=1*

Inquiry VPi Engine
VPi Engine DownlLoadMode=0"
* iseriesIntegration.ini setting DownLoadMode=0"

Deploying VPi for multiple Planners

In many environments, many planners are involved in generating master plan for the
entire warehouse with each planner being responsible for certain cells or product lines
or department. Vpi allows individual planner to check their supply or schedule status
any time. However, allows only one person to write the schedule at a time. If individual
planners nee to save the schedule and write the database, then wait until the first
planner is done with her planning and then start the planning session. By restarting the
visual planner session, all the decision taken by the first planner is loaded back to
memory and becomes reference for the second planner to start building her plan on

top of the first plan.

Removing the Schedule Lock when one planner trips over other planner’s plan

When deploying for multiple planners, in some situation it may so happen that while
first planner was writing the schedule either she aborted her planning or second
planner started writing her department schedule, you may see a following error

message

Visual Planner User Guide Page 1-7
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Visual Planner for System | *

Write Schedule Pass is in progress by other user,
Please try later.

]

oK

This prevents any user from writing the schedule. If this was accidental, and you want to
still go ahead with writing the schedule, you can do so by following below instructions:

Open Visual Planning Engine, go to Reports menu, there is a menu command Remove
Write Schedule Pass Lock (second in the list below), that gets enabled if there is a write
schedule lock. User can click the menu to remove the lock as shown below:

== Visual Planner for System i - (MFG1) - (05/01/2017 - 06/09/2017)
File Display Reports DB Maint Windows Help

B""l&l J Run Report... _| Elﬁé]ﬁ | |+|_ID ’ E
. Remove Write Schedule Pass Lock

= L:CForPl Write Schedule Pass

Workcentel

Workcenter - WO Back Flushing Summary

Units 1

Visual Planner User Guide Page 1-8
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Chapter 2 VPi Concepts

VPi uses MRP data from the System i and replaces the MRP planning run. This chapter provides a

summary of the information flow within VPi and how it compares with MRP.

The chapter consists of the following topics:

Topic Page

Role sharing between VPi and ERP 2-3
Information flow 2-4
Before you plan 2-4
While you plan 2-5
After you plan 2-6
Demand management 2-6
Forecasts and Safety-stocks and Replenishment of items 2-6

FOrecast CONSUMPTION ......cc.uvieiiieeeiee e e et e e ee et e e e et e e et a e e enaa e e snae e e snneeennaaeennees 2-6

MaNAGING FOMBCASTS. ... .eiiiiiiee e eaa e e saa e e ees 2-6
Replenishment Forecasts 2-8
Safety Stock Forecasts 2-8
Consuming forecasts 2-8
Total and Unconsumed Forecast 2-9
Viewing forecast consumption summary 2-10
Viewing forecast consumption Detail 2-11
Planning with VPi 2-13
Planned order quantity 2-13
Manufacturing order lead times 2-14
Purchasing time fences 2-14

Visual Planner User Guide
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Order rescheduling

Control items

Item Processes

Forward scheduling

Lot sizing policies

Negative BOM functionality
Inputs:

Config Changes

Example

Multi-sourcing Capability
Inputs to Visual Planner
Output from VPI

Back flushing in Visual Planner
Back flushing when multiple work orders are in Progress

Checking Back flushing details

Visual Planner User Guide
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2-15
2-16
2-16
2-16
2-17
2-17
2-18
2-18
2-20
2-20
2-21
2-23
2-25
2-25
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Role sharing between VPi and ERP

Visual planner is an interactive Planner. It serves the role of MRP planning module in your ERP
system. If you are familiar with MRP screens, they should continue to work once Visual Planner
is deployed. The underlying data now gets refreshed from the data coming from Visual Planner
planning session rather than from an MRP run. Biggest benefit you get from deploying Visual
planner is in your ability to see the exact time phased load profile on your facility thus ability to
anticipate potential overloads and take suitable action on the supply and customer orders and
the facilities. As shown in the picture below, inquiry and decision making role will be moved to
Visual Planner session (you can still override many of them in your MRP too) ,while execution of
the plan ( such as releasing work orders and purchase orders and shipment still owned by your
ERP system. Your entire enterprise data still owned and reside in the your ERP system and ERP
system is your primary execution tool. Visual Planner enhances your ability to visualize and
anticipate potential road blocks for your plan and helps you take right decision for the given

scenario.

Roles of XA/LX/S21 and VVPI

eI
B MPS Sereens
Infor System | 7
Shop Floor Systems
I 4
Procurement Screens
7
Schedules
"""" [
il L Decisions |
Low to Mewnny b qFi Enyina I
|
|
|
Blanning Reports) :
=
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Information flow

Planning with VPi consists of the steps that you perform on the System i before you download
data to VPi; the download process, planning, and uploading data; and the steps that you
perform on the System i to use the plans that you executed. The following figure shows the

information flow between the host system and within VPi.

‘ Host System |<

Extract J

Transfer Data \Pi

e
el

Configuration
Settings

Map Data and split forecast

SR Plarisine)
Enloirie

Upload Plan

Write Schedule Pass

A

Cancel

Load data and
perforn forecast
consumption

Before you plan

Supply and demand information that is used by MRP is used in VPi planning.
Review the data on the System i before you download the data to VPi. The
success of planning in VPi is dependent on the quality of the data that is

downloaded.

The demand can come from these sources:

Forecasts

Visual Planner User Guide
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Customer orders
Expected customer orders
Resupply or replenishment orders
The supply information can come from these sources:

T On handinventory
h  Open manufacturing orders

€ Open purchase orders, blanket orders, and requisitions, and open intersite
orders
" Firm planned manufacturing, purchase and inter-site orders as supported in
t
MRP.
e

The items and customers in your ERP database may be downloaded to VPi.
Verify that this information is accurate. VPi uses item and customer information
but you cannot maintain the data in VPI.

Many of the item and planning codes, horizons, and other parameters from
MRP planning are also used in VPi planning. See the integration guide for your
ERP product for more information.

While you plan

Manage planning from the VPi planning engine. You perform these steps, either
interactively or in batch mode.

Download: Demand data is transferred to the VPi engine. Identification of
the data to download and the download process are determined by your
ERP product. During the download process, customer orders consume
forecasts, and VPi uses only customer orders and unconsumed forecasts to
drive planning.

Plan: VPi matches supply against demand and develops a supply plan for
materials and production resources. You can review, interact with, and
modify the plan. You use multiple views, drill-downs, “what ifs,” and un-do
steps to resolve material and capacity issues. VPi stores your actions and you
can save the plan. See “Using the VPi Engine” for more information.

Upload: When you save the plan, VPi extracts data and transfers it to the
System i. The upload process updates the ERP product's files. See the
integration guide for your ERP product.

Visual Planner User Guide Page 2-5
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After you plan

Review and release manufacturing, purchase, and inter-site orders. Make any
manual adjustments necessary to synchronize the ERP product's files with the
uploaded plan.

Demand management

Demand management, that is, recognizing all demands for your production, is critical to
managing resources. Demand management includes forecasting, order entry, and order
promising as well as interplant requirements.

Forecasts and Safety-stocks and Replenishment of items

Visual Planner can add tremendous value to your corporate forecasting module by helping you
to spread out or split forecasts into weekly or daily buckets, demand fencing and automatic
generation of safety stocks and replenishment. VPi also does controlled multilevel BOM
forecast consumption by product family, customer class etc.

Forecast consumption

During planning session, VPi consumes forecast demand with customer sales order demand. All
customer demand and any unconsumed forecasts are considered for planning. Forecast
Consumption can be restricted by month, week or by other periods, if the forecasts are in
smaller periods.

For example, a forecast of 100 per month is divided equally into four weekly forecasts of 25. A
customer places an order for 55 in the third week of the month. VPi consumes the third-week
forecast of 25, then works toward the beginning of the month, consuming the second-week
forecast of 25, and then finally consumes 5 of the first week forecast of 25. If insufficient
forecast exists at the beginning of the month, VPi consumes any available forecast to the end of
the month.

Managing forecasts

To manage forecasts, you can either define the planning periods as weeks or months.

If planning utilizes a 445 (4 week, 4 week, 5 week) production calendar, the recommended
option is to convert all the first-year periods being planned in VPi to weeks. Use the appropriate
program in your ERP product to convert the planning periods to weeks before you perform the
download. If you do not, because months and forecasts have different lengths and the forecast

Visual Planner User Guide Page 2-6
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is always loaded on the first day of the planning period, some months may have two forecasts

and other months may have none. This will result in unsatisfactory forecast consumption.

The preferred option is to maintain monthly forecasts and use VPi to split the forecast into

weekly numbers. With this option, you split the forecast in VPi after you perform the download.

To best utilize Forecast Splitting and Consumption in VPi, we recommend that you download

"monthly" forecast demand and use the splitting function to split 2 or 3 months into weekly

buckets (Once Every 5 Days for a Monday through Friday shop or Once Every 7 Days for a

Sunday through Saturday shop).

To use the monthly split option:

In the INFORVPi folder, run Dbutil.exe.

Select File > Download Configuration.

Select the Order Board tab.

£

]

Modify Configuration

File View Help
Fel s ? Download Configuration | Download Files | Download Fies(Cont'd) | Options Order Board |

Forecast Splitting

i I~ Spit until Next Forecast

Order Board Matching
Swingdays: 2 =

Closed order cutoff : |14 5' Day(s)

No Of Buckets J:l

[ Forecasting Method
& Monthly
C Weekdy
" By Period

Spliting Period

Forecast Fence : [10 = Dayis)

|
i First Window : |1 4,: Months
[ Second Window : |4 _,j Morths

Once Every |2 4‘: Dayls)
Once Every [7 =] Dayée)

rReady

4 For Forecasting Method, select Monthly. (if you see this option disabled, click on Split Until
Next Forecast checkbox to uncheck).

If you are sending forecast in weekly buckets, then you can select by Weekly or if by

manufacturing period, then By period option.

5 Specify the Forecast Fence

Visual Planner User Guide
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Forecast fence helps you to drop past due forecasts (last month and prior) and for next 10
working days, assemble final products for customer demands only. Any forecasts prior to the
forecast fence date during the current month are moved after the forecast fence date. Thus, if
you are doing a planning session on May 15" then prior April month and before forecasts will
be dropped and any forecasts between may 1* to May 15" will be moved to May 16",

Enter the Splitting Periods.

VPi allows you to define telescopic buckets for different splitting periods for each time window.
Thus, you can have for first 1 month, the monthly forecast into daily demand quantity. Then
from month 2 to 4, split the monthly forecast into weekly forecast demands. Any future
forecasts from month 5 onwards are not split. When a forecast is split, the forecast due-date
will be set to first working day of the time bucket.

Click OK.

Next time onwards, whenever you download data from your ERP systems, VPi will automatically
applies all the rules you defined above and creates a clean forecast board for planning.

Replenishment Forecasts

If an item production or consumption is fairly uniform, you can greatly reduce your burden of
maintaining forecasts by letting Visual Planner do that job with the help of replenishment
forecasts. If you define the reorder point quantity and a replenishment period (days) for the
item, Visual Planner will create the forecasts records automatically, at those regular intervals.
All Visual Planner features such as forecast splitting, forecast fencing and forecast consumption
are available on these forecasts.

Safety Stock Forecasts

Just like replenishment forecasts, you can also define safety stock quantity for an item and
Visual Planner automatically creates one single safety stock demand for planning. Unlike
replenishment forecasts safety stocks are not meant for forecast consumption but for keeping it
in stock to meet any contingencies.

Consuming forecasts

Forecast can be consumed in five ways:

1. Individual item.
This is the simplest way as it requires no special coding. The sales of each item
consume the same item forecast. These forecasts are ‘NULL’ family forecasts.

Visual Planner User Guide Page 2-8



2-9

VPi Concepts

An item and its parents. If many possible finished product configurations exist,
made from a small number of components, you can forecast at the component level
rather than the finished product level. No finished product forecast is entered. As
VPi consumes forecast at the highest level with a forecast as the components, the
forecast is consumed there since the customer order demand is exploded through
the bill of material levels. These forecasts are ‘FULL’ family forecasts.

Planning Bill Family
Planning bill family. Identify an item as a planning bill item and enter forecasts for
the item. In the bill of material, for the optional components, multiply the quantity
required for one unit of the planning item bill by the expected percentage usage of
that option. VPi explodes the forecasts for the planning bill item through the bill of
material until it reaches a nonphantom item, then it forecasts that item. Do not
enter customer orders for the planning bill since its bill of material is a component
bill that cannot be manufactured. Enter customer orders for items with a bill for a
specific configuration, and when the components in the ordered configuration
match the components in the planning bill, the forecast is consumed.

Product Family Forecasts
For the items you want the consumption to happen you define a common product
family in the item master. They may not be related by BOM relationships. The
“Base” Item is forecasted. Customer Orders for family items consume the “Base”
Item’s forecast. They always consume at the item level itself and not at their
component level. This is useful for reserving capacity for configured items. Before
you reserve the capacity you may not know the specific configuration you are going
to receive, but you may plan to allocate a percentage capacity of valuable resources
for each family lines.

Customer specific or Customer class specific consumption
This option helps you to further narrow down the consumption of forecasts for
specific customers or a class of customers. This requires additional data to be
maintained in VPi and expert skills to configure. Please reach out to your project
consultants to help if you want to explore this option.

Total and Unconsumed Forecast

VPi shows the total forecast in Forecast Demand, and after planning, it shows only the
unconsumed forecast in Requirements. Only the unconsumed forecast (in addition to
Customer orders and safety stocks) is used in planning.

Upload builds forecast requirement records for the unconsumed forecast.
The next Download deletes the unconsumed forecast records.
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VPi shows the total forecast from all sources in Forecast Demand. VPi
consumes forecast to determine the forecast used in planning and updates the
MRP requirements file with the results.

Viewing forecast consumption summary

To view a summary of forecast consumption:

Start your VPi planning session and load the Project by going to menu, File ->
Load Project. Loading project dialog and it takes a minute to load the data into
memory and once loaded Wait until Select Display > Forecast Consumption -
Summary

This window shows you consumption of all forecast records that are
downloaded. Forecasts can be consumed by sales orders for that item or of its
parent item based on how you have configured the forecast. You must maintain
a list of items for which you want the forecast to represent the forecast for the
entire demand stream of the item.

aFurecast Consumption !EI
Forecast ID Part ID Customer ID Forecast @) Consume |Gty On Ord) Forecast Family |Original Target Dat{ Projected Comple| Forecast Type

FORECAST CMPOC10 530 0 530 05012017 05012017 INPLIT
2 FORECAST CMPOC10 10 0 110 0B032017 0B032017 INPLIT
3 FORECAST CMPOCTS 247 0 247 05012017 05012017 INPLIT
4 FORECAST CMPOCTS 10 0 10 0BM32017 0BM32017 INPLIT
5 FORECAST CMPOM25 288 0 288 05012017 05012017 INPLIT
[ FORECAST CMPOM25 184 0 184 0BM32017 0BM32017 INPLIT
7 FORECAST ChiPOMES 73 0 73 0501 52017 0501 52017 INPLIT
8 FORECAST ChiPOMES 174 0 130 06362017 06362017 INPLIT
9 FORECAST ChPLC1D 336 0 336 0501 52017 0501 52017 INPLIT
10 FORECAST CHPLC10 101 0 101 0B032017 0B032017 INPLIT
1 FORECAST CMPLCTS 163 0 169 0502017 0502017 INPLIT
12 FORECAST CMPLCTS 143 0 143 0B032017 0B032017 INPLIT
13 FORECAST RTAOM4S &0 0 0 0502302017 0502302017 INPLIT
B

By default, the forecast specified is consumed only by sales orders for that item.
In addition to the forecast downloaded from your ERP, safety stock forecast
records are generated for items for which safety stock is specified. Safety stock
is not consumed; it serves as an additional requirement for the item. Safety
stock requirements are placed at a fixed duration from the current date. See
the FMT file for Item for your ERP for more information.

The Forecast Consumption window displays this information:

Forecast ID
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A descriptive, non-unique identifier for the forecast record.
Part ID

The item being forecast.

Customer ID

Identifies the customer if forecasting at the customer level rather than utilizing the
traditional global forecast.

Forecast Qty

The quantity being forecast for that item in that planning period.

Consumed Qty

The forecast consumed by Shipments in that planning period.

Qty On Order

The forecast quantity consumed by open customer orders in that planning period.
Forecast Family

The family ID flag that determines if a forecast is non-consumable (FULL) or if the
forecast is associated with a planning bill family or a product family

Viewing forecast consumption Detail

Forecast consumption Detail provides the detailed information regarding the target customer
order consuming the forecast order and hwo much quantity.

To view a summary of forecast consumption detail:

Start your VPi planning session and load the Project by going to menu, File -> Load Project.
Loading project dialog and it takes a minute to load the data into memory and wait until loaded
once .

Select Display > Forecast Consumption — Detailed
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T s
&l Sales Order  Product ID Customer Il Request Date | Open Forecast ID Part ID Target Date Used OTY Status
A0 ORDOI 454 1 L CMPOCHD e RN NNRN BN J FORECAST. S CMPOCID.: :i | BSH01 /0 K L AR DN ORDER © i
2 |oRDO1S.135 CMPOCTO 057207 FORECAST CMPOCTO 05012017 130.00 | ON_CRDER
N B R SRR T T At o0 |FORECAST T CoeoME T [OgmmiT T T o oLoRDER T
4 | ORDOS3ATS CMPLCTS 05152017 FORECAST CMPLCTS 05012017 £6.00 | ON_CRDER
5 ORDO2E1ES [ CMPOCTS i B L R R R e e [ PORECAST- 11 OMPAGTS & 1| OSINTIORT B T00 | © s 4500 ONORDER &
& | oRDO3E_101 CMPOMBS 05A 3207 FORECAST CMPOMES 05012017 ON_CRDER
7 |G EHELCT EEE |FORECRST. |1 WPLED L 09 | OOREER |
& | ORDO1B_138 CMPOCTD 05A12017 FORECAST CMPOCTO 05012017 ON_CRDER
8 |ORDOZI ARG CMROMAS CROSELT L 9000 | FORECAST o CMPOMED L OSMMUZONT. s AOR00] e 500 ONORDER 1
10 | ORDO3T_102 CMPOMBS 05152017 FORECAST CMPOM3S 05012017 ON_CRDER
TR TR B T TTmNERT T w300 FOREGAST T CWPLGI TR T [oR_oROER T
12 | ORDOIT_137 CMPOCTO 0572372017 FORECAST CMPOCTO 0501 /2017 ON_CRDER
13 | ORDEZI IS4 CMPDOCTE it T DBRARET | 000 | FOREGRST ) CMPOGTE 1 BADTTHT L [ ONCORBER T
14 | ORDO3B_103 CMPOMBS 057202017 FORECAST CMPOMES 05012017 ON_CRDER
15| GRD0GS WG] T |FORECRST. [ CWPOTE L 09I LR
16  CRDO1E_136 CMPOCTO 052172017 FORECAST CMPOCTO 05012017 55.00 | ON_CRDER
A7 ORDRI9 04 EMPOMES 1k R OSRAT L A000 | FORECAST o CMPOMES L OSMMUZONT. R0 00 ONORDER L
18 | ORDO4B_170 CMPLCTO 0572472017 FORECAST CMPLCTO 05012017 75.00 | ON_ORDER

Sales Order

Customer Order along with the line number consuming the forecast

Product ID

Customer Product that is built by consuming the forecast

Customer ID

Customer Number

Request Date

Customer Requested Dated. This date is used to find which forecast bucket to

consume

Open Quantity

Customer Quantity still open

Forecast ID

Forecast Number being consumed

PartIiD

Forecast part being consumed ( can be assembly or a subcomponent that is needed by

customer order

Target Date
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Target of the forecast order
Forecast Qty

Total quantity of the forecast
Used Quantity

Portion of the forecast being used up in building the sales order
Status

Whether customer order is already shipped ( in which case forecast is already
consumed and has a staus of CONSUMED no more in the system) or if the customer order is still open (
in which case the forecast is still ON_ORDER)

Planning with VPi

Review the following concepts that are used in VPi.

Planned order quantity
VPi determines planned order quantities for all items as follows:

1 Subtracts on-hand, open orders, and firm planned orders from the timephased
item demand to get time-phased net demand.

2 Totals the net demand over the item aggregation period.

3 Increases to the item minimum, if the item minimum is larger than the net
demand

4 Rounds up to a multiple of the item multiple if an item multiple is specified

5 If an item maximum is specified:

If purchased, plans the order and issues an exception if the
order quantity is larger than the item maximum If
manufactured, plans the order for the item maximum if the order
guantity is larger than the item maximum
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6 Subtracts the order quantity planned from the demand, and returns to step 2

until orders are planned for all demand.

Manufacturing order lead times

VPi calculates lead times for manufacturing orders using order quantity and
routing and workcenter data, specifically workcenter standard queue time and
operation setup time and runtime. VPi also assumes that, except for operations
in which the entire order is processed at once, operation times are overlapped
as individual items are moved to the next operation as they complete the
current operation. Therefore, you should review and update workcenter
standard queue times, as they are used to determine planned manufacturing
order lead times.

Note: The default calculation is to overlap operation times. A parameter in the
Config.ini file allows for consecutive operations. Set TransferEntireBatch to 1 to
use consecutive operations. See Appendix B "Configuration Parameters" for
more details.

Purchasing time fences

Order rescheduling

VPi does not consider the Firm Time Fence or the Authorized Time Fence.
Purchase orders are flagged for release only if their start date is on or before
the Release Date.

If an item reschedule code is left as 0, VPi defaults purchased items and master
level items to 1 (no automatic rescheduling) and all other items to 4 (automatic
reschedule in and out).

The minimum days to reschedule field, for both the site and the item, is
ignored. The minimum days to reschedule days is 1 for all items.

The automatic reschedule options for all three types of orders, specified when
you initiate an MRP Planning run, are treated as Yes.
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Control items

The Due date in past (automatic reschedule options) for all three types of
orders, specified in Planning Run Execution Options, are handled based on the
reschedule frozen zone:

If the reschedule frozen zone is 0, VPi uses no frozen zone. For items
specified as automatic rescheduling, the order is rescheduled to align with
the demand.

If the reschedule frozen zone is positive, the past due order is in the frozen
zone, and is not rescheduled.

Control items are those items with an item reschedule code of 1, 2, or 3, or
master-level or purchased items with an item reschedule code of 0.
Manufactured and purchased items are treated the same way. VPi does not
automatically re-schedule open and firm supply orders for control items. You,
however, can manually intervene during the planning session to reschedule the
orders.

VPi deletes and recreates planned orders for control and non-control items
each time it explodes through the bill of material. All open and firm planned
orders for non-control items are generally rescheduled during each explosion.
The exceptions to this rule are as follows:

Open and firm planned orders are not rescheduled within the rescheduling
frozen zone.

Open and firm planned orders are not rescheduled if the order reschedule
code is 5.

You can identify additional control items during a VPi session.

VPi allows multiple valid item revisions on one date and multiple item processes

for each item revision. An item revision can have only one primary item process
on one date. VPi also lets you control how many item processes and
corresponding bills and routings are downloaded for planning. See the file
mapping for your ERP.
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Item Processes

Forward scheduling

Lot sizing policies

VPi determines the effective item process for planned work orders as follows:

Find the item revision with the latest effective-from date less than or equal to
the order start date.

If multiple revisions with the same effective-from date exist, find the one with
the latest effective-to date

Use the primary item process for the item revision effective on the order start
date.

Forward scheduling ensures that reasonable dates are set for order due dates.
Suggested due dates in the Supply Demand window and Orders window are set
to these dates if the orders are past due. The earliest feasible date for a supply
is calculated using minimum queue times and is affected by the following:

Horizon start
Back wall due to firm order due dates

Minimum lead time for purchase parts

VPi supports lot sizing policies for both make and purchase items. The quantity
of planned supply is determined using the following parameters in the part
table:

Aggregation period (in days)
Purchase Multiple of (quantity)
Minimum lot (quantity)

Make Maximum Lot (quantity)

VPi generates a planned supply order on the date of the first shortage for all the
requirements over the aggregation period. It then adjusts this quantity by the
minimum lot if the supply quantity is less than the minimum lot and the
purchase multiple-of, by rounding the quantity up to the nearest multiple. For
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manufactured items, VPi plans orders no larger than make maximum lot, if one

is supplied.

Negative BOM functionality

Negative BOM or Reverse bills of materials is common scenario within the context of product
disassembly, reverse engineering, and parts recovery. In normal BOM, components are
consumed while building an assembly. “Reverse BOM” means that a component is generated
and added to stock while building an assembly and as such the BOM is effectively negative gty

requirement.

In VPi, Negative BOM is now treated like a normal BOM but with the twist that demand for an
assembly would generate a supply for a child instead of a demand for component which

happens with a normal BOM where quantity per parent is positive. This approach will make it

very simple to understand and explain the underlying logic and resulting outputs from Negative

BOM scenarios.

Now, all Byproduct/reclaimed supplies are written to T_INTERNAL_DEMAND table and their
pegging information is written to T_DEMAND_PEGGING table. This is true whether the
byproduct or reclaimed part is a make part or a buy part. These byproduct and reclaimed parts
could be consumed elsewhere if the demand is coming from a different work order than where

it was originally generated.

Inputs:

The inputs are provided in WOAlloc table if there are open work orders; and in BOM for
standard routings. The format of the data is given below:

In WOALLOC table:

WORK_ORDER_ID | CHILD_PART_ID | QUANTITY_REQUIRED | QUANTITY_ISSUED | JOB_STEP_ID | QTY_PER_PARENT
WO1 BYPROD -12 4 30 -2
WO1 REQPART 12 4 10 2

In the above example, BYPROD is produced as a byproduct of assembling ASSEBLY with
REQPART. This is indicated as a negative requirement at jobstep 30. QUANTITY_REQUIRED of
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negative 12 indicates this component is put-back to stock. QUANTITY_ISSUED indicates how

many of these BYPROD are produced for the entire work order.

The same scenario is represented in BOM table as follows:

PARENT_PART_ID|PARENT_JOB_STEP_ID|PART_ID |[QTY_PER_PARENT
ASSEMBLY 30(BYPROD -2
ASSEMBLY 10|REQPART 2
Config Changes

This functionality is available thru a configuration parameter called DiscardNegativeBOM=0 in

the [System] section. By default, value for this parameter is 1, indicating Negative BOM records
will be ignored in both WOALLOC and BOM inputs.

Example
SALES

ORDER_ID PART_ID [PROMISE_DATE|ORDER_QTY|DEMAND_KEY
O0OMANUAL 000000 |ASSEMBLY 1/3/2013 100 1
O0OMANUAL 000000 |ASSEMBLY 1/15/2013 100 100

JSBOM

PARENT_PART_ID|PARENT_JOB_STEP_ID| PART_ID [QTY_PER_PARENT
ASSEMBLY 100 REQPART 9
ASSEMBLY 100|BYPRODUCT -3

In this example, while building each of ASSEMBLY, 9 gty of REQPART is consumed and while
doing so, BYPRODUCT is put back to on hand. Basically, 3 of BYPRODUCT is disassembled while
building each of ASSEMBLY. In the output tables, following is expected.

T_INTERNAL_DEMAND

DEMAND_KEY

WORKORDER _ID

PART_ID |wWoO_QTY

START_DATE|DUE_DATE

EST_SOURCE

2

RWO1

ASSEMBLY 100 1/3/2013

1/3/2013

Visual Planner

User Guide

Page 2-18



2-19 | VPi Concepts

T_INTERNAL_DEMAND
DEMAND_KEY|WORKORDER _ID| PART_ID |WO_QTY|START_DATE|DUE_DATE|EST_SOURCE
3 RWO2 REQPART 900 1/3/2013| 1/3/2013
4 FNWO4 BYPRODUCT 300 1/3/2013| 1/3/2013 RWO1
11 RWO11 ASSEMBLY 100| 1/15/2013|1/15/2013
12 RWO12 REQPART 900| 1/15/2013|1/15/2013
13 FNWO14 BYPRODUCT 300 1/15/2013|1/15/2013 RWO6

FNWO4 and FNWO014 : New Work order series to identify that this work order is coming from
Negative BOM. Each such work order should have unique work order ID since there could be

multiple Negative BOMs for the same Parent. Its EST source should be set to the parent work
order that generated this by-product.

T_DEMAND_PEGGING
CHILD_KEY[PARENT_KEY|| REQ_DATE |PEGGED_QTY
2 1 1/15/2013 100
3 2 1/15/2013 900
2 4 1/15/2013 300
11 100 1/15/2013 100
12 11 1/15/2013 900
11 13 1/15/2013 300
4 -1 12/31/2075 300
13 -1 12/31/2075 300

InT_DEMAND_PEGGING table, RWO1 will be pegged to FNWO4 to indicate FNW04 was built
(as a by-product) from RWO1. Similarly, RWO6 will be pegged to FNWOS9.
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Multi-sourcing Capability

Many of VPi customers have multiple strategic vendors who can supply the same buy parts. Any
suggested purchase orders now can be directed any of these vendors instead of going to
primary vendors. You can specify the list of vendors for each buy parts and their percentage
allocations and effective horizon and any other relevant information in the SC_PART_VENDOR
table. VPi can either split the requirement into these vendors or use rotating rule to direct the
requirements to just one vendor. This rule is part specific and is downloaded to
PRIMARY_VENDOR_ID in PART download. Thus, if you specify __S for PRIMARY_VENDOR_ID,
then split sourcing is applied as per the values in the SC_PART_VENDOR for that part. If __Ris
specified, then rotate rule will be applied. Please contact Infor Support for detailed documents
and illustrations for this functionality.

Along with Buy Parts, VPi also allows Multi-Sourcing for Make Parts internally and have a shared
portion with Vendors. In other words, to have a certain % to be built in house, then the rest
outsourced to Vendors. For an example, from a particular Start Date to End Date, have 75% of
an item built in house, then 25% outsourced to Vendor(s). This feature can be beneficial for
Multi-Plant environments to control the resources throughout the Supply Chain, or for a
business to ramp up production on an item that was outsourced.

Inputs to Visual Planner

All the data required in VPI planning session resides in SC_PART_VENDOR table in VPI local
database. For Make parts, this table will contain the allocation percentage i.e. a certain % which
needs to be built in house, then % which needs to be outsourced to Vendors. It also contains
the master list of vendors for the item being out-sourced.

Here are the sample demo records in different master tables:

PART table: Here CMPOC10 is a Make part and we have set its Primary_Vendor_ ID="__S”
which means apply Split sourcing rule. COVER-1 is a Buy Part and we have set Split Sourcing Rule
for this one too.

PART_ID | QTY_ON_HAND | PART_TYPE | MRP_LEAD_TIME | BUYER_ID | PRIMARY_VENDOR_ID
CMPOC10 0 0 9  BYR9 s
COVER-1 0 1 4  BYR7 _s

SC_PART_VENDOR table: For make part CMPOC10, we have defined split rule in this table with
one record only that too for vendor MAKE-V1 for allocation percentage 25%. This means 25%

needs to be outsourced to vendor MAKE-V1 here; rest remaining percentage needs to be
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produced in house which amounts to 75%. This rule is applicable for 2 months only i.e. from 1st
Jan 2014 - 28" Feb 2014. So for demand generated during this period will be 75% manufactured
inhouse and 25% will be outsourced. Any demand for this item outside this period will be
manufactured inhouse.

VENDOR_I | MRP_LEAD_TI | START_DA ALLOCATION_PERCE | VENDOR_PRIORI
PART_ID | D ME TE END_DATE NT TY
CMPOC1
0 MAKE-V1 20 01-Jan-14 28-Feb-14 25 0
COVER-1 RAW-V1 20 01-Jan-14 31-Dec-14 40 0
COVER-1 RAW-V2 20 01-Jan-14 31-Dec-14 60 0

SALES table: We have 2 orders for make part CMPOC10 as shown below — ORD014 for 150 gty
which is required on 12" Feb 2014 (outside split rule range); and another order ORD018 for 250
gty which is required on 5" Mar 2014 (within split rule range).

ORDER_ID | PART_ID

PROMISE_DATE

CUSTOMER_ID | ORDER_QTY | TARGET_COMPLETION | PROJECTED_COMPLETION

ORDO001 COVER-1 @ 01-Feb-14 BRISTOL 200 01-Feb-14 01-Feb-14
ORDO014 CMPOC10 12-Feb-14 HONDA 150 12-Feb-14 12-Feb-14
ORDO018 CMPOC10 @ 05-Mar-14 ROCKWEL 250 10-Mar-14 10-Mar-14
Output from VPI
Waterfall for ORD014:
Start Date order ID . Parl Eg Sales order ORDO14_134 for HOMDA, projected 02128/2014, qtw=150.00, Priority=0
EI% Part CMPOC10, on_hand=0.,00, short=150,00
02202004 ORDO01 121 BRISTOL |COVER-1 ..... RO OPOS 4, Due dabe: 02(22(2014, TE: 74, Total Wi gby: 37.00, Pegged gt 11
ORDO14_134 HOMDA, | CHMPOCID -] WO: RWO1, Due date: 02/22{2014, TB: 60, Total WO qty: 113.00, Pegged gty: 113.00
02M4i2014  |ORDO15_135 ROCKWEL |CMPOCT0

You will notice that VPi has generated 2 planned orders for meeting demand of 150 pieces
coming from Sales order ORD014 for CMPOC10 using 75 — 25 splitting rule:

One Planned Workorder RWO1 which needs to be manufactured in house for qty 113.
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One Outsourced WO named OPO3_4 which needs to be outsourced to vendor V1 for gty 37.

Waterfall for ORD018:
Start Date order 1D EIEEr pari E||B Sales order ORDOLE_135 for ROCKWEL, projected 03/10/2014, qty=250.00, Priority=0
E% Part CMPOC10, on_hand=0.00, short=250,00
Ll 2L RD0M_1 21 BRISTOL |COVER-1 ue date: 03/04/2014, TE: 60, Total W 50.00, Pegged gby: 250,00

ORDOT4_134

HOMDA |CWPOCT0

02142014 |ORDO1S_138

ROCKWEL |ChiPOC10

Since ORDO018 doesn’t fall within sourcing rule period, so it needs to be completely produced in

house and hence you will notice that VPi has generated one only planned work order RW023

for meeting demand of 250 pieces coming from this Sales order .

T_INTERNAL_DEMAND table: You will see record for outsourced PO in T_INTERNAL_DEMAND
table with Internal_Demand_Type = 2 which signifies outsourced orders

PART_ID | WORKORDER_ID | START_DATE | START_TIME | DUE_DATE | INTx_DEMx_TYPE | QTY
CMPOC10 OPO3_4 11-Feb-14 0 22-Feb-14 2 37

CMPOC10 RWO1 22-Feb-14 8280 22-Feb-14 O 113
CMPOC10 RWO23 03-Mar-14 9000 04-Mar-14 0O 250

T_TO_MAKE table: For outsourced PO, there will be only one record in T_TO_MAKE with
jobstep_id as Oworkcenter_id as “TPUT_OUTSRCE” which means this order needs to be

outsourced.

WORKORDER_ID | JOB_STEP_ID | RUN_TIME | QTY | DDB_DATE | WORKCENTER_ID | PART_ID

OPO3_4 0 504000 37 11-Feb-14  TPUT_OUTSRCE CMPOC10
RWO4 5 27120 226  22-Feb-14  GRD75L BCSTNGS
RWO4 4 27120 226  22-Feb-14  TBORE1 BCSTNGS
RWO4 3 6780 226  22-Feb-14  DRLCNC BCSTNGS
RWO4 2 8136 226  22-Feb-14 MLG11X BCSTNGS
RWO4 1 576000 226  10-Feb-14  LTH2NC BCSTNGS
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Back flushing in Visual Planner

Visual Planner implements a novel way of accounting for back flushing. Components required
for an assembly work order are automatically deducted from on hand stock in the warehouse
and if the on hand falls below zero, a new requirement is automatically included during Visual
planner to bring back the on hand level back to zero. This document summarizes the feature
and explains how Visual Planner computes the quantity and the requirement date for planning
purpose.

Back flushing refers to the way component issues are accounted while the assembly work order
progresses on the shop floor. Instead of explicitly issuing and tracking the component to a work
order, workers pull the components from the stock as and when they are needed during
assembly operation without an explicit transaction. This helps to reduce the amount of paper
work although the real-time availability of on hand information in the warehouse is out of sync
with the actual on hand available in the stock.

Back flushing can be explained in the context of a simple example.

Suppose there is a work order M934970 for original quantity of 10 that has been released to
manufacturing (as noted in WOHEAD table). This work order requires a component called
KCC200 at operation 10 along the work order routing for a quantity of 50 however no quantity
has been issued or reported issued( as seen in WOALLOC table). Based upon the required
guantity wrt to the assembly work order quantity we can conclude that 5 pieces of component
KCC200 is required for each of parent assembly KCC600. Customer does not explicitly issue the
components to the work order but back flushes the component once the assembly is received
to stock. Following figures show how the data will look like if you open the Visual Planner
database tables:

Work Order header (WOHEAD)

WORK_ORDER_ID PART_ID ORIGINAL_QUANTITY QUANTITY_FINISHED QUANTITY_SCRAPPED
M934970 KCC600 10 0 1

Work Order Allocations (WOALLOC)

WORK_ORDER_ID | CHILD_PART_ID | QUANTITY_ REQUIRED QUANTITY_ISSUED | JOB_STEP_ID

M934970 KCC200
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Now, this assembly work order job has been reported complete on operation 10 for quantity 1
but that got scrapped (as noted in WOROUTE table). There is also a quantity of 1 being under
process on operation 10 (as noted in JIP table). Following two diagrams show that information:

Work Order Routing (WOROUTE)

WORK_ORDER_ID JOB_STEP_ID WORKCENTER_ID QUANTITY_GOOD QUANTITY_BAD
M934970 20 APS03 0

M934970 10 APSO6 0 1

Jobs In Progress (JIP)

WORK_ORDER_ID PART_ID JOB_STEP_ID WORKCENTER_ID WORKCENTER_UNIT QTY_IN_PROCESS
M934970 KCC600 10 APS06 1 1

Based upon the above data, we can conclude that there is a total 2 pieces of assembly order are
either in progress or completed at operation 10. If the workers did pull in stock as the operation
is worked on, they would have pulled a total 10 pieces of component KCC200 (5 quantity per
parent * 2) from on hand.

Now, Visual Planner checks the stock on hand quantity as stated in the warehouse stock
register. If there are more than 10 quantities is shown available, then Visual Planner marks
them off and does not allow any other order to consume those on hand. Visual Planner’s work is
done at this point with reference to back flushing.

However, assume this item does not have a on hand quantity of 10 but there is just 5 quantity is
available. Visual Planner first marks off 5 as already consumed. For the remaining 5 quantity,
Visual Planner needs to catch up to bring back the on hand quantity back to zero in the
warehouse. Visual Planner creates a new requirement called NEGATIVE_QOH for a quantity of 5
to meet this demand. Since, the quantity is already consumed already, we need to catch up due
date of the requirement therefore Visual Planner attaches a due date of the current date of
system.

If suppose, there is no hand on hand in the warehouse. Then, Visual Planner assumes the on
hand quantity is fallen down to -10 and therefore automatically creates a requirement
‘NEGATIVE_QOH” for quantity of 10 for Visual Planner to schedule during planning.
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=l 5upply Demand Window [KCC200] [COMPONENT - RAW MATERIAL] - 0, 0,0

In Visual Planner session, if you open Supply-Demand Window for item KCC200, you will see a
demand requirement called NEGATIVE_QOH for quantity 10 as shown below:

[Slsupply Demand Window [KCC200] [COMPONENT -RAWMATERIALI-0.0.0___________________________________________________________==x]|

Supply ID Qty Start Date

Pind

Pind

Pind

Pind

‘\.D |Oﬂ |"‘ |G’\ |U| ‘“ |W ‘N

Pind

-
=]

-

Pind

-
15}

-
w

Pind

Due Date

Load {hrs)

Load %

Sugg Due Date

Proj On Hand

Reqd Date

Reqd Qty | Peg To

40.000

10,000

10,000

10.000

10.000

10.000

25.000

10027/14
10027/14
10631/14
1031/14
1031/14
1031/14

11403/14

11/10j14
11110i14
11/14i14
11f14j14
11f14j14
11f14j14

11117i14

0.000

0,000

0,000

0.000

0.000

0.000

0.000

0.00

11410/14
11410/14
11414/14
11414/14
11414/14
11414/14

11417/14

40.000
0.000
10,000
0.000
10,000
0.0o0
10.000
0.0o0
10.000
0,000
10.000
0,000
25.000

02j28{14
11403j14
11414i14
11414i14
11414i14

11/14)14

40,000 M3I34970

10,000 MEGATIVE_GOH_1

10,000 M341610

10,000 M341610

10,000 M341610

10,000 M341610

Back flushing when multiple work orders are in Progress

As shown in Line 4 in the above diagram, Visual Planner has planned for a NEGATIVE_QOH
requirement for a quantity of 10.

Visual Planner keeps a cumulative total of all back flushing done for all components along the

work orders. At the end of reading all the work order information, Visual Planner creates one
single NEGATIVE_QOH requirement for the component for a quantity that will bring back stock
guantity on hand in warehouse back to zero. Suppose, there are three work orders which
consumed the on hand of KCC200 for a cumulative quantity of 30 and stock quantity shown in
the warehouse is 10, then a single NATIVE_QOH requirement for 20 is created for planning in

Visual Planner.

Checking Back flushing details

If you go to Reports menu, choose Back Flushing Summary as shown below:
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Sl visual Planner for System i - (KAC) - (11/03/2014 - 02/10/2015)

File Display | Reports DB Maint ‘Windows - Help

=& E z:;:‘::i\:i\te Schedule Pass Lock IE}E“‘""' —I—I—Iﬂ 2l @I —I—I% E —I—I—I—I—Il 2 |

= (S e Schedde Fess

SEQNUM JOBSTEP ISSUEDQTY

[ roooofweczm I sooo0| 0000100

Email this attachment.

RERFERE LY

. Bl

Following diagram shows the important columns to take note of:

WORKORDER | ITEM | JOBSTEP REQQTY ISSUEDQTY CONSUMEDQTY QOH_DEDUCT m

M934970 KCC200 10

REQQTY: How much of Quantity component is required for the entire assembly order that helps
to determine the qty per parent. (REQQTY/ASSEMBLY WOQTY)

ISSUEDQTY: How much of Quantity component is allocated with an explicit transaction.
(REQQTY-ISSUEDQTY) is the shortage.

CONSUMEDAQTY: Quantity that the Visual Planner computed as consumed as per the numbers
downloaded the assembly header and routing.

QOH_DEDUCT: If there was any on hand stock quantity available in the warehouse, how much

of that quantity was marked off for this work order. (QTY_ON_HAND-(back flushed to other
work orders before this)) >0

NEG_QOH: Any negative quantity that needs to be accounted during Visual Planner Planning.
(QTY_ON_HAND-(back flushed to other work orders before this)) <0
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3

Chapter 3 Preparing for Planning

This chapter discusses the tasks to set up VPi, the steps to load a project, and the menus to navigate to
the charts and tables.

The chapter consists of the following topics:

Topic Page

Chapter 3 Preparing for Planning.........coooi i 3-1
Download data 3-3
Setting the download mode 3-3
Downloading data 3-3
Setting up VPi 3-4
Setting parameters for VVPi planning 3-4
Establishing calendars 3-4
Creating the default calendar ..............coooiii i 3-5
Creating @ NEW CalENUAN...........coiiieiiiee e 3-7
Creating a duplicate Calendar............c.ecoiiiieiiie e 3-8
Associating workcenters With a calendar.............cocvveiiieiiec e 3-8
ReSetting Start AN €N Qat S 3-9
Specifying machine availability 3-9
3-9

Using the menus 3-9
File menu 3-10
System ConfIGUIALION .........ocuviiiiiee e 3-10
0= Lo o (0] 1= o) A PSS SPPRRO 3-10
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Set TeleSCOPIC BUCKELS ........eeiiiieiie it 3-10
SAVE PIAN.....oeii s 3-10
CANCEIPIAN .o 3-10
EXPOIT DALA ... 3-10
o 1| O PR P RO PR UPPOPRROPRUPPPPN 3-11
PEINT PIEVIBW ...ttt ettt ettt 3-11
PIINT SBIUP ..ttt ettt ettt et e e 3-11
EXIt APPIICALION ...ttt 3-11
Display menu 3-11
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Download data

When you download data, forecast and customer sales order demand data and
planning data is extracted from your ERP product's database and transferred to
the engine. The following options apply to download and should be reviewed
and set before running download.

Setting the download mode

You can download in either test or planning mode. You can save the plan and
upload data to the System i only in planning mode.

To select the mode:

1 Navigate to the INFORVPi folder and open the ISeriesIntegration.ini file.

2 Change the mode using these parameters:

Parameter Definition

DownloadMode 0 (Default) Test. 1
Plan.

AVPActive 0 (Default) VPi is not active. The
warehouse is planned by MRP.
1 VPi is activated in this
warehouse.

Downloading data

When you are satisfied that the data in your ERP product is complete, download
the data to VPi. Initiate and run the download process in VPi.

To download planning data to VPi, you have these options:

ﬁ Double click the Visual Planner Download icon on your desktop.
2

Select Start > Programs > Visual Planner for System i > Visual Planner Download
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Setting up VPi

Before you can plan, you must define your planning parameters, such as the
default horizon days and the date format to use in VPi. You must also create a
default calendar. You have the option of adding calendars and associating
workcenters with the calendars. See the integration guide for your ERP product
for additional setup steps.

Setting parameters for VPi planning

To set parameters for VPi planning:

1 Start VPi. Select File > System Configuration.

2 Specify this information:

Default Horizon in Days

Type in the number of days in the horizon for load to capacity (L:C) planning. The
scheduling horizon starts with the MRP current date, and loads and capacities
are calculated over this horizon. The supply plan covers all demand, regardless of
this horizon. Default is 30 days.

Date Format
Select the date format to use in VPi.
Include Setup in L:C

Check this box to adjust the load to capacity chart for setup. If you select this
option, setup is included for every supply order run on the facility.

Establishing calendars

Unlike MRP which uses fixed lead time on items, VPi uses actual operation processing times on facilities/
workcenter to compute item lead times. VPi considers the actual capacity or working hours of the
facilities operation batch sizes, operation overlaps along the item routing in calculating overall item lead-
time. Therefore specifying an accurate facility-working calendar is critical to a good manufacturing plan.
If no calendar is specified or if all the facilities work on a common shift then VPi goes by the default

calendar policy. Typically, users create calendars two to three years out. If the default calendar does not
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exist, VPi forces you to create one when you load the visual planner session for the first time. Use the
calendar feature to define separate calendars for each workcenter if required. You must define at least
one default calendar. VPi uses the default calendar to calculate purchase lead times. If you add any
calendars, or make any changes to the default calendar, you must reload the project for the changes to
take effect.

Note: The default VPi calendar has a 24-hour day but the capacity of a
workcenter that uses this calendar can be greater than 24 hours. VPi calculates
the capacity of a workcenter using the 24-hour day and the number of
machines or operators that increase the capacity of the workcenter. The L:C
chart displays the number of machines or operators as "Units." VPi obtains the
number of units from the data downloaded from your ERP.

Creating the default calendar

The default calendar is the calendar under which most of your company works. All work centers are
initially associated with the default calendar.

To create a default calendar:

1. Select DB Maint > Calendar.
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Calendar Dialog E3
Mew Calendar Duplicate Calendar  Associate  Exik
Select Location: Select Calendar: Azzociated Work Centers;
IS - I.-’-'-.S SR j |.-’-'-.S SR j
Restore |
Calendar Start D ate: 01/01 427 | Calendar End D ate: 124314219 |
Drefault |
Diefault Working Hours Per Day: |17.0 bl & wiork OT: I‘U:I 5
ave |
Start OF Week: IMnnda_l,l VI M ax Mon Work OT: IB-EI
Wworking Days Inweek: IE VI bl aw wieekly OT: 30.0 Delete |
4 | >| Month:  Map, 2017
Suh ton Tue Wed Thu Fri Sat
2 3 4 ] G
1700 | 1700 | 1700 | 00:00 | 0000
7 9 10 11 12 13
1700 | 1700 | 1700 | 1700 | 1700 | 0200 | 0000
Mext Month |
14 15 16 17 18 19 20
1700 | 1700 | 1700 [ 17400 | 1700 | 0200 | 0000 Brey Morth |
21 22 23 24 25 26 27 v e
1700 | 1700 | 1700 | 1700 | 1700 | 0200 | 0000 :
28 29 30 3 . |
1700 | 1700 | 1700 [ 1700

2 Select the location that will use the calendar.

3 Select Default in the Select Calendar field.

4  Click New Calendar.

5 Enter this information in the Create New Dialog:

Calendar ID
Specify an ID or description for the default calendar.

Start Date/End Date
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Specify the period of time that the planning and scheduling process will cover.
Enter the dates in the format that you specified in the System Configuration
dialog.

Click OK.

Specify the Default Working Hours Per Day and the Working Days in Week. Reduce the number of
working hours to account for breaks.

VPi does not use these fields:
Max Work OT
Max Non-work OT
Max Weekly OT

Click Default to populate the default hours per day and the working days in the calendar.

To simulate days off and maintenance on new workcenters, double-click the specific date in the calendar
dialog box and enter the new number of hours of availability on that day. Type in zero if it is a day off.

Click OK.
11 Restoring default settings

To restore your previous default working hours per day:

1 Click Restore.

2 Click Save. You cannot restore after you have changed the default working hours
per day and saved the change.

Creating a new calendar

Use the New Calendar command to create new calendars. The software asks you set the duration for
which the calendar is to be created. Note that when you create a new calendar, you must recreate any
holiday or maintenance schedules you previously created with default calendars.
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Creating a duplicate calendar

Use the Duplicate Calendar command to create another calendar. You can set your default calendar as

your starting point. The hours per day, holiday, and work-week information are carried over from the
default calendar.

Associating workcenters with a calendar

To associate a workcenter with a calendar that you have already created:

1 Click Associate.

Calendar Dialog X

" Mew Calendar Duplicake Calendar  Associake  Exit

Select Location; Select Calendar: Azzociated Wark Centers:
| |MFG1 =] |fassvim ] [a55v1R ]
Restore |
S R E NN Associate Workcenter With Calendar |
I Drefauilt |
Location 1D Ir‘-"”:|31
D efault ‘W orking H
= — Calendar Save |
Shart O Wiesk R T
ASSY1E CaL2 Delet
Whorking Dayz Inbw | [&357TF Cal3 il
ASSYIN . CaLd
ASSYIR Associate DEFALLT
1 | *l CE=100 CvMBAL
DRLCHC Euit FRGE130
CYMBAL MLG11=
| FRG100
FRG105 j
14 15 16 17 18 19 20 — |
1700 | 1700 | 1700 | 1700 | 1700 | 00:00 | O0:00 Prey Month |
71 22 23 24 o5 o6 27 v e
1700 | 1700 | 1700 | 1700 | 1700 | 00:00 | O0:00 _
28 29 30 3 =al |
1700 | 1700 | 1700 | 1700

2 Select one or more work centers to be associated with this calendar. Use the Shift or
Ctrl keys to select multiple work centers.
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3 Select the calendar with which to associate these workcenters.
4 Click Associate.
5 Click Exit.

6 Save the calendar information to permanently save associations.

Resetting start and end dates

Click Calendar Start Date or Calendar End Date to reset those dates on a
calendar. Click Save.

Specifying machine availability

Many facilities in your shop floor may have multiple machines. In many situations, some
machines from your facility may be taken offline for maintenance activities. In such cases, Visual
Planner needs to deduct those capacities and only consider the remaining machine capacity
available for planning purpose. You specify this by going to DB Maint menu and choosing
machines. Here you specify the actual number of machines available between start and end
dates specified. In the screen example shown below, facility ‘MLG11X’ has three units but one
machine from the facility will be not available between 05/01 thru 05/10. Therefore, we specify
two machines being available between 05/01 thru 05/10. Outside this period, all the machines
are available for planning.

'E_ Visual Planner for System i - (MFG1) - (05/01/2017 - 06/09/2017) - [MACHINE Table : Total 1 Records]

E File Display Reports DB Maint Windows Help

@|&| =] O[] ezl E] o @]l B @]o]2] 8 +]-|0]0] B =S
‘ WORKCENTER_ID START_DATE END_DATE UNITS LOCATION_ID |
MLG11X | 05/01/2017 0541042017 2 MFG1 |

Using the menus

Use the VPi menus to select the options that you need to set up and use VPi and
to manage the display of charts and tables.
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File menu

The file menu includes several options that you use to maintain a project in VPi.

System Configuration

Load Project

See “Setting up VPi” for more information.

Select Load Project or click the file-folder icon to download MRP data from the
System i. After the initial download you cannot download data again until you
upload a plan to the System i.

Set Telescopic Buckets

Save Plan

Cancel Plan

Export Data

You can change the bucket size and the number of buckets. This option is
available on the toolbar and on the option list that is displayed when you right
click on a chart or data.

Save the plan and upload the data to the System i. If your ERP product locks jobs,
the upload releases the System i jobs that were locked when you ran download.

Cancel the plan without saving it. If your ERP product locks jobs, Cancel Plan
releases the System i jobs that were locked when you ran download. Use this
option if you do not want to save the plan until you make changes to data on the
System i.

To export a table to a text file:

Display the table. If the information is in chart format, select Display > Table and
then display the table.

2 Select File > Export Data...
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3
Print
1
2
3
4
Print Preview
Print Setup
Exit Application

Display menu

When prompted, specify the directory in which to save the text file and a file
name.

To print a table:

Select File > Print to print the active window.

For a table with many columns, use the printer properties dialog to specify
landscape view.

Select the columns and rows to export.

Click OK.

This menu item is available if the Time-Phased Order Chart is active. From this
preview window, you can zoom in or out of the Time-Phased Order Chart and
select to print the chart.

This menu item is available if the Time-Phased Order Chart is active. Use the
dialog to specify the bucket range of the Time-Phased Order Chart that you want
to print.

Exit the planning engine without either saving the plan or releasing the locked
System i jobs. See the chapter “Uploading data to the System i” for more
information.

Using the menus

Use the Display menu to manage the display of some data and to navigate to the
various tables and charts available in VPi.
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Toolbar. Select the Standard toolbar. The toolbar includes icons that
represent the actions that you can take in VPi. The icons are active for the

actions that you can perform in the active window.
Bar. Display the succeeding windows as bar charts.

Table. Display the succeeding windows as tables.

Use the options below to display tables, charts, and windows that you use to

maintain plans in VPi. See the chapter "Using VPi."

Visual Planner User Guide

Item List Filter
Create Firm Planned Order

Past Due Purchase Orders

[tem List

L:C for Plant

Items Load

Timephased Orders

Orders Window

Which Orders to Push Out

Push All Orders Out

Which Customer Orders to Push Out
List of Customer Orders to Push Out
Waterfall—Pegged Order
Waterfall—Feeding Supplies

Supply Demand Summary for Part

Timephased Labor Load Summary

Timephased Workcenter Load Summary

Forecast Consumption —Summary
Forecast Consumption - Detailed

View Log
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Chapter 4 Using the VPi Engine 4

Use the VPi tables and charts to maintain your plan. Load a project and then use the menus, tool
actions list to access the tables and chart.

The chapter consists of the following topics:

Topic

Loading the project
L:C Chart
Actions
Drill Downs
Items Load
Actions
Drill Downs
Orders Window
Actions
Drill Downs
Time Phased L:C
Actions
Maintaining stability of the time phased chart
Drill downs
Supply Demand for Item
Actions
Drill downs
WaALErTAll CRArtS ......coovviiiiecee e

Orderwise Waterfall
Display supply-demand summary

Time-phased load summaries

bar, and
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Customer order options 4-21
Item List Filter 4-25
Fields 4-26
Actions 4-29
EXAMPIES .. s 4-29
Set Default ReSched Code 4-31
View Log 4-31
Undo 4-31
Using the toolbar 4-32
Loading the project
After you complete the steps to set up VPi, you are ready to load the project. To load the
project, select Load Project or click the file-folder icon to download MRP data from the
System i.
VPi reads the data, loads it into memory, and processes this data:
Uses the BOM and routing information to build the product structure
Processes the work order files
Performs forecast consumption.
After the data is loaded into memory, you can access charts and tables either from the
Display menu or by right-clicking your mouse in the window. Actions are available by
right-clicking in the window. Most actions are available only for supply orders, and you
can select one or more orders by selecting any column in that order’s row. Only the
actions that can be taken for that order are shown. Other actions are inactive.
L:C Chart

Use this chart to see the load to capacity percentages for the workcenters in the plant.
The chart is sorted in descending order of the load to capacity. The chart shows you
workcenters that are potentially overloaded and balances that you must resolve.
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Sl ¥isual Planner for System i- (MFG1) - (05/01/2017 - 06,09/2017) - [LiC For Plant]
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The bar chart uses these color codes:

Red if the load is greater than the capacity over the planning horizon

Yellow if capacity exceeds load for the entire horizon but the cumulative
load exceeds the cumulative capacity during a time period within the

horizon

Blue if one period over the horizon is overloaded but there is no

cumulative period overloaded anywhere within the horizon

Green if the load never exceeds capacity throughout the horizon.

The thick red vertical line depicts 100% threshold load line. Any facility that has the bar length
crossing over the red line indicates overload and a potential constraint.

Actions

Note: LC Chart shows up when you load Project into memory. If you close the
LC Chart window, you can again open it by going to Display menu and click on
L:C for Plant. You can switch between by table format and bar graph format by

selecting bar and Table command options in the Display menu.

Select a facility (work center) and right-click to see the available actions.
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Set Telescopic buckets. You can specify the bucket size and the number of buckets using

a dialog box.

Drill Downs

Select a facility (work center) and right-click to see the available tables and charts:

Items Load
Orders Window

Time Phased L:C

Items Load
Use this chart to see the load in hours contributed by each item to the overall load of the
workcenter in a bucket. You can also see the quantity each item is short. The Percent
column shows the percentage of the total load contributed by each item.

S Visual Planner for System i - (MFG1) - (05/01/2017 - 06/09/2017) - [Items Load on Workcenter ASGY1F]
£ Fle Diplay Reports DBMaink Windons - Help _[8]x|
=gl 5| plrl=l=lwlsl) @l 5 Bl Bl-100] g5 25

ltem load on: ASSYTF

Load Hours
ol 1m0 120

2 @ 60

2 curouss
3 cwrouzs
4 cwpLcD
5 curocrs w00
o cwpLers 700

When you reach this window from a specific bucket rather than an entire horizon, you

see the information for that specific bucket.

Actions

Select an item and right-click to see the available actions:
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Drill Downs

Identify as Control Item - If your ERP product supports control items as used in VPi, right-
click to identify the item as a control item.

Sort by item or load

Select an item and right-click to see the available tables and charts:

Orders Window. Display orders sorted by workcenter and part.

Supply Demand for Item. Display orders sorted by Part ID.

Orders Window

The information displayed on the Orders window depends upon which chart or table you

used to access the Orders window. Use the Orders window to see information

dependent upon from where you reached this window. You can get to this window from

these charts and tables:

L: C for plant

Time phased L: C

Items Load

Specific Item List Filter

Order Type|Ord ID |lem ltem Type |item Description| Oty Start Date|Due Date |Sugg Date |Source  |Source Kem|Analyst/Buyer|CustWend |Setup Family|Load Setup Time|% Lateness|

el M1 |CMPOCIO | Cortral Mfg | COMPRESSOR-10 90.00 | 040272017 | 05012017 | 05012017 |ORDOM4  |CMPOCID AN3 18.00 0.00{ 1250 0.00
2 |Rel MO034  |CWPOCI0 | Confrol hifg COMPRESSOR-10 | 90.00 |04i27/2017 \05/02/2017 (0503/2017 |ORDIMS  |CMPOC1D |AN3 16.00 000| 1250 0.00
3 |Rel M55 |CMPOCIO | Cortral Mfg | COMPRESSOR-10 90.00 | 0501 2017 | 05032017 | 05032017 |ORDOMS  |CMPOCID AN3 18.00 0.00{ 1250 0.00
4 |Pind CMPOCI0 | Cortrol Mfg | COMPRESSOR-10 90.00 | 050972017 | 050172017 |05M1/2017 |ORDOME  |CMPOCID AN3 18.00 0.00{ 1250 0.00
5 |Pind CMPOCI0 | Cortrol Mfg |COMPRESSOR-10 | 90.00 (054702017 051972017 |0519/2017 [ORDOT7  |CMPOC10 AN 18.00 000| 1250 0.00
6 |Pind CMPOCI0 | Cortrol Mfg | COMPRESSOR-10 90.00 |05H 72017 |05M 92017 |05M 82017 [ORDOME  |CMPOCID AN3 18.00 0.00{ 1250 0.00
T |Pind CMPOCI0 | Cortrol Mfg | COMPRESSOR-10 90.00 | 0502402017 | 050262017 |0526/2017 |ORDOME  |CMPOCID AN3 18.00 0.00{ 1250 0.00
8 |Pind CMPOCTO | Control hifg | COMPRESSOR-10 | 80.00 [D6AI7F2017 [06/03/2017 | 06032017 [ORDOXM  |CMPOC10 | AN3 18.00 003| 1250 0.00

The orders window displays this information:

Order Type

VPi uses these order types:

Rel — Released manufacturing order

PInd — Planned order

Firm — Firm planned order

Pur — Purchase order

Visual Planner User Guide
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Sales orders
Order ID

The work order ID for released manufacturing orders; the purchase order ID for released

purchase orders; the order ID for independent orders.

Item ID

Item Type

VPi uses these item types:

Date

Control - Mfg
Non-Control mfg
Control - Purchase

Non-control purchase Due

The current due date of the order.

Visual Planner User Gu

Suggested Date

The requirement date for supply orders and suggested due date, assuming firm
supply for independent demand. If the suggested date is the maximum date,
blue appears for supply order. The default (white) appears for demand orders. If
the suggested date is less than the order due date, red appears for supply orders
and yellow appears for demand orders. If the suggested date is greater than the
order due date, yellow appears for supply orders and red appears for demand
orders. Note that the red and yellow conditions are reversed for supply and
demand orders.

Source

The parent work order ID that causes the greatest exception for this supply, or, if
this supply feeds independent demand, the Demand order ID.

Source Item

The item ID associated with supply in the Source column. If you are seeing
supply at a lower level, this field contains the Part ID of the parent item that
drives this supply. For independent orders, the same value as the item ID field.
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Analyst/Buyer ID

The analyst or planner for the part if it is a make part. If it is a purchase part, the
buyer for this part.

Orders Window

Customer/Vendor

If this is an independent customer order, the customer from the order was
received. If this is a purchase order, the vendor who has the purchase order.

Load

Information is displayed only if you reached this display from the load to
capacity chart.

Load %

Information is displayed only if you reached this window from the load to
capacity chart.

Legend

The color coding shows that the row is expedited, deferred, or cancelled.

Actions

Right-click to see the actions.
Outsource — Change the work order from a make route to a purchase route.

Alternate Route — Available only for firm or planned orders that have alternate routes.

Offload — Change the work center for one operation. Available only for released orders
because there are no specific routes for firm or planned orders

Re-Schedule Supply — Available only for control items. The due date of the supply is
rescheduled to the earliest required date of the supply.
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Modify Supply — Modify the due date and process for an existing firm supply. Planned
supplies are firmed up in the process. If you modify a planned or firm supply date, you can
also modify the quantity and the reschedule code. If you modify a released supply, you can
only modify the due date and re-schedule code.

Level Load — Change the due date of the supply within the same work center.

Re-Schedule Requirement — Available from all released and firm planned supplies for control
items. You can reschedule the due date of the parent item supplies and their parents.
Forward scheduling is based on minimum queue times on facilities and not on typical queue
times.

Re-Schedule All Requirements — Reset all requirement dates based on the due date

of all the supplies in this window.

Identify Control items — You can identify additional control items during the planning
session.

Drill Downs

Select an order and right-click to see the available tables and charts:

Supply Demand for Item: For the item associated with the supply or demand order.
Waterfall — Pegged Orders

Waterfall — Feeding Supplies

Time Phased L:C

Use the time phased orders window to see the bucket L: C in user-defined buckets.
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Y visual Planner for Systemi - (MFG1) - {05/01/2017 - 06/09/2017) - [Timephased Window[ASSY1F]]

£ Fle Digly Reports DBMat Windows -Help 81X
18] 5] | |lal-{adlo) ) ) ek el -0l B B
e Phased(h) ol

106

LU EE i “ R Fonin | 3
i E L 2 L .

: LLoad range: 75-90 Hrs| 8 : : '
o o u e . o L

i TR T T B e I e e e e e e N
14 |

Ttem:CMPOCTS Order:MOZ0 [ Q90,000 |startosfoeft7 | Due date:05/09/17 Loac: 16,000000 Hrs

The chart uses these colors to identify the types of order:
Green — Planned Orders
Blue — Planned Orders available for Alternate Route option
Pink — Firm Planned Orders

Yellow — Released Orders

The chart uses these color lines to indicate capacity and load:

Blue indicates the capacity in the bucket
Red is the cumulative load line

Yellow is the cumulative capacity line

If the cumulative load exceeds the cumulative capacity, the bar for the workcenter is
colored red in the L:C chart.

To adjust the load, you can drag-and-drop an order from one bucket another. Select
Display > Undo to reverse changes.
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You can determine the L: C ratio and imbalances that need to be addressed from this screen. You
can preview a printout of the time-phased orders chart for extended horizons.

To print the time-phased orders chart for an extended horizon:

1 Right-click and select Print Setup.

2 Specify the bucket print range. Click OK.

3 Use your printer properties dialog to specify Landscape view.
4 Click OK to print the chart.

The due date of the supplies determine the bucket in which the load is generated.

The maximum lot size has an impact on time-phased load calculations. For example, you have a
demand of 190 pieces. The maximum lot size is 25. SCM splits the demand into 8 small demands
with same due date which generate 8 almost identical tasks on the work center. These demands
have the same schedule start and end dates (except the final one) which causes an overload.

Actions

Select an order and right-click to see the available actions:
Alternate Route Order — Available only for firm or planned orders that have alternate
routes. Indicated by blue planning blocks on the Time Phased window.

Offload — Change the work center for one operation. Available only for released orders
since there are no specific routes for firm or planned orders

Outsource — Change the work order from a make route to a purchase route

Re-Schedule Supply — Available only for control items. The due date of the supply is
rescheduled to the earliest required date of the supply.

Modify Supply — Modify the due date and process for an existing firm supply. Planned
supplies are firmed up in the process. If you modify a planned or firm supplies date, you
can also modify the quantity and the re-schedule code. If you modify a released supply,
you can only modify the due date and re-schedule code.

Level Load — Change the due date of the supply within same work center.

Visual Planner User Guide Page 4-10



4-11

Drill downs

Using the VPi Engine

Re-Schedule Requirement — Available from all released and firm planned supplies for
control items. You can reschedule the due date of the parent item supplies and their
parents. Forward scheduling is based on minimum queue times on facilities and not on
typical queue times.

Identify Control items — You can identify additional control items during the planning
session. Your decisions are saved back to your ERP and are downloaded the next time
that you load a project.

Modify Operation Delay Time — Add buffer time between two jobsteps to allow the
Order Due Date and downstream jobsteps to keep the current completion date while
rescheduling a critical upstream job step to avoid a bottleneck. This action is only active
for released manufacturing orders.

Maintaining stability of the time phased chart

VPi maintains the stability of time phase L: C when you take actions in this window.

If load is moved forward from one bucket to another then the item has to be declared
a control item. In addition all planned supplies due earlier than this supply are firmed
up. If this is not done then the newly rescheduled supply is expedited in and additional
planned supplies take its place.

If the item is a control item and the load is moved backward (earlier) from one bucket
to another, the supply order and other planned supplies for that item between the
moved-to bucket and the moved-from bucket are set to reschedule code 5. The
reschedule code for firm and released supply is not modified.

If the item is not a control item, the supplies within the two bucket ranges are firmed
up and are set to a type 5 supply. This applies to all planned, firm, or released supply
orders.

To avoid seeing all exception conditions on the engine, the difference between the planned
dates and the moved to date is stored as an offset for the work order. The user has the option to
hide exceptions within offset.

Select an order and right-click to see the available tables and charts:

Waterfall — For a specific supply order.

Supply Demand for Item — For the item associated with the supply or demand order.
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Orders Window: [f the time-phased L:C appears as a table, you can see the orders for a specific
bucket.

Supply Demand for Item

Use this window to see the pegging information between supply orders and

demand orders for an item. The window shows one level pegging between an

item and its immediate parents.
avisual Planner for System i - {MFG1) - (05/01/2017 - 06,/09,2017) - [Supply Demand Window|[CMPOC10][COMPRESSOR-10] - Min[90.00], Mult[0.00], Agg[0] ]

LIT§

;Eile Display Reports DB Maint  Windows - Help

= =3 e A S e e e e e [ e = T B = B v el = =

Supply ID| GOty |Start Date|Orig Due Date|Due Date|Load| % |Sugg Due Date|Proj On Hand|Reqd Date|Reqd Oty| Peg To Item |iHem Description|Ana/Cust|Due Date|Sugg Date
TE] 90.00 (042717 |0SmH7 03M1M7 (000 (000 |0SMAT 20.00
2 10.000 050117 80000 |ORDO14_134 |CMPOC10|COMPRESSOR-10 | GM 050117 050117
3 MO 90.00 042717 050247 050217 |0.00 000 |050347 100,00
4 [M0oas 90.00 (050147 030347 030317 |0.00 (000 |030347 190,00
5 £0.000 050317 [130,000 |ORDO15_135 | CMPOC10|COMPRESSOR-10 [FORD 050317 050317
6 |Pind 90.00 (0509417 |05H1H7 05M1M7 |0.00 (000 |0SM1A7 150,00
7 85.000 054117 |B5.000  |ORDO1G_138 |CMPOC10|COMPRESSORA0 |GM 05117 050917
8 |Pind 90.00 (05A7HT |0SHANT 03MIM7 (000 (000 |0SMINT 17500
9 15.000 0541917 [160.000 |ORDO17_137 |CMPOC10|COMPRESSOR-10 [FORD 052017 |052507
10 |Pind 90.00 (0547HT |05 9H7 05M9M7 |0.00 (000 |05M947 105.00
11 50.000 03M9M7  [55.000  |ORDO16_136 CMPOC10|COMPRESSOR-D |GM 032917 032547
12 |Pind 90.00 (05724117 |05/2607 052617 |0.00 (000 |052647 140,00
13 85.000 05/26M7 |55000  |ORDO19_139 |CMPOC10|COMPRESSOR-10 | GM 0502617 06081 T
14 35.000 0BNBAMT  |50000  |ORDO20_151 |CMPOC10|COMPRESSCRA0 [FORD OBNEAT |0608NT
15 |Pind 90.00 (06077 |06DMT 06MIM7 |0.00 (000 |060NT 12500
16 £5.000 06N9M7  [B0000  |ORDO21_152 |CMPOC10|COMPRESSOR-10 |GM O6M1M7 |0BH1NT

The window displays this information:
Supply ID
The window displays the supply type:

The work order ID for released orders
The purchase order ID if the route is a purchase route
Firm if it is firm planned order

PInd if it is a planned order.
Qty
The quantity of the supply order that is remaining or pending.

Start Date
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The current start date associated with the workorder. For PO orders this field is
set equal to end date.

Due Date

The current due date of the supply. If you re-scheduled the order, this date is set
equal to the suggested due date. For PO routes, the due date is the dock date.

Load

Appears only when you reach this window from the load to capacity chart. The
load placed by this supply in the bucket being drilled down.

Load %
The percentage of load in the bucket generated by this supply.
Suggested Due Date

The recommended due date of the supply to meet shortages in supply. Also,
excess supply

Projected On Hand

The supply on hand + quantity on release or firm supply up to bucket date. The
required quantity up to bucket date. Supply availability is calculated based on
the due date, not the suggested due date.

Required Date

The due date of the requirement.

Required Quantity

The quantity pegged to a specific requirement.
Peg To

The order ID of the independent demand if this item has an independent
demand. If this is a customer order, a combination of the Order ID field and the
Line number field in the Sales table. If the item is lower in the BOM and this
supply feeds into a firm order or released order of a higher-level item, that
information appears here. If the supply feeds into a planned order, the word
Planned appears here.
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Actions

Item

The item driving the requirement.
Item Description

The description of the item.

Supply Demand for Item

Analyst/Customer ID

The customer ID for the sales order or forecast order, if available. Alternatively,
the Planner ID of the item this supply feeds into.

Due Date

The current due date of the independent order if the supply feeds into an
independent order. Or, the start date of the planned, firm, or released work
order this supply feeds into.

Suggested Due Date

The recommended due date of the independent order or supply this order feeds
into based on shortages for this item. An earlier due date is not suggested if the
supply is available earlier than the required date; the suggested due date is set
equal to the due date.

Select an order and right-click to see the available actions:
Alternate Route Order — Available only for firm or planned orders that have
alternate routes.
Offload — Change the work center for one operation. Available only for
released orders because firm or planned orders do not have specific
routes.
Outsource — Change the work order from a make route to a purchase
route.

Re-Schedule Supply — Change the due date to a suggested to due date for
this supply.
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Modify Supply — Modify the due date and process for an existing firm
supply. Planned supplies are firmed up in the process.

Level Load — Change the due date of the supply within same work center.

Re-Schedule Requirement — Reset requirement dates based on the due
date of supply.

Re-Schedule All Requirements — Reset all requirement dates based on due
date of all the supplies in this window.

Drill downs
Select a workcenter and right-click to see the available tables and charts:

Waterfall — Pegged Orders

Waterfall — Feeding Supplies

Waterfall Charts

Pegged Orders and Feeding Supplies waterfall charts are available.

a) The Pegged Orders chart shows the level-by-level pegging between a supply
order and its parent orders all the way to the independent demand.

QWaterI‘a Pegged Orders...

B Order ID=0RD0SA, Item CMPLC?S Level 1, Oru:ler Qty 3? EID Skart Date—Dﬁ,l'Ddr,fl? Due Date Dﬁ,l'lilﬂ'l?
: B Order ID=0RD0S7, Ikem=CMPLCTS, Level=1, Order Qty=41,00,5tart Date=06/10)17,0ue Date=06/10/17
------ El Order ID=0RD0SE, Ikem=CMPLCTS, Level=1, Order Qty=67,00,5tart Date=061217,0ue Date=06/12/17

b) Feeding Supplies shows the component shortages for a specific supply and
the supplies available to satisfy them. On doing right-click in this screen, we
have 4 menu options available as listed below:

e "Show Everything" displays the entire production plan involved in
building this item
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aWaterfall - Feeding Supplies...

=

Order ID=PLANNED, ltem=CMPOC10, Level=1,Pegged Qty=90,00,Order Qty=90,00,Start Date=05/0917,Due Dake=05{11/17

-4 Jab Step=3.00,0n wjc=A35Y1F,Qky=90.00, Start Date=05{11{17

1 Job Step=2.00,0n wjc=TESTIF,Qty=30.00, Start Date=05/03/17
B- &, Ttem=BAGMC10,Level=2, Pegged QOH=0.00,Gross Qry=180.00,Gty Shart=180.00
EI W Crder ID=MO1, Ikem=BAGMC10,Level=2,Pegged Gty=90.00,0rder GQky=90,00,5tart Dake=12/29/99,Due Date=12/30/99
bl Joh Step=1,00,0n wic=ASSY 1B, Qhy=00,00,5tart Date=12(73/99
Elﬁ Order ID=PLANMNED, Item=BAGMC10, Level=2,Pegged Qty=50.00,Order Qby=590.00, Start Date=05/08/17,Due Date=05/08/17
M Job Step=1.00,0n wc=ASSY1B,Qty=90.00, Start Date=05{08/17
an Tkem=BCSTNGS, Level=3,Pegged QOH=81.00,Gross Qty=20,00,0ty Short=9.00
EI@ Order ID=MO&, Item=BC3TNGS, Level=3, Pegged Qty=%.00,0rder Qty=218.00,5tart Date=12/29/99,0ue Date=12/30/99
M Job Step=5,00,0n w/c=GROTEL,WIP Qty=34,00,0ty=134.00, Start Date=12(73/3
] Job Step=4.00,0n wic=TBOREL,WIP Qty=50,00,Qty=134,00,5tart Date=12/29/99,3etup Time =0,50(Hrs)
¥ Job Step=3.00,0n wic=DRLINC, Qty=134.00,5tart Date=12/23/93,5etup Time =0,17{Hrs)
H w1 Job Step=1.00,0n wjc=LTHZMC, WIP Qty=53,00,Cty=51,00,5tart Date=12/29/99, Setup Time =0,50(Hrs)
EI& Ttem=EIN3TO1 Level=3,Pegged QOH=0.00,Gross Qty=90.00,Qty Short=90.00
EI@ Crder ID=MO7, Ikem=EINST01 Level=3,Pegged Qty=25.00, Order Qby=25,00,Start Dake=12{29/99,Due Date=12/30/99
----- M Tob Step=1,00,0n w/c=AS3Y1E, WIP Qby=25.00
E Order ID=PLANMED, Item=BINSTO1, Level=3,Pegged Qty=05,00,0rder Qty=05,00,Start Date=05/04/17,Due Date=05/04/17
=+ Job Step=1.00,0n wje=AS5Y1B, Qty=65.00, Start Date=05/04/17
EI @, Tkem=JBRGA-1,Level=4,Pegged QOH=27,00,Gross Qty=65,00,Gty Short=38.00
L@ Order ID= PO03, lkem=IBRGA-1,Level=4,Pegged Qby=38.00,Order Qby=200,00,5kart Date=11/25(19,Due Date=05/03/17

e “Show Job-Steps” works in sync with “Show Everything” menu option
and is used to hide the job-step nodes form the display for user’s quick
referencing of part nodes only. By default, this menu option will be
checked if Show Everything is checked. If user clicks on “Show Job-
Steps”, then the menu option will get UNCHECKED and all job-step
nodes will be hidden in display as shown below:

Sjwaterfall - Feeding Supplies...

Order ID=PLAMMED, Item=CMPOC10,Level=1,Pegged Qty=90.00, Order Qky=90.00,Start Dake=05/09/17,0ue Date=05[11/17

EI& Item=BAGMC10,Level=2,Pegged QOH=0.00,Gross Qty=180,00,Qty Short=180.00

Ordet ID=MO1,Item=E6AGMC10,Level=Z, Pegged Qty=20.00, Order Qby=90,00,5tart Date=12/29/99,Due Date=12/30/92
Ordet ID=PLANMED, [tem=BAGMC10,Level=2, Pegged Qty=30,00,Order Qky=90,00, 5tart Date=05/05/17,Due Date=05j05/17
Q@ Ikem=BC3TNGS, Level=3,Pegged QOH=E1.00,Gross Qty=90,00,Qty Short=9.00
2 W Order ID=MO6, Ikem=BCSTNGS, Level=3,Pegged Qty=9.00,0rder Qby=218.00,5tart Date=12(23/99,0ue Date=12130/93
E& Ikem=BINSTO1, Level=3,Pegged QOH=0.00, Gross Qky=90.00, Jky Short=90.00
- Order ID=MO7, Ikem=EINSTO1 Level=3,Pegged Qty=25.00,Order Qby=25.00,5tark Date=12/29/99, Due Date=1230/99
=T Order ID=PLAMNED, Itern=BINSTO1, Level=3, Pegged Qty=65,00, Order Qby=65.00,5tart Date=05/04/17, Due Date—05/04/17
B % Itern=JBRGA-1,Level=4,Pegged QOH=27.00,Grass Qby=55.00,Gty Short=38.00
. 4@ Crder [D=PO03,Item=JBRGA-1,Level=4,Pegged Qty=38.00,Crder Gty=200,00,5tart Date=11/25/19,Due Date=05/03/17
E% Item=TBRG:-1,Level=4,Pegged QOH=30.00,Gross Qty=65.00,0ty Short=35,00
L@ Order ID=PC25, Ikem=TBRGx-1,Level=4,Pegged Qby=35.00, Order Qby=240.00,5tark Date=11/15/19,Due Date=05/058{17
Item=RTADC 10, Level=2,Pegged QOH=0.00,Gross Qby=20,00,Qty Short=90.00
; g Ordet ID=MO64, Ikem=RTAOC10,Level=2,Pegged Qby=z2,00,Order Qty=2,00,5tart Date=12/29/99,Due Date=12/30/99

Ordet ID=PLANMED, [tem=RTAQC10,Level=2,Pegoed Qty=56.00,0rder Qty=55.00,5tart Date=05/03/17,Due Date=05/08/17

Q@ Ikem=IMPAA-1,Level=3,Pegged QOH=0,00,Gross Qty=88.00,Qky Short=88.00

Order ID=MO33, Item=IMPAA-1,Level=3 Pegged Qty=15.00,0rder Qty=15.00,Start Date=12{29/99,Due Date=12/30/99

Order ID=PLANMED, Item=IMPAA-1 Level=3,Pegged Qty=73.00, Order Qky=73.00,Skart Date=05{02(17,0ue Date=05j0z{17

Q@ Itern=ELD1C 10 Level=4,Pegged QOH=0.00, Gross Qby=435.00,0ky Short=435.00
Crder ID=MO11, Item=BLD1C10,Level=4,Pegged Qty=40.00,Order Qty=40,00,5tart Date=12/29/99,Due Date=12/30/99
Crder ID=PLANMED, Itern=BLD1C10,Level=4,Pegged Qty=398.00,0rder Qty=395.00,5kart Date=05/01/17,0ue Date=05{01/17

: i % Itern=BLADERM,Level=5,Pegged QOH=398.00,Grass Qby=398.00,Qty Short=0.00

= % Tterm=IMPHC 10, Level=4,Pegged QOH=0.00,Grass Qhy=73.00, Qty Short=73.00

[ @ Crder ID=PO39_1, Tkem=IMPHC10,Level=4,Pegged Qby=73.00,Order Qby=500,00,5tart Date=04/25{17,Due Date=05/02/17

L Them=TMPrAAC | evel=4 Penned MNH=T3 AN Arocs Abe=73 00 Ok Shork=n 00

=]

e "Show Material Shortages" allows the planner to quickly identify Raw
Material shortages. Please refer to sample screenshot below:
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a\'daterfall - Feeding Supplies...

=¥ Order ID=PLANMED, Item=CMPOC10,Level=1,Pegged Qty=20.00,0rder Qty=20,00,5tark Date=05/09/17,Due Date=05/11/17
E-% Item=TERGX-1,Level=4,Pegged QOH=30,00,Gross Qty=65,00,0ky Shork=35.00

: & Order ID=P025, lkem=TBRGX-1,Level=4,Pegged Qty=35.00,0rder Qty=240,00, Start Date=11/15/19,Due Date=05/03/17
E| % Item=ICSAC10,Level=3,Pegged QOH=29.00,Gross Qty=86.00,Qty Short=57.00

i@ Order ID= PO0E, Ikem=I1CSAC10,Level=3,Pegged Qty=57.00,Order Qby=450,00,Start Date=11/25/19,Due Date=05/15/17

e "Show Shortages" allows the planner to quickly identify All kind of
material shortages (i.e. for both Make Parts and Buy Parts). In other
words, it will display all Part Nodes for which Qty Short > 0.

) Waterfall - Feeding Supplies

Item=BAEMC10,Level=2,Pegged QiOH=0,00, Gross Qty=180,00, kv Short=150,00

% Ttem=BCSTMGS, Level=3, Pegged QOH=51.00,Grass Qty=90,00,0ty Short=3.00

E&, Item=BINSTO1 Level=3,Pegged QOH=0,00,Gross Qbw=20,00,Qty Shork=20,00

@h Item=IJBRGA-1,Level=4,Pegged QOH=27.00,Gross Qby=65.00, Gty Short=35.00

----- ’@h Item=TBREX-1,Level=4,Pegged QOH=30.00,Gross Qky=65.00,Qky Shork=35.00

[=]- % Item=RTADC10,Level=2,Pegged QOH=0,00,Gross Qby=20,00, Oty Short=20,00

E| @@ Item=IMPAA-1 Level=3,Pegged QOH=0,00,Gross Qky=383.00,Qty Short=385.00

- % Item=BLD1C10,Level=4,Pegaed QOH=0,00,Gross Qty=438,00, Jty Short=433.00

----- @h Item=IMPHC 10, Level=4,Pegged QOH=0.00,Gross Qty=73,00,Qty Short=73.00

% Item=SHFT380,Level=3,Peqged QOH=0.00,Gross Qby=55.00, Gty Short=58.00

: % Item=PISTQ-1,Level=3,Pegged QOH=0,00, Gross Qty=83.00,Qky Short=53.00

E@@ Item=IMPAS-1,Level=3,Pegged QOH=0.00,Gross Qky=88,00,Qty Short=38.00

: ’@h Item=IMPHIZ10,Level=4,Peqged QOH=0.00,Gross Qkw=75.00,Qty Short=75.00

Q}h Item=IMPC5AC, Level=4,Pegged QOH=0.00,Gross Qty=75,00, 0ty Short=75,00

[—]-% Item=MNZAAC10, Level=2,Pegged QOH=0.00,Grass Qky=20,00, Oty Short=90.00

----- % Item=0EWAC10,Level=3,Pegged QOH=0,00,Gross Qby=56.00, 0ty Short=86,00

@@ Ttem=0C3AC10,Level=3,Pegged QOH=50,00,Gross Qtw=86,00, Qty Short=36.00

j ’@h Item=INEWOO00,Level=4,Pegged QOH=0.00,Gross Qby=19,00,Qty Shart=19,00
Lo @, Item=MNZFRGAL, Level=4,Pegged QioH=0.00,Gross Ghy=19,00,Qty Short=19,00
----- % Ttem=IC5AC10,Level=3,Pegged QOH=22.00,Gross Qty=86,00, Oty Short=57.00

% Item=DFMAC10,Level=2,Pegged QiOH=0,00, Gross Qty=90,00, Oky Short=20,00

For each item you can see the gross quantity, the quantity on hand, and the
guantity short. You can also see the planned and firm supply available to satisfy

the requirements.
The waterfall charts use these icons:
Interstate symbol with W — Released work order

Interstate symbol with PL — Planned work order
Interstate symbol with F — Firm planned order

Screw — Item level information. Red indicates control items
Truck — Released purchase order

B — Planned purchase order.
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Orderwise Waterfall

If you ship multiple line items in your customer order, it is often desired to see
the progress of the whole order instead of the individual progress. Individual line
themselves may be combined with other line items for single delivery or they
could have separate delivery dates. Thus, for example a customer order consists
of four line items L1, L2, L3 and L4 and if L1 and L2 are shipped together, they
will have same shipping group SG1 and L3 and L4 are shipped in another group
SG2. During planning, Visual Planner ensures that both line items in SG1 will
have one delivery ship date and both line items in SG2 will have same or another
delivery date. Orderwise waterfall helps to visualize all the order line items that
make up the final order in one single view.

There are two kinds of shortage view shown and depending upon your
preference, you can see the Bar view or Table view:

During Visual Planner session, once you have loaded the project you can go to
Display -> Orderwise Waterfall.

This will bring up below dialog:

Show Waterfall for Order

I
S ] I
Order Murmber ; j

Cancel |
Due Date I

[ Fepot Format [ Show katl Shortage

User can select any order from the the available Customer orders in the list. You
can also specify a Due Date (if you have blanket orders). It will display Waterfall
view for the selected order/s:
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a\h‘aterfall Chart...

E||El Order ID=CRD001, Item=BAGMC10,Level=2, Pegged Qby=30,00,0rder Qby=30,00,5tart Date=05{21/17,Due Date=05/21/17

E&, Item=BAGMC10,Level=2,Pegged QOH=0,00,Gross Qky=30,00,Qty Short=30.00

Eﬁ Order ID=PLANMED, Item=BAGMC10, Level=2,Pegged Qty=30,00,0rder Qby=30,00,5tart Date=05/15/17,Due Date=05/19/17
(=14 Job Step=1,00,0n w/c=A55718,Qky=30.00,5tart Date=05/18/17

E| % Tkem=BCSTMNGS, Level=3,Pegged QOH=0.00,Gross Qby=30,00, Oty Short=30,00
H EE Order ID=PLANMED, Item=BCSTNGS, Level=3,Pegged Qty=30.00,Order Qty=30,00,5tart Date=05/17/17,Due Date=05/17[17
4 Job Step=S5,00,0n wc=GRD7SL, Qty=30,00,Start Date=05/17{17
-4 Job Step=4.00,0n w/c=TBORE1,Qky=30,00,Skart Date=05/17/17,5etup Time =0,50{Hrs)
-4 Job Step=3.00,0n w/c=DRLCNC, Qty=30,00,5tark Date=05/17/17,5etup Time =0,17(Hrs)
-4 Job Step=2.00,0n wfc=MLG11¥, Qky=30,00,5tart Date=05{17[17,Setup Time =0,50{Hrs}
=4l Job Step=1.00,0n w/c=LTH2MC, Qty=30,00,5tart Date=05{1717,Setup Time =0,50{Hrs}

E% Ikem=BCSTMNGS-RAW, Level=4,Pegged QOH=0.00,Gross Qby=30,00,Qky Short=30,00
H 4= Order ID=| P0G, lkem=BCSTNGS-RAW, Level=4, Pegged Qbw=30,00,0rder Qty=200,00,5tart Date=11{25/19,Due Date=05/15/17

& Ikem=BINSTO1,Level=3,Pegged QOH=0.00,Gross Qky=30,00,Cty Short=30,00

B- ﬁ Order ID=FLANMED , Item=BINSTO1, Level=3,Pegged Qky=30.00, Order Qty=30.00,5tart Date=05/17/17,0ue Date=05/17/17

- Job Step=1.00,0n w/c=A35Y 1B, Qty=30,00,5tart Date=0517/17

EI Qh, Item=IJBRGA-1,Level=4,Pegged QOH=0.00,Gross Qky=30.00,Qty Short=30.00

: & Order ID=P0O0&, Item=JBRGA-1,Level=4,Pegged Qty=22,00,Order Qby=400.00,Start Date=11/25/19,Due Date=05/11/17
H & Order ID=P019,Item=IBRGA-1,Level=4,Pegged Qty=8.00,Order Qty=200.00,5tart Date=11/25/19,0ue Date=05/30/17
E| % Item=TERGX-1,Level=4,Pegged QOH=0,00,Gross Qky=30.00,Qty Short=30.00
& Order ID=P009,tem=TER G- 1,Level=4,Pegged Qty=30.00,0rder Qty=430.00,3tart Date=11/15/19,0ue Date=05/17/17

“Report Format” option, if checked, will display the same data in tabular view as shown below:

Orderwise All Supplies Waterfall Tabular ¥iew, Page 1 of 1

ORDERWISE WATERFALL

ORDER_ID ORDER_QTY CUSTOMER ID PRODUCT ID LOCATION ID TARGET DATE PROJECTED DATE

ORDO01 30.00 FORD BAGMCLO 0512172017 0512142017
To Make: PariRequired Pegged Qty WorkOrder_ID Route Toh Step Start Date Due_Date
BAGHMCTO 50000 PLAWNEL i O3 IS8E0IT O3 IHEOIT

BCYIGS 30.00 PLANNED A5STIE H 0HITINT 0HITINT

BINSTOL 30.00 PLANNED A5STIE H 0HITINT 0HITINT

To Buy: PariRequired Pegged Qty PO_ID PO_Qir PO_Line $tart_Date Due_Date
BOSTIGS-RAW 30.00 POUG 20000 z 112342019 0SII0I7

JBRGA- 22.00 POOG 20000 5 112342019 0511017

JBRCA- 400 Poig 20000 z 112342019 0SII0IT

TERCUET 30.00 POOS #5000 1 111342019 0SHITI0IT

“Show Matl Shortage” will display only Raw Material Shortages for the selected order in the
corresponding view (i.e. Waterfall / Tabular) selected by user.

Display supply-demand summary

This option is listed on the Display drop down list. Use this tool when you want
to go directly to the Supply Demand window for a specific item. It is an excellent
way to quickly pull all planning information for a purchased item.
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Time-phased load summaries

VPi includes summary windows for workcenter load and labor load. These
options display the time-phased load profile on all work centers in a single
tabular display. Each row represents one work center and each planning bucket
is defined as Days, Weeks or Months. Buckets are color-code red if load exceeds
capacity. You can export these tables to Microsoft Excel.

Access the workcenter summary from the menu bar. Select Display >
Timephased Workcenter Load Summary.

amual Plannet for Systemi - (MFG1) - (0570172017 - 06/09/2017) - [Timephased Resource Load Summay(Total Records = 18)]
Fle Display Reports DBMaint tWindows - Help =18l

e e = EA N R P =

osmT P

050317 050517 0500117
1350
1 ﬂﬂ
[l
164
a2
1673

00

totalload

Access the labor summary from the menu bar. Select Display > Timephased

Labor Load Summary.

=4 visual Planner for Systemi - (MFG1) ) - [Timephased Labor Load Summary(Total Records =4)]
fle Diplay Reports DBMank Windows - Hep Jilﬁ

M

e e e e

Time-phased load summaries

To export a time-phased load summary to Microsoft Excel:
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1 Select the required columns or click on the icon in the first row of the first
column to select all columns. .

2 Right click on the first row and select Export.

3 Use the standard Windows dialogs to enter a file name and select the Excel file
format.

Customer order options

VPi provides options to select and work with requirements to be pushed out.
These windows list the orders affected by level loading on a workcenter:

Which Orders to Push Out
Which Customer Orders to Push Out

List of Customer Orders Pushed Out

In VPi, you have the option to level load a workcenter by rescheduling work
orders. If you reschedule work orders, the customer orders will also be delivered
later. Because some customer orders are very important and their promise dates
need to be honored, you need visibility to the orders affected by scheduling on a
workcenter.

Rather than go to either the Supply Demand detail screen to see the pegged
customer order or to the Waterfall View of Pegged Orders, you can display the
orders in a table. The summary list allows you to reschedule the customer orders
of choice.

The Which Orders to Push Out and Which Customer Orders to Push Out options
provide tables that list the orders that potentially will be delayed based upon the
current schedule. The table includes the Customer Name from the
SC_CUSTOMER_MASTER table.

When you select Display on the menu bar, you are given several options for
customer orders.

Customer order options
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ToolBar 3

v Ear
Table

Item List Filker
Create Firm Planned Order
Past Due Purchase Crders

Itern Lisk k

Set Default Resched Code

L:C For Plant

Items Load

Timephased Crders

Crders Windom

Which Srders be Pust ot

Push All Crders Cut

Which Customer Orders to Push Ot
List of Customer Orders Pushed Cut

Crderwise Wakerfall
Waterfall - Pegged Grders
‘aterfall - Feeding Supplies

Supply-Demand Surmmary
Timephased Labar Laad Surmmary
Timephased Workcenter Load Surnmnarsy

Forecast Consumpkion-Summarsy
Forecast Consumption-Cretailed

View Log
Undo

These options display records that are generated from within VPi:
Items Load
Timephased Orders

Orders Window
Which Orders to Push Out
Push All Orders Out

These options display global records that are not limited to within VPi:

Which Customer Orders to Push Out

List of Customer Orders Pushed Out
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Which Orders to Push Out is the same function as the Reschedule Requirement
for control items. Push All Orders Out is the same function as Re-Schedule All
Requirements for control items.

The following windows show the difference between "Which Orders to Push
Out" and "Which Customer Orders to Push Out. " The Supply Demand window
displays all the dates. The results will vary if buffers are involved.

avisual Planner for System i - {(MFG1) - (05/01,/2017 - 06/09,/2017)

Fle Display Reports DEMaint  Windows - Help

=& o Bl

el E) Sl ml+-0l0] gl BlE|

aSupply Demand Window[CMPOM85][COMPRESSOR-M85] - Min[90.00], Mult[0.00], Aga[0]

Supphy ID| Oty |Start Date| Orig Due Date|Due Date|Load| % [Sugg Due Date|Proj On Hand|Reqd Date|Reqd Oty| Peg To tem | Hem Description | Ana/Cust|Due Date|Sugg Date
Firm 120000504017 054047 05M0M7 |0.00 |0.00 [05M0M7 120.00
2 30.000 03107 (90000 |ORDO36_101 |CMPOMES | COMPRESSOR-MES [HOMDA  [0SM0M7 (031047
3 |Pind 9000 (0SM147 0537 05371517 |0.00 (000 031317 120.00
4 70.000 051517 (50000 |QORDO37_102|CWMPOMES | COMPRESSOR-MES [HOMDA  [0SMSMT |052617
5 34.000 051917 (36000  |ORDO3S_103|CMPOMSS | COMPRESSOR-MES [HOMDA  [05/20M7 |03/2617
6 |Pind 9000 (0SAEMT7 | OS622A7 052217 |0.00 (000 |03/2217 124.00
7 &1.000 052217 (43000 |ORDO33_104 |CMPOMES | COMPRESSOR-MES [HOMDA 052217 |03/2617
§ 27.000 032617 (54000  |ORDO40_105|CMPOMES | COMPRESSOR-MES [HOMDA  [05/28M7 |03/2817
9 0.000 060217 | 27.000 CRDO42_107 | CWPOMES | COMPRESSOR-MSS (HOMDA  |08/03M7 060317
10_|Pind 9000 [0S3MT|0R02AT 0BM0ZM7 |0.00 |0.00 |0BAD2M7 a0.00
11 46.000 060217 (44000  |FORECAST |CMPOMES |COMPRESSOR-MES OB/M3M7 (OBM3MT
12 2.000 060517 |44.000 CRDOH 106 | ChPOMES | COMPRESSOR-MSS [HOMDA  |08/03M7 (061317
13 |Pind 90.00 [D6MAMT  |OB06AT OBMBMT |0.00 |0.00 |0BADEMT 92.00
14 6.000 060617 (26000  |ORDO43_103|CMPOMSS | COMPRESSOR-MES [HOMDA  [DBMDGMT (0613417
15 |Pind 9000 (0G07HMT | OG09MT 060917 |0.00 (000 050917 156.00
16 79.000 060917 (77000 |ORDO44_109|CMPOMES | COMPRESSOR-MES [HOMDA  [0BMOMT (063417

alist Of Potential Orders with Late Delivery[MLG11X]

Order Type|Ord ID | Customer ID | Customer Hame |lem tem Type |0ty Source htem| Start Date|Due Date |Sugg Date | Days
Rel M4 IMPHMBS | Control hify 5400 (IMPAL-4 1202901899 120301899 | 04/252017 | 30611
2 (*}|Rel MOS BCSTMGM (Cortrol Mfg | 34300 |BAGMM2S 1202911399 |12/301 5899 |04/27/2017 | 30611
|3 )| Rel 2 BCSTRGL | Caontrol hfy 200.00 ([BAGKMES 1202901899 1203001899 | 050172017 | 30811
|4 )| Rel MO47 IMPHM25  [Cordral Mg 71.00 IMPAR-3 1242901899 [12/3001 899 | 050202017 | 30611
IS Rel Mgz IMPHMBS  [Cordrol Mfg | 20000 |IMPAS-4 Q5/M08/201 7 [05A 072017 | 050202017 &
Ili Rel mMo49 IMEWDO0 | Cantrol hfi 184.00 (OCSACT0 050872017 050972017 (03042017 3

The window above, "Which Orders to Push Out, " works with the current
workcenter and lists potential late orders for a workcenter. The potentially late
orders are the Supply Orders where "Supply Due Date" > "Supply Suggested
Date" (records shown in red in Supply Demand window).

The window below "Which Customer Orders to Push Out " is global and lists only
Customer Orders where Demand Suggested Date > Demand Due Date.
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¥isual Planner for System

(MFG1)

£= Flle Display Reports DB Maint Windows - Help

) - [List OF Potential Orders with Late Delive:

= = N o Y e e Y _|H|Eé|3|ll|+|—|9|9|£| | |

OordID |Hem Customer ID |Customer Hame | Oty Target C: (l urrent Ci (l

ORDO7S | SHFT3E0 | TOYOTA TOYOTA ORG 43.00 | 05H 052017 Q5052017 05MEB2017 5]
2(*) |ORDOM1S [CMPOCTIO [ Gh GEMERAL MOTORS 6500 |05A1/2017 051152017 05M 92017 5
F°) |ORDO29 [CMPOMZS  [HOMDA HOMNDA GEMNSET 5500|051 472017 031452017 0572572017 11
4"} |ORDOST [CMPOMSS  |HOMDA HORDA GERSET S0.00 |05H 502017 asM S0 7 0512602017 11
5(*) |ORDO4T [CMPLC1O  [ACMWE ACME 4300 |05A 62017 05162017 05/24/2017 5
6"} |ORDOG4 |IMP2A-T ACMWE ACME 22,00 |05A 72017 [y irgriny g 051802017 1
F*) |ORDOMT |CMPOCIO  |FORD FORD 160.00 |0520/2017 052002017 05252017 5
& (*) |ORDOSE [CMPOMSS  |HOMDA HORDA GERSET 5600 |052002017 052002017 05/26/2017 5]
) |ORDOME [CMPOCTO Gk SEMERAL MOTORS 55.00 | 0502172017 Qor2120$7 057252017 4
A0 (*3| ORDOOT |BAGMC1O |FORD FORD 50.00 | 056212017 0552152017 061 2017 11
A1 (*}| ORDO3S |CMPOMSS  |HOMDA HONDA GENSET 43.00 |05/22/2017 05222017 05/26/2017 4
12 ()| ORDO4S [CMPLCTO | ACME ACME V.00 | 0502402017 052472017 OE072017 14
A3 (*)| ORDOS4 [CMPLCTS  |ACMWE ACME 43.00 | 0552402017 052452017 0572902017 5
A4 (*)| ORDOGE |IMPAA-Z [ TOVOTA TOYOTA ORG 4.00 05242017 05i24/2017 06/02/2017 a
A5 (7} ORDO19 [CMPOCTO Gkt SEMERAL MOTORS 55.00 | D5026/2017 Q52652017 DE082017 13
A6 (*)| ORDO49 [CMPLCTO  |HOMDA HONDA GERSET 66.00 | 056252017 05252017 0672017 10
A7 (*)| ORDOZT |CMPOM2S | GM GEMERAL MOTORE 75.00 |05/25/2017 05282017 05/28/2017 1
A8 ()| ORDOTS |IMPCADM | TONVOTA TOYOTA ORG 3.00 | 0529:2017 052952017 0012017 3
19 (*)| ORDOSO [CMPLCTO [ ACKWE ACME 66 .00 | 0552902017 0552952017 0672017 El
20 (*)| ORDOS2 |CMPOM2S | GM GEMERAL MOTORE 77.00 05312017 05312017 0632017 13
21 ()| ORDOET |IMPAL-3 TOVOTA TOYOTA ORG 5.00 |05/3152017 03312017 0E0202017 2
22 (*3| ORDOGS |IMPA2A-4 TOVOTA TOYVOTA ORG 100 | 055312017 0513152017 060202017 2
23 (*)| ORDOSE |CMPLCTS | ACME ACME I7.00 | 06042017 OE04/2017 06062017 2
24 ()| ORDO33 [CMPOMZS Gk SEMERAL MOTORS 74.00 | 06042017 060472017 06M 302017 E]
25 (*3| ORDO41 [CMPOMSS  |HOMDA HOMNDA GERSET 44 00 | 06/052017 OBMS2017 061 302017 5
26 ()| ORDO20 |CMPOCIO  |FORD FORD 50,00 | DEMDE6/2017 Q662017 DED52017 2
27 () ORDO43 [CMPOMSS  |HOMDA HONDA GEMSET 26.00 | 05062017 OGMOE2017 06M 302017 T
28 (*)| ORDOST [CMPLC1O  |HOMDA HORDA GERSET 4500 | 06052017 OBMS2017 06092017 1
29 ()| ORDO44 [CMPOMSS  [HOMDA, HOMNDA GEMNSET F7.00 061 0/2017 061052017 061372017 3
F0 (*y| ORDOI4 [CMPOMZS [ Gh GEMERAL MOTORS 50,00 |05M 142017 Q6152017 06M 302017 2

Customer order options

Customer orders that are rescheduled are displayed from the option List of

Customer Orders Pushed Out.
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isual Planner for Syste: jith Due date Changes- Tot
£ He Diply Reports DBMant Windows - Help
3(&] o [ =[ldmlo] il B @leld] B+ =[] BlE

| Order ID PartID Description Customer ID Customner Hame Oty Due Target Completion | Current Completion Days

ORDD45_170 CMPLCTD COMPRESSOR-LCIO AChE ACME T 057242017 0BAO72017 14
2 ORDDM9_139 CHPOCTD COMPRESSOR-10 M GEWERAL MOTORS. % 057262017 0B/Da2017 13
3 ORDO32_112 CHPON2S COMPRESSCR-M25 GM GEWERAL MOTORS 7 050312017 0BA 32017 13
4 ORD023_166 CHPON2S COMPRESSCR-M25 HONDA, HONDA GENSET % 051412017 0572502017 1
E ORDOO 121 BAGMCIO FORD FORD Ell 050212017 0BID1 2017 1
1 ORDO3?_102 CHPOMBS COMPRESSCR-MBS HONDA, HONDA GENSET l 05H5207 0552017 10
7 ORDI43_171 CHPLCTD COMPRESSOR-LCID HONDA, HONDA GENSET [ 038007 0BO72017 10
8 ORDOS4_176 CMPLCTS COMPRESSOR-LCTS ACME ACME 43 052412017 080212017 9
k) ORDOBE_1 85 IMPAA-5 TOYOTA TOYOTA ORG 4 052412017 080212017 9
10 |ORDOSD_1T2 CMPLCTD COMPRESSOR-LCID ACNE ACKE 3 0580017 08072017 9
11 ORD033_MN3 CHPONZS COMPREZSCR-M2S M GEWERAL MOTORS 1] 0BD4R2M7 B3R 9
12 ORDIME_138 CHPOCTO COMPREZECR-10 M GEWERAL MOTORS B3 03 my 0582017 8
13 ORDD47_168 CMPLCT0 COMPRESSCR-LCID ACHE ACME 43 05607 0572412017 8
14 ORDD41_105 CMPOMES COMPRESSCR-MBS HONDA HONDA GENSET “ 0BD52M7 0BA32017 8
15 ORDD43_108 CHPOMGS COMPRESSCR-MES HOMDA, HONDA GENSET i OBDG2017 0BA 32017 7
16 ORDOTS_211 SHFT380 TOYOTA TOYOTA ORG 4 0a0m7 09162017 6
17 ORDIM7_137 CMPOCTO COMPRESSOR-10 FORD FORD 160 057202m7 0a7252017 5
16 ORDOGE_103 CHPOMES COMPRESSOR-MES HOMDA, HONDA GENSET i 057202017 0572512017 3
19 ORDOSE_178 CMPLCTS COMPRESSOR-LCTS ACME ACME ki 060412017 0B/D32017 3
20 ORDOME_136 CHPOCTD COMPRESSOR-10 M GEWERAL MOTORS. % 08721207 0572502017 4
21 ORD039_104 CHPOMSS COMPRESSOR-MES HOMDA, HONDA GENSET k5] 08/2202m7 0572612017 4
22 ORDOSS_177 CMPLCTS COMPRESSOR-LCTS ACME ACME % 052802017 0BID212017 4
23 ORDOT3_195 IMPCADM TOYOTA TOYOTA ORG 3 052802017 0BID1 2017 3
24 ORD044_109 CHPOMBS COMPRESSCR-MBS HONDA, HONDA GENSET 7 0BAD2017 0BA 32017 3
25 ORDOB?_183 IMPAA-5 TOYOTA TOYOTA ORG 3 050312017 0B/D202017 2
26 ORDOBS_1 90 IMPAA-4 TOYOTA TOYOTA ORG " 050312017 0B/D202017 2
27 ORDO20_151 CMPOCTD COMPRESSCR-10 FORD FORD 0 OB/DB2017 0B/Da2017 2
28 ORDO34_114 CHPON2S COMPRESSCR-M25 M |GENERAL MOTORS B0 0B/12017 0BA32017 2
29 ORDOB_1 86 IMPAA-1 ACME ACME 2 05H702017 054802017 1
30 ORDO31 11 CHPONZS COMPREZSCR-M2S M GEWERAL MOTORS 5 DaiaRmy 0572902017 1

Item List Filter

Use this tool to see the status of your critical parts right away. You can filter
critical items based on either supply or independent orders. You can save
multiple templates to the database. These templates are loaded and appear
when you select Display > Item List.

Visual Planner User Guide Page 4-25



4-26

Using the VPi Engine

Fields

=fitem List Filter ]|
Template Mame: at tarmer Orders
Settings:
Item:l | Make ltems: ©* Ves € Mo
Planner ID/Buyer D I j Furchase ltems: £ ez Mo
Product Famil_l,l:l ﬂ Cantral ltems: & Yez: © Mo  Ignome

Supply Orders Demand Orders |

Cuztomer Orders »= |2

Forecast Orders #= |E|E|EI
Safety Stock Orders »= |995|
Show Past Due »=|339

] I Cancel Save Save Az Delete

A quick way to view supply demand for an item is to select a specific item from
the Item drop down list in this window.

Specify the following information to create a template:
Template name

After you have determined your search information, type a name, for example,
Purchase Exceptions, and click Save. To use a saved template, select Display >
Item List. To use a particular template as a starting point for

Item List Filter

another template for a new type of search, select the template, make your
changes, and then click Save As.

Item ID
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Select an item.

Make Items

Select Y (default) to display manufactured items.
Purchase Items

Select N to display purchase items.

Planner ID/Buyer 1D

Select an Analyst ID. The default is ALL. If you select purchase items, this is a list
of buyer IDs. If you select make items, this is a list of Analyst IDs. If you select
both, this is a list of both with duplicates eliminated.

Control Items

Select Y, N, or Ignore (default). If you select yes, only control items (items with a
reschedule flag of 1, 2, or 3 in the Item table) appear. If you select no, only non-
control items appear. If you select Ignore, items are selected regardless of
control code.

Specify the following information on the Supply Orders tab:
Show Items with past due > =

Enter O or any positive whole number. If you select supply orders, only those
items with a start date greater than the number of days before the horizon start
that you select here appears. If you select demand orders, those items with a
due date in the past of more than the number of days that you select here
appears.

Show Items with Expedites > =

Enter O or any positive whole number. Available only for supply orders. Only
those items with a supply due date more than the number of days you select
here later than the required date appear.

Show ltems with Defers > =

Enter O or any positive whole number. Available only for supply orders. Those
items with a supply due date earlier than the number of days you select here
than the required date are added to the list of items.
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Show Items with Cancel orders

Select Y (default) or N. Available only for supply orders. If you select Y, items
with orders recommended for cancellation are added to the list of items if they
are not already on the list. If you select N, items are added to the list regardless
of the presence or absence of cancel orders.

Show Items with Exceptions within Offset

Select Y (default) or N. Available only for supply orders. Offset is the number of
days a supply is moved in or out in order to balance load to capacity. This often
creates an exception condition, if the order due date no longer matches its
required date. To avoid seeing these messages on the engine during planning,
select N. Items then are added to the item list only if defer or expedite
exceptions are greater than the offset value. If you select Y, item deferrals and
expedite exceptions are added to the list, even if their exceptions are less than
the offset value.

Show Items with planned orders within frozen Zone

Select Y (default) or N. Available only for supply orders. If you select Y, items
with planned orders within the period are added to the list of items if they are
not already there. If you select N, items are added to the list without checking
for planned orders within the frozen period.

Specify the following information on the Demand Orders tab:
Customer Orders > =

Enter any positive whole number. Available only for demand orders. Only those
items with customer orders with projected completion more than the number of
days you select here than the due date appear.

Forecast Orders > =

Enter any positive whole number. Available only for demand orders. Only those
items with forecast orders with projected completion more than the number of
days you select here than the due date appear.

Safety Stock Orders > =

Visual Planner User Guide Page 4-28



4-29 | Using the VPi Engine

Enter any positive whole number. Available only for demand orders. Only those
items with safety stock orders with projected completion more than the number
of days you select here than the due date appear.

Show past due > =

Enter O or any positive whole number. If you select supply orders, only those
items with a start date greater than the number of days you select here

Item List Filter

before the horizon start appear. If you select demand orders, items with a due
date in the past more than the number of days you select here appear.

Actions

The following buttons are available from this window:
OK Save template changes to memory, but not to the database.
Cancel Do not save you entries and exit the Item List Filter.

Save Save changes to the template to the memory and to the database.
Save As Save this new template to the memory and the database with a
user-defined template name.

Delete Delete the current template from the database, effective the next
session. The template is not deleted from memory as some windows use
the template.

Examples

To see purchase parts for control items with orders more than 3 days past due or
cancel orders, complete the window as follows:
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Template Mame: |I:ritic:al Purchaze M aterial ll
Settings:
Iterm: I LI Make ltems: £ Yes & Mo
Planner D /B uyer 1D I ;I Purchase ltems:  ¥es © Mo
Product Farnily: I LI Contral ltems: % ez © Mo  |grnore

Supply Orders I B Demand Drder&l

Show [tems with Past Due »= |3

Showvy [temz with Expedites = IEI

Show [ternz with defers = IIJ

Show Iterms with Cancel orders: " Yezx [ Mo

Show Items with Exceptions within Offset: " Yez * Mo

Shaow ltems with planned arders within frozen Zone; € Yes & Mo
ITI Cancel | Save | Savess | Delete

To see items with customer orders that are late by more than 3 days, but not

those items with safety stock or customer orders, complete as follows:

SQneemuserieer |

Template Mame: |Late Customer Orders

=]

— Settings:
[tem: I j
Flanner 1D/Buyer 1D: I ll
Product Farnily: I j

Make ltems: © Yes € Mo

Furchasze ltems:

Control ltems: ¢ ez ¢ Mo & |gnore

Supply Orders &2 Demand Orders |

Customer Orders r= |3
Forecast Orders = IE!E!S
Safety Stock Orders b= IEIEIS
Show Past Due >=|EI

Ok I Cancel Save

Save bz

Delete
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Set Default ReSched Code

View Log

Undo

The DEFAULT_RESCHED_CODE parameter value specified in RESPARA table governs the
default ReSchedule Code used by different functions such as Drag and Drop, Modify
Supply and Level Load in VPi for firming up a planned order.

During Project load, VPi will read default Reschedule Code value from this parameter
value. If missing, then it will set the default value as 1. Also user will have the option of
overwriting the RESPARA value by using new added option “Set Default Reschedule
Code” under DISPLAY menu as shown below:

Select Default Reschedule Code |

1 [MOAUTORESCHED)
2 [RESCHEDOUT]

3 ﬁHESEHEDINﬂ Cancel |

5[DOMTUSEBEFORE)

Use this function to save the decisions made in the planning session. You can view and
print the log of your decisions.

You can undo most of your actions; however, you cannot undo change requirements and
change all requirements decisions. To undo those actions, load the project again. See
“Load project” for more information.
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Using the toolbar

The toolbar provides some of the same options that are available from menus and some additional

options.

@8] 2| bl e==laa o] @i @ D2 B+ =000 @ BB

The following functions are available from the VPi toolbar:

E] Load project. Use this icon to load the project into memory.

E]
=

explosion that includes your changes.

Print the screen that is in focus. Click to print the active window.

Refresh all VPi views. Use this option after you make a change to the plan to run a planning

B Alternate Route. This icon is available for planned and firm planned supplies with multiple

processes.

Alternate Route Order

Supply 1D
[tern |0
Lluantiby

Due Date:;

Foute Dezcription;

[ter Revizion:

Prirmary Boute:

ERP Alternate BOM 1D

ERP Routing 1D
ERP Routing Yerszion:
Load Haours:

Fiezchedule Code;

o |

IPMd

pMPHE?E

|9unn

|nax12xzn1?

]

|ROUTE 102

p

|v

ITEST1

IHDUTE2

|TEST2

Cancel |

i e ate Ehanae |
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The definition of an alternate route depends on data downloaded from your
ERP product. An alternate route can be the substitution of an operation in a

route or the alternate route can be a complete replacement for the original
route.

You can enter the due date of the supply and display the available alternate
processes. You then set the reschedule code for the supply. If a planned supply is
alternate routed, the supply is firmed up. This information is uploaded to the
System i and downloaded for the next planning session.

_rI-—J Offload. Use this icon to perform offload decisions on released work orders.

Alternate workcenters defined in the route appear at the top of the alternate
workcenters list. If the reschedule code is set to 5, you cannot modify the due
date.

=T |
Supply 1D [MOz1
Item |CMPOM25
Quantity |0.00
Load [18.00

whork Center Start D ate ||:|5,-'|:|2,.Jg|:|1 7
work Center Due Date  [05/04/2017
Offload Work Centers I-"-"-H L2z j

Reschedule Code I1 j

G?' Outsource. Use this icon to create a purchase supply for a make item. If you outsource an item,

you must manually contact your purchasing department to notify them of the order. The item ID is

the part that will be outsourced. This window is displayed when you select
Outsource:
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Group Outsource Dialog E
ltemn ID | Quantity Date Reschedule Code tadify
ChPOMES  [REERun oS 20 7 0
Apply
Cancel

Enter this information:

Type in the quantity to be outsourced.

Type in the day on which the material will be available in the dock.
Reschedule Code

Either 5 or other. If you set this code to 5, earlier requirements for this item
are satisfied by generating planned manufacturing orders. Any other value

reschedule behavior is based on the control item code for the item.

-'F'l Modify supply. Use this window to maintain the quantity of a planned or firm planned order. This

window is displayed when you select this icon:
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Srodiysupoy |

Supply 1D IFi"T'
Iterm ID: ||:MPDM85
Due Date: |n5;1 0/2017
Start Date: |05;u4;2m 7
Ruantity: |1 20.00
Itern Fewvizion I
Foute 1D: I
Offset: |n
Route Description: I
Fie-schedule Code: {1 NOAUTORESC =]
¥ Firm Up all Feeding Supplies

Cancel |

You can change the Due Date of the manufacturing order, its quantity and
Reschedule Code.

Firm Up all Feeding Supplies

Firm up component work order or purchase order suggestions while firming
up the assembly schedule. All the feeding supplies to the assembly order will
be firmed up as if, they already had suggestion status.

Caution: Visual planner may reallocate the firmed up supplies to other
assembly order if the other assembly order is required sooner. It is always
better to firm up the supplies from earliest requirement to the latest
requirement.

ET,},I Level load. Use this icon to move loads from one bucket to another on the same workcenter.
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Group Level Load Dialog E
Supply ID | Hem 1D | Quantity | Supply Load|Current Due Date|Hew Due Date| Resched Edit Due Date |

1 20 CMPOCTSE (90,00 18.00 05 17 05092017 1

Spply Changes |

Cancel |

Enter New Reschedule Code:
|1 NDAUTORESCHED) |

Change Code for Al |

Enter Mew Due Date:

Change Date for Al

‘ | Bl

You can move the load from one bucket to another in the same workcenter.
See “Maintaining decisions” for more information.

Group Level Load:

User can also select multiple orders/tasks by pressing Ctrl/Shift key and then
can click on Level Load icon to move multiple loads from one bucket to another
on same workcenter. Not only user can change the Due Date of a selected group
of records, but it can also be used for changing the Reschedule Code, thus a
mass firming of planned orders. Once the firm planned orders are created for
REP items, the XA Upload processes these records into Unreleased Schedules
and solves a long standing customer complaint of no option to mass release REP
schedules. This also opens up other features for VPI customers:

1) for traditional mfg, it allows for an easy mass firming of planned orders

2) for released MO, PO, REP Schedules and firm planned order, it allows an easy
mass change to the Reschedule Code

(say from 4 to 1 or from 1 to 5)

From the Orders Window, it's quite easy to select the desired records using the

traditional M.S. CTRL or SHIFT function keys and select Group Level Load. This
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will open up a dialog as shown below. User can provide a new ReSchedule Code
in the textbox marked with red outline in right-hand side and can click on
“Change Code for all” which will update reschedule code for all selected orders;

and hence firming up all planned orders.

Group Level Load Dialog

Quantity | Supply Load | Current Due Date| Hew Due Date | Reschedule Cy
CMPOC10 15.00 0sM12M7 051102017
CMPOCT0 05M97201 7 051952017 Apple Changes |

3 CMWPLCIO (90,00 15.00 05245207 0ar2402017 4
_ | Lancel I

Enter Mew Reschedule Code:

[4 RESCHEDINOUT) =]

EdtDueDate |

90.00

Change Code for All I

Enter Mew Due Date:

Change D ate for Al

@l Telescopic buckets. Use this icon to define a smaller planning window up front and longer
planning window in the future. The default is weekly buckets. You type in the number of buckets

for each bucket duration. This window is displayed when you select this icon:

Cancel

Telescopic Bucket |
Daily Bucket: |-| 4
Weekly Bucket: ||:|
Manthly Bucket: ||:|
Cuarterly Bucket; ||:|
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You can type in the number of buckets for each bucket duration.

2] Undo. Display the Undo Dialog to reverse a change that you made to the plan.

O . - . .
L‘_‘J Items Load. Select a workcenter and click this icon to display the Items Load window.

g" Orders Window. Select a workcenter and click this icon to display the Orders Window.

M Timephased Orders. Display the Timephased Window.

LD_I AP Log. Display a log of the actions taken during this planning session.

EJ Save. Save your changes.

[ g@l Write Schedule Pass. Save your changes to the Access database. The next time that you load the
project, the last plan is loaded. Two dialogs are displayed. Accept the default values and click OK.
£l

Push Out All Late Orders. This icon is active on the windows that list orders that may be late.

EIEJ Calendar Maintenance. Access the windows to create or maintain calendars.
=|H| Cascade Windows, Tile Windows. Change the display of open windows.

Ell

Search in a row

Iil Zoom In

[

Zoom Out
El Find
El Find Next
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Chapter 5 Uploading Data to the System i

This chapter discusses the process to upload files to the System i after you have finished planning in VPi.

The chapter consists of the following topics:

Topic Page
Upload settings 5-2
Write Schedule Pass 5-2
Save Plan - uploading data to the System i 5-3
Uploaded Data 5-4
Planned Order (PPPLNO) 5-4
Manufacturing Order Operations (PPRTGW.QUT File) 5-5
Requirements (PPREQM.OUT file) 5-5
Reschedule Activity Work (PPRACW.OUT file) 5-5

Source Of Demand reference (PPDMDR.OUT file) 5-6
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Upload settings

The config,ini file is located in the folder into which you installed VPi. Use the parameters
listed below to define the upload settings.

Parameter Definition

PlannedWorkOrderQOutputHorizonLength Number of calendar days planned mfg orders are
to be uploaded to the System i.
Any number from 1 to 999; default = 7 days.

RawMatlReleaseOutputHorizonLength Number of calendar days planned purchase orders
are to be uploaded to the System i.
Any number from 1 to 999; default = 7 days.

RequirementHorizonlLen Number of calendar days requirements are to be
uploaded to the System.
Any number from 1 to 999; default = 7 days.

NonDrumOutputHorizonLength Number of calendar days requirements updating
pegged requirements of Replenishment planning.
Any number from 1 to 999; default = 7 days.

To tailor the Planning Engine to "turn off any filtering" and upload all records, change the Config.ini
parameters to match these statements:

PlannedWorkOrderOutputHorizonLength=999
RawMatlReleaseOutputHorizonLength=999
RequirementHorizonLen=999
NonDrumOQutputHorizonLength=999

Write Schedule Pass

Use the option Write Schedule Pass to save a planning session to the local database on
the PC ( or central SQL Server). Write-schedule Pass utilizes the OutPutCustom.sql script
that resides in the main install folder.

This functionality allows companies with multiple planners to place the VPi database on a
server. Planner 1 accesses the server and runs their portion of the planning run and runs
Write Schedule Pass to save the planning changes to the local database. Planner 2 loads
the project, runs their portion of the planning run and runs Write Schedule Pass to save
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their changes back to the local database. When the last planner is finished, run Save Plan
to upload data to the System i.

Write Schedule Pass creates the full functioning VPi waterfall chart. The Waterfall Chart is
a tool that can help identify specific planning details and dates for a specific order, that is,

the requirements to expedite a specific customer order. Most of the options are self

explanatory and the Longest Rope is the portion of the order that has the longest time
from start to finish.

aVisuaI Planner for System i - (MFG1) - (05/01/2017 - 06/09/2017) - [Waterfall Chart]

?‘F\Ie Display Reports DB Maint  Windows - Help

e e S 2 A B X S =

w Start Date Order ID Customer
2 (ORDO23_154 GM|CMPOCTS
3 CRDO25_162 GM|CMPOCTS
4 CRDO38_104 HONDA | CHPOMBES
5 CRDO3T_102 HONDA | CHPOMBES
1] CROD40_105 HONDA | CHPOMBES
i CRDO3E_1M HOMD, | CHPOMBS
§ CRDO3B_103 HONDA | CHPOMBES
] CRDD42_107 HONDA | CHPOMBES
10 CROD48_170 ACME |CMPLC10
11 CRDD4T_163 ACME |CMPLC10
12 CRDOB_136 Ght |CMPOC1D
13 CRDOTT 157 FORD | CWPOC1D
14 CRDD18_138 GM|CMPOC10
15 CRDO29_168 HONDA | CHPOMZS
b (CRDO31_111 GM | CHPOMZS
17 CRDO30_1M0 HONDA | CHPOMZS
18 CRDO32_112 GM | CHPOMZS
19 CRD0S4_176 ACME |CMPLCTS
20 CRDOSE_178 ACME |CMPLCTS
pal CRD0S5_177 ACME |CMPLCTS
2 CRDOBS_191 TOYOTA [IMPAS-2
5 CRDOB3_155 ACME [DFMACTS
24 CRDOBS_157 TOYOTA IMPAR-2
i CRDO18_139 GM|CMPOC10
2% CRDO15_135 FORD | CWPOC1D
2 CRDOT4_134 GM|CMPOC10
28 0501207 |CROMEATH HONDA |CMPLC10
29 0503217 |CRD046_168 HONDA |CMPLC10
30 05042207 |CRD0S3_TS ACME |CMPLCTS
31| |DSﬂD4f2017 CORD022_153 | G |CMPOCTS _lj
1 }

B g Sales order ORDI3L_L11 for @M, projected 05/28/2017, qhy=75,00, Priority=0
E-% Part CHPOMZS, on_hand=0.00, short=75.00
-1 WO: RWO113, Dus date: 05122017, TB: 0, Tatal W ghy: 90,00, Pegged gty: 44,00
B E Prinary Route
4] Step 3,00 on wje ASSYIF, qby=90.00, TE={hrs, start 05/12/2017
B-M Step 2,00 on wje TESTLF, qty=90,00, TB=Dtrs, skart 05/10/2017
EI% Part RTAOMZS, on_hand=0.00, short=30.00
[ 1¥1 WO: RWOGD, Due date: 05/09/2017, TB: 0, Total ' gty: 90,00, Peoged qty: 90.00
B E Primary Route
-] Step 2,00 an wic DVNBAL, qhy=50.00, TB=(krs, skart 05/09/2017
(-4 Shep 100 on wic ASSVIR, oty=50.00, TB=Ohs, start D5/04/2017
E-‘@ Part [MPAS-3, on_hand=0.00, short=90.00
14 WO: RWO34, Due date: 05/03/2017, TB: 0, Takal WO qty: 78,00, Peaged qty: 78.00

>

b B E Prinary Route

=114 Skep 1.0 an wc WLDOZD, oty=78.00, TB=0hrs, start 050312017
EI& Part IMPH!ZS, on_hand=0.00, shart=78.00
[ M W0 1047, Due dake: 12/3071899, TB: 551016, Takal WO gty: 7100, Pegged gty: 3.00
B W Workorder MO47
¢ WIP after step 3,00 &t wit DRLCHE, on_hand=16.00
M Step 3.00 an wic DRLCNC, ghy=53.00, TB=5351016Hs, start 12(28/1899
- M Step 2,00 an wic MLGILY, qhy=41,00, TB=S51016Hrs, start 12(29/1899

Ready

\ D 03162018

Right click in the window on the right to change the display.

Save Plan - uploading data to the System i

As discussed in the chapter “Prepare For Planning,” you can plan in two modes: test or

planning. The planning mode is set when you start the engine, from the DownlLoad
option used in the last download.

When you finish planning in test mode, select File > Exit Application to exit the planning

engine.

When you finish planning in planning mode, you have these options:
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Select File > Save Plan to save the plan, upload the data to the System i, and release the
System i jobs locked when you ran download. This is the normal choice. The remainder of this
chapter describes what happens when you take this option.

Select File > Cancel Plan to release the locked System i jobs without saving the plan. Use this
option if you do not want to save the plan until you make changes to data on the System i.
After you make the changes, run download and then plan again.

Select File > Exit Application to exit the planning engine without either saving the plan or
releasing the locked System i jobs. You must confirm your action if you select this option, as
this is not a normal choice. Use this option only if you need to exit the planning engine for
some reason but do not want to save or cancel the plan.

Uploaded Data

See the integration guide for your ERP product for information about the files that are uploaded
to the System i. The files are written to the SampleDBAP folder in the VPi install folder, then
transferred to the System i for processing. In the SampleDBAP folder, the files use the file
extension of .out.

Below is the list of output files which are generated during Save Plan:
Planned Order (PPPLNO)

This file contains one record for each open, firm planned, and planned “supply order”:

Open / released work order [manufacturing order, REP schedule],

Open / unreleased REP schedule,

Open / released purchase order [purchase line item, purchase line item header,
purchase line item release, purchase requisition, and intersite order]

Firm planned / planned work order [manufacturing order, REP schedule],

Firm planned / planned purchase order [purchase line item, purchase line item release,
purchase requisition, and intersite order].

It is sequenced by item (POITM), due date (PODUD) and start date (POSTD).
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Manufacturing Order Operations (PPRTGW.OUT File)

This file has a record for each operation included in the T_TO_MAKE table and if the start date of
operation is within the PlannedWorkOrderOutputHorizonLength specified in the config.ini file.

Requirements (PPREQM.OUT file)

This file contains a record for each demand for each (“component”) item, and identifies the
parent item, if the demand came from a higher level item.

There are no records for safety stock or shrinkage. Safety stock is generated for use (calculation,
display or report) from the safety stock field in the item record. Shrinkage on supply orders is
stored in the shrinkage qty field (POSHK) in the PLNORD record.

The VPi planning engine (PE) creates & sends only 2 types of records:

e records for generated / dependent demand (RQSOR = 8) — the component / child
requirements for planned and firm planned WOs, and

e records for unconsumed forecasts (RQSOR =6, RQORG = 6).

Note: No records are written for 2 types of demand that are planned: Negative on hand, due on
the Current Date, and safety stock, due on (Current Date + Planning Fence, which is sent per the
MRP safety stock lead time option).

Reschedule Activity Work (PPRACW.OUT file)

This file has a record for each open order and firm planned order for which:

(1) automatic rescheduling was requested — on Initiate Planning Run (screen AMM300) — for that
type of order (PO, MO or REP schedule), and

(2) planning determined the order is:

e needed earlier or later (exception 21, 22, 32, 33, 41,42, 61 or 62), or
e not needed at all (Cancel exception - 71 or 72).

Note: Cancel code, set at the warehouse level, determines, when the user has requested
automatic rescheduling, whether orders with a Cancel exception, should be rescheduled to a date
one month from the end of the calendar. This gives open manufacturing orders a very low
priority relative to needed orders, so helps ensure they are not worked on. Values are:
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0 Do not reschedule.

1 Reschedule to end of the calendar, less one month.

Source Of Demand reference (PPDMDR.OUT file)

This file links a supply — an open or planned supply order or on hand inventory — to independent /
ultimate demand for an item —e.g., a customer order, forecast, safety stock, etc. One demand
can have multiple supplies, and one supply can meet multiple demands.

Records are written to this file only if field PEGC, Demands -per supply- To Track, in downloaded
Warehouse Control file is positive.

If field DSQH, Track demand for On Hand, in downloaded Warehouse Control file = 1-Yes, pegging
records are written for the quantity on hand, as well as for open and planned orders.

In VPi, supply (orders and/or on hand) can track to five types of demand: (1) Sales, (2)
Unconsumed Forecast, (3) Safety Stock, (4) Supply Order — if there is no sales or forecast demand
for a supply WO — open or firm planned, or negative on hand.

1) Sales — Regmt sequence no (RSEQ), sent to the PE in Sales, as a User Defined Attribute
(“UDA”),

2) Unconsumed Forecast — Reqmt sequence no (RSEQ), supplied by PE when it writes the
REQMTS record,

3) Safety Stock — No regmt seq no, or planned ord seq no,

4) Supply Order — Planned order sequence no (PSEQ) supplied by PE when it writes the PLNORD

record,

5) Negative on hand — No reqmt seq no, or planned ord seq no.

Note : With Visual Planner Version 7.0.214, Demand reference logic has been rewritten to
compute the pegged quantity. In case, you have issue with and want to use the old logic, you
can open the VPi database and goto RESPARA table and add a parameter called
DMDREF_WITH_QTY and specify value of 0.
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Chapter 6 Planning Reports in VPi

This chapter discusses the Planning Reports Available in Visual Planner once you write the planning result

to the database. The chapter consists of the following topics:

Topic Page
Load Profile Report 6-3
Purpose 6-3
Usage 6-3
Work Order Pegging Report 6-5
Purpose 6-5
Usage 6-5
Suggested New PO (Detailed) Report 6-6
Purpose 6-6
Usage 6-6
Part Supply Demand (Detailed) Report 6-8
Purpose 6-8
Usage 6-8
Shipping Buffer Expedite Report 6-9
Purpose 6-9
Usage 6-9

Visual Planner User Guide

Page 6-1



6-2

Planning Reports in VPi

Once the planning is done, user can put the supply schedule back to the ERP system and view the result
in the normal MRP screens. In some ERPs, not all the visualization available in Visual Planner is available.
For this, reporting functionality has been added to Visual Planner so that user can go back to Visual
Planner even after a planning is completed. Visual Planner makes use of built in HTML Viewer of
Microsoft Windows Operating system hence no additional reporting component needs to be installed.
Data from planning Reports is accessed from the local database of the Visual Planner hence you need to
complete the writing the Visual Planner schedule to the database thru writing schedule at the end of
planning.

Following Planning Reports are currently available in Visual Planner.

Load Profile Report

Work Order Pegging Report
Suggested New PO (Detailed) Report
Shipping Buffer Expedite Report

Part Supply Demand (Detailed) Report

To check report, user needs to click on menu option named Reports -> Run Report. This will provide user
option to select from one of the above mentioned reports as shown below:

Run report, page 1 of 2 E |

Chooze one of the following Reparts that are available:

WWorkorder Pegaing
Suggested New PO [Detailed]
Part Supply Demand [Detailed)
Shipping Buffer Expedite

o BECh I Mewt > I Cancel Help
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For each report, we have below buttons at the top:

EEEEEN
This icon is for Zoom In the report.

This icon is for Zoom Out of the report.

@ This icon is for Printing the current displayed page of the report.

@ This icon is for Exporting the current displayed page of the report as excel file at user specified
location.

H This icon is for Saving the current displayed page of report as web page at user specified location.

ﬂ This icon is for Closing the report dialog.
= This icon is for moving to next page of current selected report.

% This icon is for moving to previous page of current selected report.

User can customize the report and change the Report logo by going to Visual Planner installation
folder using Windows Explorer, and replacing the Reportlogo.gif file in the ReportTemplate
subfolder with their own preferred images files in the .GIF format.

Load Profile Report
Purpose

Load Profile Report provides the bucketized load on each of your facilities. Work load generated
by each task on a given work center(facility) is aggregated to daily buckets, then further summed
to get weekly and monthly view of load and capacity.

Usage

Selecting Load Profile option from the list will provide user with below screen where he can filter
report data on the basis of work center; date range; and bucket type for load profile report.
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Load Profile
Workcenter List Date Range
I Start Date: I
ARCTZ =
ASSY1B End Date: I
ASSYIF
ASSYIN
ASSYIR
DE=100
DRLCHC
DvNBAL
FRG100
FRG130
FRIO01 ~ Bucket Type
GRD75L _
LTHINC @ Dally  Weekly " Monthly
LTHZNC
MLGT T
SPECIAL TOOL [V Show Labor Report
TEORE1
TESTIF —
WwLDO0
WLD020 =l
I~ Select Al
< Back I Finizh I Cancel | Help
Clicking Finish will result in below screenshot:
Labor Load Profile, Page 1 of 1 [ x]
|8 5[] ] %] =]
m LABOR LOAD PROFILE
WORKCENTER ID: ASSYTE WKCTR DESC: Assembly UNITS: 2.00 OVERTIME RATE: 15.00
CALENDAR:CAL2 TYPICAL BUFFER: 64800.00 DEPARTMENT: MINIMUM BUFFER 0.00
BUCKET_START BUCKET_END LOAD (Hrs) LABOR LOAD (Hrs) CAPACITY (Hrs} LOAD /CAPACITY(%) LOCATION
05/01/2017 05/01/2017 537 1073 36.00 14.91 MFG]
05/02/2017 05/02/2017 2 90 290 36.00 806 MFG]
05/03/2017 05/03/2017 0.00 0.00 36.00 0.00 MFG
05/04/2017 05/04/2017 29 55 29.70 36.00 82.08 MFG]
05/05,2017 05/05/2017 0.00 0.00 0.00 0.00 MFG]
05/06/2017 05/06/2017 0.00 0.00 0.00 0.00 MFG
05/07/2017 05/07/2017 217 4.33 36.00 6.02 MFGT
05/08/2017 05/08/2017 4020 4020 36.00 167 MFG]
WORKCENTER ID: ASSYTF WKCTR DESC: Assembly UNITS: 1.00 OVERTIME RATE: 15.00
CALENDAR: DEFAULT TYPICAL BUFFER: 0.00 DEPARTMENT: MINIMUM BUFFER 0.00
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Work Order Pegging Report
Purpose

To show how each open work order and firmed work order is pegged to its assembly order or
customer/forecast/safety stock order. You can optionally display just the assembly order by
adding following parameter to config.ini manually to [System] section:

ShowMultilLevelPegging=0

Usage

Selecting WorkOrder Pegging option from the list will provide user with below screen where he
can filter report data on the basis of facility (work center); Start date; Part ID, Analyst ID, WO ID,
MAKE / BUY / BOTH for WorkOrder Pegging report.

Workorder Pegging

—workcenter List
I Part 1D I

ARCTZ -
ASEY1E Start Date: |
ASSYIF
ASSYIN
A55TIR Analyst ID: | =l
DBX100
DRLCNE

DYMHEBAL Workorder|D: I
FRG100 J

FRG130
FRMOO1 LI [™ Include Finished Gaods

[ Select Al [T Include Fiaw Materials
[v lgnare Dummy W ork centers

¥ Show Multi Level Pegging

< Back I Firizh I Cancel | Help |

Clicking Finish will result in screen similar to below screenshot:
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Workorder Pegging, Page 1 of 1

E1EETES

==

Start_Date

12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899
12/29/1899

12/29/1899

12/29/1899

WaorkOrder_ID

MO1

MO1

MO1

MO10

MO10

MO11

MOT1

MO12

MO12

MO12

MO13

MO13

MO14

MO14

MO14

Part_ID

BAGMCI10

BAGMC10

BAGMC10

BINSTO4

BINSTO4

BLD1C10

BLDI1C10

BLD1C75

BLD1C75

BLD1C75

BLD1M25

BLD1M2Z5

BLD1M85

BLD1M85

BLD1M85

JobStep
o
(]

(1]

WORKORDER PEGGING

WorkCenter_ID Qty
ASSY1B 90.00
ASSY1B 0.00
ASSY1B 0.00
ASSY1B 0.00
ASSY1B 19.00
FRMO01 0.00
FRMOO1 40.00
FRMOO1 0.00
FRMO01 50.00
FRMOO1 0.00
FRMOO1 0.00
FRMO01 30.00
FRMOO1 0.00
FRMOO1 80.00
FRM001 0.00

Order_ID

MO1

ORDO17

ORDO18

ORDO36

MO10

ORDO17

MO11

ORDO25

MO12

ORDO65

ORDO29

MO13

ORDO37

MO14

ORDO36

Product_ID

BAGMC10

CMPOC10

CMPOC10

CMPOMB5

BINSTO4

CMPOC10

BLDIC10

CMPOC75

BLD1C75

IMPAA-2

CMPOM2 5

BLD1M25

CMPOMB5

BLD1M85

CMPOMB5

Target_Date
12/30/1898
05/23/2017
05/11/2007
05/13/2017
12/320/1899
05/23/2017
12/30/1898
06/03/2017
12/320/1899
05/14/2017
05/21/2017
12/320/1899
05/15/2017
12/30/1898

05/13/2017

Proj_Date

12/30/1899
05/19/2017
05/11/2017
05/10/2017
12/30/1899
05/19/2017
12/30/1899
06/02/2017
12/30/1899
05/12/2017
05/12/2017
12/30/1899
05/15/2017
12/30/1899

05/10/2017

Suggested New PO (Detailed) Report

Purpose

To show each of the newly suggested Purchase order and its pegging information; which

assembly order/sales/forecast/safety stock are consuming the purchase item.

Usage

Selecting Suggested New PO (Detailed) option from the list will provide user with below screen

where he can filter report data on the basis of Raw Matls List; Date Range; Buyer ID and Vendor

ID for Suggested New PO report.
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Suggested New PO (Detailed)

r— Master Plan Iterm List

ALUM-HS
ALUM-<S
BAR-01
BAR-0Z
BAR-03
BAR-04
BAR-11
BAR-12
BAR-13
BAR-14

Add

Femove

Buyer ID: I ]'
Wendor ID: I 'l

— Date Required

Start:l
End:l

™ Select Al

¥ Shaw Multi Level Peaging

< Back I Firizh I Cancel | Help |

Clicking Finish will result in screen similar to below screenshot:

Suggested New PO (Detailed), Page 1 of 1

8| 3] el x]

Parc_ID Buyer ID Quy
BAR-02 BYR1 10.00
BYR1 90.00
BYR1 5.00
BYR1 90.00
JBRGA-3 BYR1 140.00
4]

Buyer_Date

05/17/2017

05/25/2017

05/26/2017

05/30/2017

05/15/2017

PO_Req_Date

05/23/2017

05/31/2017

06/01/2017

06/05/2017

05/24/2017

SUGGESTED NEW PO (DETAILED)

Analyst_ID Vendor_ID Vendor_Loc Order_Status

ANT

AN1

AN1

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

PITTSBURGH

Order_ID

RWO0244

ORD0O19

ORD020

RWO0419

ORDO20

ORD021

RWO0445

ORDOBO

RWO464

ORDO052

ORDO51

RWO2638

ORDO032

ORD033

Line

139

151

Customer_ID

GM

FORD

FORD

GM

TOYOTA

ACME

HONDA

GM

GM

Product_ID

SHFT380

CMPOC10

CMPOC10

SHFT380

CMPOC10

CMPOC10

SHFT380

SHFT380

SHFT38L

CMPLC10

CMPLC10

BINSTO3

CMPOM25

CMPOMZ5

Proj_Date

05

05

06

05

06

06/

06/

06/

06/

06/

06/

05

05

06

{23
/26
106/
{31
/06
09/,
02/,
02/,

05/,

14

08

{25
{31

102

/201

/201

201

/201

/201

201

201

201

201

/201

/201

/201

/201

201

il

Visual Planner User Guide
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Part Supply Demand (Detailed) Report
Purpose

To show the item supply and demand balance for each item along the planning horizon. Item inventory
available in stock, incoming supplies and the demand requirement indicating when they are required. All
the quantity shown is in the purchasing units.

Usage

Selecting Part Supply Demand (Detailed) option from the list will provide user with below screen where
he can filter report data on the basis of Part ID; Buyer ID and Vendor ID.

Part Supply Demand (Detailed) E3
kM azter Plan Itern Lizt
|| Buyer ID: I j
ALUM-HS i’
ALLUM-#S Wendor 1D: i
BaGMCI0 I J
BaGMCYS
BAGMMZE
BAGMAMES .
BAR-O1 rDate Requied——
BAR-02 _ I—
BAR-03 Start :
BaA-04 LI
End: I
Add Femove |

[~ Select Al ¥ Show bulti Level Pegging

< Back I Finizh I Cancel | Help

Clicking Finish will result in screen similar to below screenshot:
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Part Supply Demand (Detailed), Page 1 of 2

[N ENETES)

==

01

05

05

05

05

05

05

05

05

05

05

05/

PART ID: BCSTNGL
MRP LEADTIME: 8

SAFETY STOCK: 0

REQ DATE

101/1901
(04,2017
{0552017
10572017
10572017
(0852017
10972017
10972017
(1252017
(152017
15/2017

N512017

BUYER ID: BYR]

BUYER LEADTIME: 0

REORDER POINT: 0

Qry

200.00

197.00

0.00

19.00

177.00

3.00

177.00

15.00

180.00

174.00

1500

POH

219.00

22.00

2200

22.00

3.00

180.00

177.00

15.00

195 00

369.00

254 AN

PART SUPPLY DEMAND (DETAILED)

ORDER_ID

MO4

RWO17

ORDO36

ORDO37

RWO17

RWO21

RWO57

RWO57

RWO80

RWO85

RWO86

RWO10R

LINE

(1]

o

101

102

(1]

VENDOR ID:

AGGREG PERIOD: 0

CUSTOMER_ID

HONDA

HONDA

DOCK25TOCK LEADTIME: 0

FRODUCT_ID

BCSTNGL

BAGMMSE5

CMPOMB85

CMPOMB835

BAGMMS85

BCSTNGL

BAGMMS85

BAGMMS85

BCSTNGL

BCSTNGL

BCSTNGL

RAGMMEAS

PROJ_DATE

01

05

05

05

05

05

05

05

05

05/

05/

ns

/01/1901

/082007

o207

/13/2017

/08/2017

/082007

/10/2017

/10/2017

nz2pzmz

15/2017

15/2017

1RI2017

PART TYPE_ O
YIELD:1.00

QOH:19.00

ORDER_QTY

200.00

216.00

90.00

50.00

216.00

177.00

180.00

180.00

15.00

180.00

174.00

15 00

TARGET_DATE

01/01/1901

05/08/2017

05/13j2017

05/15/2017

05/08/2017

05/08/2017

05/10/2017

05/10/2017

05/12j2017

05/15/2017

05/15/2017

0511Ri2017

Shipping Buffer Expedite Report

Purpose

To show item shortages for each customer order being shipped. For each customer order, all the items

that are short are categorized into to make and to Buy section and detail out how much quantity

required, when and where they are progressing currently in the production.

Usag

e

Selecting Shipping Buffer Expedite option from the list will provide user with below screen where he can
filter report data on the basis of Customer Order ID; Part ID, Analyst ID, Cutoff Date Range; MAKE / BUY /
BOTH for the components which need to be expedited.
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Shipping Buffer Expedite

Start D ate: ||

End D ate:

Order 1D

Custamer |0

Lef Lef Lel

Product 1D:

|

|

|

Analyst [D: I
|

Part D I

Cutoff: I? day(s]

¥ Include Finizhed Goods
¥ Include Faw Materials

< Back I Finizh I

Cancel |

Help

Clicking Finish will result in screen similar to below screenshot:

ing Buffer Exped

E1EETES

‘ORDER_ID
ORDO15

To Make:

ORDO14

To Make:

ORDO30

To Buy:

To Make:

LINE_NUM
135
PartRequired
CMPOC10
CMPOC10
CMPOC10
CMPOC10
CMPOC10

134
PartRequired
CMPOC10
110
FPartRequired
ICSOM25

FartRequired
CMPOM25
CMPOM25

DEWOM25

CUSTOMER_ID
FORD

Qey To Expdr
90.00

90.00

90.00

90.00

90.00

GM

Quy To Expdt
90.00
HONDA

Quy To Expdt
17.00

Qty To Expdt
90.00
90.00

67.00

SHIPPING BUFFER EXPEDITE

FRODUCT_ID
CMPOC10
WorkOrder_ID
MO19

MO94

MO94

MO95

MO95

CMPOC10

WorkOrder_ID

MO19

CMPOM25

POID

POOS

WorkOrder_ID
MOZ1
MOZ1

MO25

TARGET_DATE
05/17/2017
Route

ASSYIF

TESTIF

ASSYIF

TESTIF

ASSYTF

05/15/2017
Route
ASSYIF

05/24/2017
PO_Qy

150

Route
TESTIF
ASSYIF

FRG100

PROJECTED_DATE
05/03/2017
JobStep

3

2

3

2

3

05/01/2017
JobStep

3
05/05/2017
PO Line

19

JobStep
2
3

1

ORDER_QTY

130.00
DDB_Date
05/01/2017
05/01/2017
05/02/2017
05/02/2017
05/03/2017

80.00
DDB_Dare

05/01/2017

81.00

PO.Req_Date

05/13/2017

DDB_Date
05/03/2017
05/04/2017

01/01/1901
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Chapter 7 Running multiple warehouses in VPi 7

This chapter discusses the process to create setup for Multiple Plants on same PC and accessing any plant

directly from a central dashboard named LaunchPad in VPi.

The chapter consists of the following topics:
Topic

Multiple Warehouse/Plants Setup

Step 1: Create required folder structures for each warehouse/location
Step 2: Create Plants for each warehouse/location using ResAdmin
LaunchPad Application

VPi

DbuUtil

ResAdmin

Download

Putback

Create a Combo

Concept of Multi Plant Database or Corporate Database

Steps Involved in Setting up Multi-Plant

Steps Involved in Setting up Participating Warehouses / Locations
Preparing for the download

Downloading and building corporate data with XA and APSI
Building corporate data in other scenarios (No XA or not using APSI )
Have the .DAT files stored separately

Have combined .DAT files and use DbUtil to create a corporate database

Visual Planner User Guide
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7-10
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7-11
7-11
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7-18
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7-19
7-19
7-19
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Multiple Warehouse/Plants Setup

We can have VPi setup done on same PC for multiple entities (i.e. multiple warehouses, facilities, or
companies). For creating required setup for multiple warehouses on same PC, we need to install the VPi
engine first (only one installation is sufficient to plan for multiple warehouses). Each warehouse has
these requirements:

e Separate PC database

e Adistinct ODBC connection to that database An ODBC connection to the ERP system on the
System | (which can be common to all your warehouses)

e Separate Visual Planner Configuration file (config.ini)

e Separate iSeries Integration file to specify the warehouse number

e Separate folder to receive and putback the data for the warehouse between your ERP and VPi.

You can either plan each entity on a separate PC or you can plan multiple entities on the same PC. To
plan each entity on a separate PC, use the preceding sections of this chapter to install and configure the
VPi engine on each PC that is used to plan an entity. To plan multiple entities on one PC, use the
following sections to install the VPi engine multiple times on the PC.

Once VPI application has been installed on the PC, then we need to create separate folder and plant for
each location. Each of the plant folder will contain the config.ini, ISeriesintegration.ini and dat/fmt files
for each location. Please note, when downloading data from XA, it will download only one warehouse
data at a time which we need to store in separate folders. For setting up the folders and for specifying
plant configuration to be used, please follow the steps below:

Step 1: Create required folder structures for each warehouse/location

Before creating plants corresponding to each warehouse/location, we first need to create corresponding
folder structures for each warehouse/location for storing config.ini, ISeriesIntegration.ini and .dat/.fmt
files.
Let us assume we want to do planning in VPi for 2 different warehouses — FRV and FRP. Thus you will
have following folder structures:
» C:\INFORVPi\Plants\FRV\
e Config.ini =>This corresponds to config.ini file for FRV location
e [SeriesIntegration.ini => This corresponds to ISeriesIntegration.ini file for FRV location
«» C:\INFORVPi\Plants\FRV\Data => This is the directory where all data and fmt files for FRV

will be downloaded. And .OUT files will be written after the write schedule.
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» C:\INFORVPi\Plants\FRP\
e Config.ini =>This corresponds to config.ini file for FRP location
e |SeriesIntegration.ini => This corresponds to ISeriesIntegration.ini file for FRP location
< C:\INFORVPi\Plants\FRP\Data: This is the directory where all data and fmt files for FRP

will be downloaded. And .OQUT files will be written after the write schedule.

Step 2: Create Plants for each warehouse/location using ResAdmin

Second step in setting up multi-plant environment is to create as many plants as there are
warehouses/locations. Use ResAdmin.exe available in the InfoVPi installation folder to create the plants
that point to different plant config files and different download folders as setup in Step 1. A step-by-step
dialog wizard will help you to create and manage the scheduling plants in VPi. From INFORVPi folder,

when you run ResAdmin (ResAdmin.exe in the VPi installation folder), you will see the following dialog:

Thru-Put 6.1 Server Configuration Wizard - Page 2 of 5 [ x|

Chooze one of the following options, and click the Mext button

£+ ‘Create a Thu-Put &pplication Server

€ Wadify an existing Thiu-Put Application Server

" Remaove an exdisting Thiu-Put Application Server

< Back I MHext > I Cancel | Help |

e You can choose the ‘Create’ option to create a new plant. You can specify the plant information

in the next step as shown below:
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Thru-Put 6.1 Server Configuration Wizard - Page 3 of 5

Give a name to the Thu-Put Application Server

IPIant_FF!V

Specify location of the Thru-Put Application S erver
II::\INFDHVPi\Hesnnance.e:-:e Browse. ..

Specify config file of the Thru-Put Application Server

II::\INFDH\-"F‘i\F‘Iant&\FH&-‘T\cnnfig.ini Browse... |

< Back I Mewxt > I Cancel | Help |

e Clicking Next will bring up ODBC connection window where you can specify a new DSN i.e. ODBC
connection (or can connect to existing DSN for the plant) for the selected plant. You can specify

the DSN to point to the local VPi database the plant should be pointing to as shown below:

Thru-Put 6.1 Server Configuration Wizard - Page 4 of 5

The current database used by Thiu-Put Application Client iz given below.
Y'ou can change the databaze by clicking the Change Databaze buttan

Current Databaze Type:
[oDeC i

Current [ atabaze Mame:

IVPI_FHV(Microsoft Accesz Driver [*mdb]>

| Change Database. ., I

< Back | Mest » | Cancel | Help |

a) To specify a new DSN i.e. ODBC connection, click on “Change Database...” button as
shown in above screenshot. It will bring up the ODBC Data Source Administrator

window where you need to click on ODBC Setup.
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b) Then click the System DSN tab. Click on Add.

c) InCreate New Data Source window, select “Microsoft Access Driver (*.mdb, ;*.accdb)”

driver and hit Finish.
Create New Data Source

Select a driver for vahich pou want to et up a data zource,

M ame

r\|1r\1m_n_n_n_n_;_;(-

|

El iSenies Access ODBC Driver

. L Microsoft Access dBASE Diiver [*.dbf, * ndx, * mdsx)

h ¥ Diriver [*.mdb, * accdb]

Microzoft Access Test Driver [ tst,
ticrozoft Excel Driver [* =1z, " wlsx, ™ slzm, " xlzh]
Oracle in OraClient11g_homel
SOL Server
SOL Server Mative Clisnt 10.0
SOL Server Mative Clisnt 11.0

1 —

I;I

< Back I Finish I Cancel |

d) On the ODBC Microsoft Access Setup window, provide a name for the data source. E.g.

for location FRV, we have provided DSN name as VPi_FRV.

ODBLC Microsoft Access Setup |

Data Source Hame: I"-.-"F'i_FH"»-"

E

Dezcription:; ||
Cancel |
— Databaze
D atabase: Help |
Select... | Create. . | Bepair... Compact... |
Advanced... |

— Syztemn D atabaze

* Mong
™ Databaze:

Suztem Databaze,

Optior: >
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e) Click “Select” from same dialog and browse to the VPi database which you need to use
for the given location; and click OK.

f) It will populate database location and name in the same dialog . Click OK, then OK again.
In the Dialog window, ensure that your newly renamed data source is selected in the

Select ODBC Source list as shown below:

Dialog

Select ODBC Source:

X
WPi_Chinesetcoess <Microsoft Access Drwer[ rrJ

\-’F‘I Demu.-’-‘-.F' <M|n::rn:-3n:nft .-i'-.c:n::ess Drwer mu:ll:n "

Cancel

WP Validated'0 <Microzaft Access Driver [*.mdb,
WY _128zhley <SOL Server Mative Client 10, EI>
WIS ample 70 <Microzoft Access Dnver [*.mdb, *.2
WFiS avePlanlzzue <Microzoft Access Driver [7. mclJ

ODEE Sstup.. |

— |Jzer Infarmation
Izer Hame: I

Pazzword: ||

g) Click OK, then click Next.

e You can specify the Administrative password for managing the plant as shown below:

Thru-Put 6.1 Server Configuration Wizard - Page 5 of 5

You heed to zpecify an Administrative User for the Thru-Put Application Server

Give the name of the Administrative User:

IF!es.&dmin
Choose a password for this uger
|

Confirm the password for this user:

< Back I Finizh I Cahcel | Help |

e  C(Click Finish. It will give a message “Server created Successfully” to user and will close ResAdmin

application.
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Navigate to the folder for the corresponding plant which you have setup in above steps. Edit the
Config.ini file and verify that the changes above automatically updated the name of the data
source (DataSourceName) with the new name you assigned in the preceding steps.

For the selected plant, create a new ODBC data source to the System i server, to permit
concurrent operation in separate System i jobs for each entity between the PC and the System i.
See “Creating an ODBC data source” for more information.

Then we need to link the new VPi installation to the ERP environment. Edit the
IseriesIntegration.ini file in the corresponding plant folder (for example,
C:\INFORVPi\Plants\FRV\) and update the ISeriesDataSourceName parameter value with the
ODBC name for System i created in previous step. You may also need to accordingly update the
other parameters under ODBC section in ISeriesIntegration.ini file.

Confirm that the InputFileDir parameter value in both Iseriesintegration.ini and Config.ini is
pointing to data folder which we created in Step 1 under the mentioned plant folder. E.g. for FRV
warehouse, InputFileDir should point to C:\INFORVPi\Plants\FRV\Data\ folder.

This will setup the required configuration for first warehouse FRV.
Repeat the above steps for all plants you want to include in planning.
Once you finish your task you should be able to list the plants as shown below in ResAdmin when

you click on “Modify” option in first screen:

Thru-Put 6.1 Server Configuration Wizard - Page 4 of 5

Plant Hame Location o
29 |Plant_FRP COAMNFORVPIRezonance exe
30 |Plant_FRY CHANFORYPIResonance exe
3 [SAmM E Build='61006 .1 S00'Resonance
32 | =0 E:Builds's106 .1 S00MResonanc
33 |=DE E \Build='61006 .1 S00MResonanc
34 |=HZ E:Builds's106 .1 S00MResonanc =
25 | TactDlart AR DN 2T RIR YR acnmanima c
7 | 5T

< Back Cancel | Help |

Once all plants are created, then we can use LaunchPad application as mentioned in next section
to download data from ERP system; run DBUtil to build the database for that warehouse; run VPI

Planning engine for corresponding warehouse; and upload output schedules back to ERP system
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for the given warehouse. Summarily, you can manage all warehouses i.e. plants setup on same PC

from one central application which acts as a dashboard for Multi-Plants setup.

LaunchPad Application

Configuring the environment for running multiple warehouses planning on the same computer is
quite tedious. Administrator needs to create separate batch file short cuts for each warehouse
with their own shortcut for downloading data from ERP systems, running VPi planning engine,
performing put back to ERP system etc.

Now we have introduced a new launch pad application for easy configuration and deployment of
multiple warehouses with shortcuts to run separately. With “LAUNCHPAD”, user can access any
VPI module/batch files for all the warehouses from a single Ul. This application will get installed
in same INFORVPi folder whenever user installs VPi.

On clicking on LaunchPad.exe from INFORVPi installation folder, below Ul will get displayed:

i Infor ¥isual Planner: Launch Pad _ O] =]
9

LAUNCH PAD APPLICATION

T
~
DEUtil

61Release

i Create & COMbD

Bramptonb

[ ——————
. :
Download Putback il Create a Combo

Here you will notice:
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VPi

1.

2.

3.

Each Warehouse listed along with icons to launch download/putback/dbutil/ VPI planning engine
for the same.

The first Warehouse listed name “VPI_Install” corresponds to DEFAULT Warehouse and all icons
under this Warehouse will be referring to INFORVPi installation folder. Users who do not have
Warehouse created on their server will only get to see VPI_INSTALL Warehouse. As user creates a
new Warehouse on the server (using ResAdmin utility), LaunchPad will display those new
warehouses underneath VPI_INSTALL.

There is option to expand or collapse all warehouses in one go using Expand and Collapse links
provided at the top in LaunchPad. Above Ul shows expanded view of all warehouses; clicking on
Collapse will result in below Ul:

+ Infor Yisual Planner: Launch Pad [ (O] =]
<
[=]

LAUNCH PAD APPLICATION

Let us have a look at functionality of each of the icon displayed under warehouses.

This will open VPi application for the given Warehouse. If you click on VPi icon under
“VPI_INSTALL” folder, then it will launch VPi application from default INFORVPi installation folder
and the config too picked from same location. Clicking on VPi icon from any other Warehouse
folder will launch VPi application using the config and exe from that specific Warehouse folder
(depending upon the location provided by user when creating that Warehouse).
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Right-clicking on this icon will bring 2 additional options as shown below:

&10RelDbg

®

DEUril Create a Combo

a) Write-Sched Pass: Clicking this option will run VPi planning engine in silent mode and will

perform Write-Sched Pass and will also perform putback. In other words, it will execute
below batch command at the back-end:

Resonance.exe -rAP —n< WarehouseName> -sw

b) Write-Sched Pass With No Putback: Clicking this option will run VPi planning engine in silent
mode and will perform Write-Sched Pass, but WON’T PERFROM ANY PUTBACK. In other
words, it will execute below batch command at the back-end:

Resonance.exe -rAP —n< WarehouseName> -swn

DbUtil

This will launch DbUtil for the corresponding Warehouse. From DBUtil, user can make required

changes in download configuration to update config file for the input .dat files which needs to be
downloaded and can also update mapping in fmt files.

ResAdmin

This will open standard ResAdmin.exe to create new warehouses or for modifying existing
warehouses setup. If user launches ResAdmin exe from LaunchPad and goes on to create new

Warehouse and complete all the steps; then she will need to click on “REFRESH” icon at the top
left-hand side corner in LaunchPad UI.

i Infor Yisual Planner: Launch Pad

<l

This will refresh LaunchPad Ul and will also list down the new Warehouse created by user just
now.
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Download

Clicking on this icon will execute the standard command-line for downloading of .dat files data
from ERP using APDatalink. The command-line which will be executed is:
<Warehouse Folder>APdatalink.exe -C:D -T:1 —n<WarehouseName>

When user first time opens LaunchPad, then it will dynamically create download batch file for
each Warehouse, with above mentioned command-line in the batch file; and will save the batch
file in corresponding Warehouse folder. The download batch file will be named as
<WarehouseName>_Download.bat. User can opt to modify contents of this batch file manually
later on, but are advised NOT to change the name of this file; else LaunchPad will recreate this
file on next run.
Whenever user clicks on Download icon under a specific Warehouse panel in LaunchPad, then
application will simply execute this download batch file from the Warehouse folder. If user clicks
on Download icon under VPI_INSTALL panel, then application will execute standard command-
line dynamically:

<VPI Installation Directory>APdatalink.exe -C:D -T:1 -nDEFAULT

Putback

Clicking on this icon will execute the standard command-line for putback i.e. upload of .out files
data from local server to ERP system using APDatalink. The command-line which will be executed
is:

<VPlinstall Folder>APdatalink.exe -C:B -n<WarehouseName>

When user first time opens LaunchPad, then it will dynamically create putback batch file for each
Warehouse, with above mentioned command-line in the batch file; and will save the batch file in
corresponding Warehouse folder. The putback batch file will be named as
<WarehouseName>_Putback.bat. User can opt to modify contents of this batch file manually
later on, but are advised NOT to change the name of this file; else LaunchPad will recreate this
file on next run.

On clicking of Putback icon under a specific Warehouse panel in LaunchPad, application will

simply execute this download batch file from the Warehouse folder. If user clicks on Putback icon

under VPI_INSTALL panel, then application will execute standard command-line dynamically:
<VPI Installation Directory>APdatalink.exe -C:B —nDEFAULT
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Create a Combo

This icon is meant to be used ONLY FOR VIRTUAL CORPORATE WAREHOQOUSE. On click of this icon,
user will be presented with a pop-up box, as shown below, to get list of warehouses for which
user wants to perform combined download and putback.

i Infor ¥isual Planner: Launch Pad

LAUNCH PAD APPLICATION

Please provide the plant names separated by plus ResAdmin

{+) sign to make up for Combined plant:

CANCEL | !
pd |

i
Download Create a Combo

Create a Combo
61Release =28
®
Download Putback Create a Combo

Bramptonb

[ ——————
Download Putback Create a Combo

E.g. Assume 610Reldbg and 61Install are 2 warehouses; and you have created 61Release as
virtual Warehouse for downloading combined data for the other 2 warehouses. So, you will need
to click on “Create a Combo” for 61Release Warehouse only and in above pop-up screen, provide
those 2 Warehouse names separated by plus (+) sign as: 610Reldbg+61Install

Click Save. It will update both download and putback batch files in the 61Release Warehouse
folder as shown below:

Screenshot for download batch file:
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i 61Release_Download.bat - Notepad
File Edit Format Help

E:/Builds/810/6.1. 908 /APdatalink.exe -C:0 -T:1 -n8loreldbg+elinstall+6lRelease
FPALSE

Screenshot for Putback batch file:

61Release_Putback.bat - Motepad
File Edit Formak Help

E:/Builds/810/6.1.59058/apdatalink.exe —C:6 -néloreldbg+élinstall
PALSE

Note: This is one time activity for VIRTUAL CORPORATE WAREHOUSE.

If user needs to perform download for this virtual Warehouse, all she needs to do is click on
Download icon under this virtual Warehouse panel in LaunchPad, which will in turn execute the
above created download batch file.

Similarly, if user needs to perform putback for this virtual Warehouse, then she needs to click on
Putback icon under this virtual Warehouse panel in LaunchPad, which will in turn execute the

above created putback batch file.

User can also hover the mouse over different icons to see the exact location of exe/batch file
which will be executed on click of that icon. Please see sample screenshot below:

VPi Download

610RelDbg

Download

E:/Builds/a10/6,1,908/Reldbg)a10RelDbg_Download. bat

&1Install
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Combining warehouse to create corporate planning

VPi planning can also work with single combined database of all locations that are included in the
supply chain. Data from all locations are combined in each of the VPi tables and LOCATION_ID
column in the table identifies the plant/warehouse, the record belongs to. Thus, item number
‘FOAM’ belonging to warehouse ‘TEXAS’ will have PART_ID= ‘FOAM’ and LOCATION_ID='TEXAS’
in the PART table. All the plants that are combined for single integrated planning purpose are
listed in SC_PLANTS table. Following table shows a sample SC_PLANTS table:

Sample SC_PLANTS table:

LOCATION_I COMPUTER_NA USER_ID | USER_PASSWO | ORGANIZ SITE_ID PLANT_NAME
D ME RD ATION_ID
FRV NULL NULL NULL AdvanPlan | FRP FRV
ner
FRP NULL NULL NULL AdvanPlan | FRP FRP
ner
TTS NULL NULL NULL AdvanPlan | FRP TTS
ner
Corporate NULL NULL NULL AdvanPlan | FRP Corporate
ner

Steps Involved in Setting up Multi-Plant

VPi corporate database can be set up in any of the following four ways depending upon the way VPi
that has been integrated with your ERP System.

e Downloading data from directly from XA using APDatalink and running DButil for the
combined downloaded data

e Have the individual data files stored in separate plant folders and combine them using
APDatalink and running DButil for the consolidated data

e Have the combined dat files downloaded from your ERP system

e Direct integration with your ERP database if you have the mapping file created between your
ERP system and VPi data layout
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Steps Involved in Setting up Participating Warehouses / Locations

Here we need to follow steps similar to what is mentioned in Step 1 and Step 2 in previous
section “Multi-Plant Setup on Same PC”, with the additional change that we also need to create
an additional virtual planti.e. corporate plant. Summarily, please follow below steps:

Step 1: Create plants for each warehouse locations using ResAdmin

First step in setting up multi-plant environment is to create as many plants as there are
warehouses/locations. Use ResAdmin.exe to create the plants that point to different plant config
files and different download folders. Thus you will have following folder structures:

C:\INFORVPi\Plants\FRP\
Config.ini

ISeriesIntegration.ini

C:\INFORVPi\Plants\FRP\Data

This is the directory where all data and fmt files for FRP will be downloaded. And .OUT files will
be written after the write schedule.

C:\INFORVPi\Plants\FRV\
Config.ini

ISeriesIntegration.ini

C:\INFORVPi\Plants\FRV\Data

This is the directory where all data and fmt files for FRV will be downloaded. And .OUT files will
be written after the write schedule.
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C:\INFORVPi\Plants\Corporate\
Config.ini

ISeriesIntegration.ini

C:\INFORVPi\Plants\ Corporate \Data

This is the directory where all data and fmt files for Corporate will be stored. Consolidated data
.DAT files of all respective .DAT files from individual warehouse/plant.

For example:
PART.DAT = PART.DAT (from FRP) + PART.DAT (from FRV) + ... + PART.DAT ( from nth plant)

ROUTE.DAT = ROUTE.DAT (from FRP) + ROUTE.DAT (from FRV) + ... + ROUTE.DAT (from nth plant
)

Note: All FMT and .DAT files need to be of same format.

You can check the following diagram to understand the full architecture behind combining the
data from XA
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XA/
[
LX W1 .| APDatalink.exe Dat Files R
.Dat Files
W2 .| APDatalink.exe .Dat Files R R
[
W3 .| APDatalink.exe .Dat Files R
N
’J:‘ M~
W1 APDatalink.exe P | .0uT DB
< WA1
A
Jﬁ; VPi <« le Dbutil |y
W2 APDatalink.exe < w2
\/.l ouT
P APDatalink.exe P
< W3 il W3 ouT
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Step 2: Setting up the Plants using ResAdmin tool

Here you need to create Plants for each warehouse/location using ResAdmin.exe. For this, please
follow the same steps as mentioned in “Step2: Create Plants for each Warehouse/Location using

ResAdmin” in previous section.

So, for the example in SC_PLANTS table, you will need to create Plants for locations FRV, FRP, TTS
and Corporate.

Preparing for the download

If you use XA, VPi provides out of box APSI tool to download the individual warehouse data and
combining into one single data and run DBUil all in one single command. There is a utility in the
installation folder called APDatalink.exe that does this job. If you are not using standard APSI
integration with XA or you are using different ERP system (without direct integration), you will
need to download and consolidate the data as a one single corporate data.

Downloading and building corporate data with XA and APSI

Standard XA download downloads the data one warehouse at a time. There is a utility in the
installation folder called APDatalink.exe that downloads and combines the data automatically.
The way to download and build the corporate database (multi-plant database) is using following
command:

APDatalink —C:D —m —n<Plant1>+<Plant2>+....+<CorporatePlant>
Here, Plantl, Plant2 etc and CorporatePlant are plants you created earlier using ResAdmin tool.

These will download the warehouse Plantl, Plant2 etc (Warehouse name and access credentials
are provided in ISeriesintegration.ini file located in the plant folder). You can check the exact
command line syntax by opening a command window and then going to installation folder and
typing APDatalink/? In the command window.

Optionally, you can just download the files from XA but skip building the data or you can the
combining the data and skipping download. These options are accomplished by adding —T:0 or —
T:1 command line argument to APDatalink command above.
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For all the possible command line argument for APDatalink, please type APDatalink/? from the
command promt when you are in the VPi installation Folder.

All the logs of running APDatalink and errors if any are logged to APDatalink.log in the
installation folder.

Building corporate data in other scenarios (No XA or not using APSI )

In this scenario, you have two choices:
e Have the .DAT files for each plant create separately

e Have combined PART.DAT, ROUTE.DAT etc and then use VPi to build corporate data.
Please note in this configuration, make sure to map the LOCATION_ID in each download
data files mapped.

Have the .DAT files stored separately

When you are having .DAT files for each location stored in separate file, you can still use
APDATAIlink.exe and provide a command line option that does not download the data from XA
but will combine the data for you and run DBUtil for the combined data. In this you will have to
make sure, you have PPIPLN.DAT file created. APDatalink needs this file to populate SC_PLANT
table

After creating plants for each location, you can run the following command:
ApDatalink —C:D -T:0 -m —n<Plant1>+<Plant2>+....+<corporate>

T:0 indicates, the data is already available in each of the plants specified folder (specified during
plant creation in ResAdmin). And XA download will not be called. APDatlink will first combine
each data file from all plants (Part.Dat from all locations, Route.Dat from all locations etc). Then
APDatalink will call Dbutil.exe to build the corporate database.

Have combined .DAT files and use DbUtil to create a corporate database

In this configuration you need to create SC_PLANTS table manually once before running DBULil.
OR create SC_PLANTS.DAT explicitly added to downloaded data and FMT. Then you will run
DbUtil in interactive mode once to specify that this database is corporate database instead of
single plant. For this make sure that RESPARA table is empty. When Dbutil is run by specifying the
following command line option:

DButil —-nCorporate
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You will be running the corporate plant. Now when you goto File->Build complete database, you
should see following dialog in DBUTil:

& Thru-Put DBULlity - {Default - 04,/04/2018)

File View Help

#| )& ﬂg”

@ Select Database Information [ %] -
Buld - Database Information———————————————
04/ Database: & Multi-Plant g
" Single Plant

Primary Location D ICDHP

User Organization 10 - IADVANF‘LANNEH| LI
oK I LCancel |
Ready T U |

Note: If you don’t see the dialog to choose multiplant or single plant , this means DBUTIL
already has this information stored in RESPARA table. You can drop the RESPARA table in the
database and then rerun DBULil again.

Remember to choose Multi-plant in the radio button option. You can specify the name of your
organization. And You can specify the primary organization which is normally the final assembly
plant or could be one of the larger plants which has the majority parts( this does not really matter
if the part number is called with the same name in all locations).
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Appendix A Configuration Parameters A

Normally, Visual Planner standard installation works great without any special tuning. Visual
Planner consultant you worked with you might have already discussed with you to get the most
of the Visual Planner. However, some planning calculation can be further fine-tuned to get
specific behavior from the Visual Planner. Visual Planner relies on a configuration file called
config.ini to set the planning parameter. The config,ini file is located in the folder into which
you installed VPi. We recommend that you do not change the settings in the file without
discussing the changes with Infor PSO.

Mandatory settings

These settings are mandatory:

Parameter Definition

DeclareAllMakePartAsMPS 1

CreateDataFiles 1 - Triggers Write Schedule Pass to generate the
.OUT files

MoveWOW!IPToQOH 0 - Setting 1 means that any WIP (quantity good)

on the last job step will be added to QOH for the
part. The work order pending quantity will be
respectively reduced.

NewIntTimeCalc 1- New Interceding Time Calculations calculate
more accurate Jobstep Start and Completion
Dates. These calculations are triggered by a
configuration parameter that resides in the
[System] section. The code does not overlap
back-to-back operations on the same work
center. This code also works interactively with
the Routing Transfer_Size, allowing sequential or
overlap between individual operations.
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Additional parameters

The file includes these additional parameters:

Parameter

Definition

UseWCCalForldlingTime

DDBEqualsStartTime

TransferEntireBatch

OverlapChildAndParentOrdersInAP

ValidateWorkOrderQuantities

1 - (Recommended) Utilize the work center calendar
0 - Utilize a 24 Hour / 7 Work Day calendar. This
setting is very difficult to follow with idle time
absorbed by non-working days and the portion of
24 that is greater than the workcenter calendar on
working days.

0 - Disabled (Default) Creates a buffer
between

Order Start Date and first Job Step Start Date

1 - Excludes the buffer before the operation in
DDB calculations, thus producing an aggressive
schedule

(global setting) Determines whether the quantity
completed is transferred as 1 or the entire batch
quantity between operations. Entire batch time is
based on running the entire batch before
transferring to the next operation.

0 - No. Qty completed is transferred as 1
creating overlapping operations
1 - Yes. Entire batch qty completed before

transferring to the next operation

1 - Allows Child Due Date and Parent Start Date to
be on the same day.

0 - The Child Due Date will be one work day earlier
than the Start Date of the Parent Order. Set to O will
also add a one work day buffer between the
Demand Due Date and the Parent Order Due Date.

0 - Use routing quantity. VPi ignores status of
operation. If Operation 'Good' quantity plus 'bad'
quantity is less than order quantity operation will
show up regardless of operation status. Assume
order quantity on work order is 500. Operation is
complete with quantity reported of 350. Operation
will still show up with open quantity of 150 (500 -

Visual Planner User Guide
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AllocQOHToOpenWOFirst

SplitQtyAcrossUnitsForNonDrums

Visual Planner User Guide

350). If 350 is all that is going to be completed then
deviate work order header by 150. 1 - Base
guantity open based on work order header and
ignores quantities reported against operations. If
operation is C (complete) it will not show up. If you
use this setting only open operations will show up,
but quantity will be equal to open order quantity
not quantity received at the operation. For
example, if open quantity on an order is 100 then
each open operation will show open quantity of
100. You will never know what the actual reported
quantity.

2 - Use routing quantity. Operations reported short
and complete will be dropped from the Work
Center Load. Quantity reported short and complete
will become the Mfg Order Qty anticipating the
quantity completed at the operation is the most
that can be assembled and shipped.

Whether to assign the on hand of components
based upon parent work order due date or work
order type ignoring the status of work order, open or
planned.

0 - Allocated in Required Date sequence

1 - then the allocation sequence will be Sales orders,
forecast orders, open work orders and firm
planned orders in their demand due date
sequence. Only planned work orders will have a
lower priority.

(Global setting) On a non-drum work center, the
work orders quantities will be equally divided over
number of units available. If the quantity is cannot
be divided equally, the quantity will be rounded to
next integer or the batch size. This generally leads
to uniform distribution of load across the units on a
non drum workcenters. O - Entire task will be
placed on unit while computing the lead-time
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1 - The work orders quantities will be equally
divided over number of units available (whole
numbers) 3 units & gty 4 splits 1,1,2 2 - The work
orders quantities will be equally divided over
number of units available (fractional) 3 units and
gty 4 splits 1.33, 1.33, 1.33. It does not split a gty
of 1.

-1 - drop global setting and use value in
Attribute 5 from WKCTR

UseFullBatchRunTime Calculates load with Time Basis Code = H "Hours per
Lot"
0 - (default, old behavior), load calculation
uses prorated method.
1 - load calculation uses full batch method.
For example, if batch size is 10, and qty is 1, run
time per batch is 10 hours:
- the load is 1 hour (UseFullBatchRunTime=0)
- the load is 10 hours (UseFullBatchRunTime=1)

PeggingFractionlgnoreFactor To reduce performance degradation due to very
small fractional quantities, when VPi matches
required quantities during repegging. This factor is
used to ignore very small fractional quantities.

IgnoreSetup ** Obsolete **

IncludeSetup This parameter determines whether to include
setup in L:C Defaultis YES

NoAutoRefresh Used by VPi module. Does not refresh screens
after decisions were performed until users choose
to manually refresh a single screen or all screens.
Improves performance when set to 1.

ResolvePastDuesInAP Past due customer orders and forecast orders: O -
(Recommended) Orders are not rationalized
(pushed out) to their feasible dates.
1- Orders are rescheduled to their calculated
completion dates before schedules are saved. This
action takes place during Write Schedule Pass and
Save Plan.
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PushOutFromNonDrumChains=0

SCPartVendorOverride

OfflineSyncWaterfallLen

NonDrumOutputHorizonLength

ForecastFenceByPart

DiscardNegativeOnHand

DiscardNegativeBOM

Specific customer parameters

This insures that the engine does not automatically
push out Customer Orders

1 - turns on multi-source planning to look to
PART Primary_Vendor for __R “rotate” or __S
llsplitll

0

730 for updating pegged requirements for
Replenishment planning

This parameter is in config.ini under [Order board
Options] section.

Allows individual item forecast demand time fence
where the value of PABZoneDays will be read from
PART table, instead of reading the global value from
DBUtil Order Board / Forecasting Method / Forecast
Fence.

PART table PLANNING_FENCE value will serve as the
individual part’s Forecast Demand Fence.

Note: there is no mix of logic, it’s either global or by
individual part.

0 - allow negative on hand to be downloaded and
included in the planning process

1 - discard negative on hand in the download
process

0 - allow negative BOM "qty per" to be downloaded
and included in the planning process

1 - discard negative BOM "qty per" in the download
process

This parameter is included in the config.ini file for a specific ERP XA customer.

SortOpenWOByWorkProgress= (multiple open work orders for a given part)

Visual Planner User Guide

Page 5



6

Appendix A Configuration Parameters

0 -- sort hierarchy

- work order release date (XA MO Start Date)

- identical release date, then work order id in the ascending order

1 & 2 -- sort hierarchy

- highest progress index

- work order release date (XA MO Start Date)

- identical progress index, then work order id in the ascending order Work order
with highest progress index gets first priority.

Progress Index = Sum Of(Quantity Good at each Operation)/ (No Of
operations*Total Qty).

1 -- Compute from the last status 30 operation upstream and including
last assembly operation with components charged to it. (Ignores operations
prior to the last assembly operation) (assembly operations contain Op Where
1st Used components)

2 -- Compute from the last status 30 operation upstream and including
the first job step, instead of stopping at the last assembly node.

Further, if you set AllocQOHToOpenWOFirst, then even the on hand will be
allocated to open work orders with higher completion index first. This will help
to optimally close the open work orders quicker. Further, if you set
AllocQOHToOpenWOFirst, then even the on hand will be allocated to open work
orders with higher completion index first. This will help to optimally close the
open work orders more quickly.

RESPARA Table Definition for VPi

CANCEL =0 This triggers VPI not to automatically cancel supply orders that have
zero associated demand. It is controlled by XA MRP Planning Run Execution
Options parm: Cancel exception code updates RESPARA .
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IseriesIntegration Setting for VPi

APSMFGRTGOut

1 -- Triggers VPi to upload route records to PPRTGW.out. Then XA translates to work file
PPMORT, which in turn updates MOROUT.

0 -- If you do not want VPI to upload routing dates planned by VPI

UpdateOpenWOStart=
0 -- upload original order dates (ignore any rescheduled dates)

1 -- upload new rescheduled dates from T_Internal_Demand.
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Appendix B Glossary

alternate routing
A set of bill of materials and routing data that captures another method for
producing a product.

ASCIl (American Standard Code for Information Interchange) A
binary character code used to represent a character in a computer. It
consists of 128 seven-bit codes for upper- and lowercase letters, numbers,
punctuation, and special communication-control characters.

batch
A quantity scheduled to be produced together.

batch production

A manufacturing method used when the lot size of identical parts is produced in
a factory. Batch production is the method adopted when the required product
volumes are not adequate to permit continuous product of one product on
dedicated machines.

bill of materials (BOM)
A listing of all the subassemblies, parts, and raw materials that go into a parent
assembly.

BOM Bill of
materials.

bucket
A time period, usually daily, weekly, or monthly. The load within a given period
of time, referred to as the bucket.

buffer

Additional planned lead time used to protect the system from the disruptions
inherent in any process, or additional inventory used to enable filling customer
orders in less than the normal lead time (stock buffer). A duration of time used
to protect firm schedules generated during the planning process. Strategically
placed before drums, shipping operations, or some assembly operations.
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burden rate
A cost, usually in dollars per hour, normally added to the cost of every standard
production hour to cover overhead expenses.

capacity

Time available at a resource over a period of
time. Usually determined by how the resource
is staffed. For example, capacity at machine A
is 40 hours per week.

CGS Cost of

goods sold.

child part
A manufactured component or purchase part used in assembly. A part made up
of parts that have been made previously (parent parts).

classifying materials
A way of distinguishing orders of importance of materials in a plant. See

” u

“ignore materials,” “normal materials,” and “priority materials.”

Configuration
The arrangement of components specified to produce an assembly.

cycle time
The time between completion of two discrete units of production. See
“manufacturing cycle time” and “order lead time.”

data file
A collection of related data records organized in a specific manner.

DB Util
An VPi product that converts data files from any external source into a database

that has the correct information and structure for VPi.

delivery lead time
The time difference between when a customer places an order and when the

order is shipped.

demand
A requirement for a particular product or component over time. Expressed by

date, quantity, and product.

Demand Fence
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Cut off date in future until which no forecast will be build but only customer
orders and master schedules. In VPi, this term is interchangeably used with
forecast fence.

Dependency
Certain operations or activities cannot take place until certain other operations
or activities have been completed.

dock-to-stock lead time
The time difference between the time a purchase part product arrives at the
dock to when the part can be released.

expedited POs (purchase orders)
Purchase orders with a due date (arrival date) after the date of requirement on
the shop floor.

first day load (FDL)
A task must performed on the horizon start date and insufficient capacity is
available.

explosion

Process of traversing thru the product structure from the final assembly ( root
of the tree) to the subassemblies level by level and collecting and netting out
demand and supplies at each level until buy materials are reached or no more
level to go further.

facility

A group of machines with similar capacity and performing same functions can
be used to process similar operation interchangeably. Facility is also called
workcenter.

forecast
A planning methodology that predicts orders for a product.

forecast fence
Cut off date in future until which no forecast will be build but only customer

orders and master schedules. In VPi, this term is interchangeably used with
demand fence.

idle time
Time not used to perform a setup or process (run) material import.
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ignore materials
Materials completely ignored by a VPi for material analysis. For example, screws
and bolts.

ignore work centers
Workcenters sufficiently flexible to handle the load or with inaccurate data. You
can specify to ignore these.

Intersite orders

Transaction between two warehouses or sites within the same company. Often
single order is recorded as two transactions purchase order in the buying
warehouse and a matching sales order in the supplying warehouse

inventory

Amount of money tied up in materials that the company intends to sell.
Inventory is equal to the purchased material value of raw material, purchased
parts, work in process and finished goods.

jobs in progress (JIP)

Operations or setups currently in progress on a work center, usually a drum.
Used by VPi to account for significant progress on operations that might
otherwise be scheduled for a full run. For example, a furnace operation that is
14 days long might be in day 12 by the time a scheduling session occurs.

L:C chart

A software function that shows load versus capacity information on all work
centers sufficiently flexible. To facilitate decision making, several display options
appropriate for finite scheduling are available.

manual overtime allocation

Allocation of exact amount of overtime on specific days. VPi reschedules the
work center to optimize the schedule of the work center after OT allocation. VPi
allocates overtime for every calendar day (not just every work day) in the range
subject to a maximum of 24 work hours per day.

manufacturing cycle time
The difference between material release for an order and shipment of the
release.

minimum lead time
Any of the following:

Firm purchase orders due before today’s date plus a minimum lead time
beyond which an order cannot be expedited
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Any firm purchase orders due outside of today’s date plus a minimum lead
time that can be expedited to today plus a minimum lead time

New purchase orders that can be made due today plus a minimum lead time.

normal materials
All materials other than priority. Unless you ask VPi to analyze Priority Materials
only, these materials will show up in your analysis.

ODBC Open Database
Connectivity.

offload
A decision you make during planning to change the work center for unstarted
operations in a released order.

offloaded jobs
Tasks that have been offloaded from their original work center to an alternate
work center.

outside processing
A specific routing step always sent outside the plant for processing.

outsourcing.

Buying parts which could be made in-house. Indicated in VPi by adding a
purchase order to the Purchase file. If out sourced parts arrive on different
dates, add multiple entries to the purchase file. VPi computes the date on which
a requirement exists for an out sourced parts. It uses the arriving out sourced
part for all orders that require the part after the date on which the part arrives.
If insufficient parts arrive by the required dates, VPi plans to make the parts in-
house. VPi assumes that all sub-components required for

the out sourced parts have either been shipped or provided by the vendor. No
requirements are generated for the quantity that has been out sourced.

overhead $ (dollars)
Operating expenses minus direct labor dollars. overtime (OT). Hours worked

exceeding normal labor hours. parent part. A part produced from one or more
components.

Phantom Items
Any item Kits and make ltems without routing. Normally, work order will not be
represent for such items
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planned overtime
Shows by work center the overtime allocated in the current session

planned work orders
Work orders for parts to be released no sooner than the start date but as soon
as possible after start date.

PO_Qty_Open
A field in the Purchase file that specifies the sum of all purchase order quantities
for the same item due on the same date.

priority materials
Materials that may be hard to procure or have long lead times.

product mix
The proportion of individual products that make up the total production or sales
volume.

R&D (Research and Development) order
An experimental order.

real time
The immediate availability of data to an information system as a transaction or
event occurs.

scheduling horizon
The time period for which scheduling is relevant.

Setup

A procedure performed on a work center or work centers to prepare for
processing a given job.

setup time
The amount of time required to perform a setup.

SQL
Structured Query Language.

supply chain management
The use of information technology to give automated intelligence to a network

of vendors, suppliers, manufacturers, distributors, retailers, and a host of other
trading partners. The goal is for each player in the supply chain to conduct
business with the latest and best information from everyone else in the chain,
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guiding supply and demand into a more perfect balance. Effective
management of the supply chain enables a company to move product from the
point of origin to that of consumption in the least amount of time at the
smallest cost.

time-phased load profile
A chart that shows the orders at a work center. UDAs. User-defined attributes.

Undo Reversal of decisions you made previously in
planning.

work center

A specific production area consisting of one or more people and/or machines
with identical capabilities that can be considered as one unit for purposes of
capacity planning and scheduling.

work center family
A group of similar work centers. VPi can show loads and capacities for work
centers with specified families.

work center load profile

A chart that presents load to capacity ratios for
the scheduling horizon established when VPi
was started. The top portion of the chart
provides details about the work center (for
example, number of units, ID of the calendar
associated with the work center, and the work
center family).
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